
NetSupport Manager 
Manual – Version 14.00 



NetSupport Manager v14.00 

 

 2 
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Software Licence Agreement 
 
Please read this agreement before using your copy of NetSupport Software. This is a legal agreement 
between you and NetSupport Ltd.  If you do not wish to be bound by the terms of this licence 
agreement you must not load, activate or use the software. 
 
TERM: Subject to termination under Termination Clause below the licence shall be perpetual.  
 
GRANT OF LICENSE: Subject to the payment of the applicable license fees, and subject to your 
abidance by the terms and conditions of this agreement, NetSupport Ltd hereby grants to you a non-
exclusive, non-transferable right to use one copy of the specified version of the software which you 
have acquired. 
 
USE: The software is licensed with volume use terms specified in the applicable order 
acknowledgement, product invoice, license certificate or product packaging. You may make, install and 
use as many additional copies of the software on the number of devices as the terms specify. You 
must have a reasonable mechanism in place to ensure that the number of devices on which the 
software has been installed does not exceed the number of licenses you have obtained.  
 
SERVER USE: To the extent that the applicable order acknowledgement, product invoice, product 
packaging or license certificate sets forth, you may use the software on a device or on a Server within 
a multi-user or networked environment ("Server Use"). A separate license is required for each device 
or "seat" that may connect to the software at any time, regardless of whether such licensed devices or 
seats are connected to the software concurrently, or are actually using the software at any particular 
time. Your use of software or hardware that reduces the number of devices or seats that connect to 
and use the software directly or simultaneously (e.g., "multiplexing" or "pooling" software or hardware) 
does not reduce the number of licenses required. Specifically, you must have that number of licenses 
that would equal the number of distinct inputs to the multiplexing or pooling software or hardware "front 
end"). If the number of devices or seats that can connect to the software can exceed the number of 
licenses you have obtained, then you must have a reasonable mechanism in place to ensure that your 
use of the software does not exceed the use limits specified for the license you have obtained.  
 
COPYRIGHT: This software is protected by international copyright laws.  You may copy it only for 
backup purposes.  The software is licensed to you, but not sold to you. 
 
RESTRICTIONS: Neither you nor any reseller may rent, lease, sell licensed copies [on approval], or 
otherwise transfer the right to use this software to another person, except that you may sell or give 
away your original copy, as long as you do not keep any copies. The software may not be modified, 
disassembled or reverse engineered except with the prior written consent of NetSupport Ltd. 
 
LIMITED WARRANTY:  NetSupport Ltd warrants that the software will perform substantially in 
accordance with the accompanying documentation for a period of ninety (90) days from the date of 
purchase.  NetSupport's entire liability and your exclusive remedy shall be either a) the replacement of 
the defective software or b) return of the price paid.  This remedy shall be at NetSupport's option and 
subject to proof of purchase from an authorised source. 
 
Any implied warranties including any warranties of quality or fitness for a particular purpose are limited 
to the terms of the express warranties. NetSupport Ltd. shall not in any event be liable for loss of 
profits, data or information of any kind or for special, incidental, consequential, indirect or other similar 
damages arising from any breach of these warranties or use of the software even if they have been 
advised of the possibility of such damages.  Some countries do not allow the limitation or exclusion of 
incidental or consequential damages, so the above limitation or exclusion may not apply to you.  This 
warranty does not affect your statutory rights, and you may have other rights that vary from country to 
country.  In any event NetSupport's maximum liability shall not exceed the price paid by the end-user / 
licensee. 
 
TERMINATION: You may terminate this licence and this Agreement at any time by destroying the 
program and its documentation, together with any copies in any form.  
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NetSupport Ltd.  may terminate this licence forthwith by notice in writing to you if you commit any 
serious breach of any term of this licence and (in the case of a breach capable of being remedied) 
shall have failed within 30 days after receipt of a request in writing from NetSupport Ltd.  so to do, to 
remedy the breach (such request to contain a warning of NetSupport's intention to terminate). Upon 
termination you will destroy or return to NetSupport Ltd the original and all copies of the software and 
will confirm in writing to NetSupport Ltd that this has been done.  
 
SUPPORT: If you have a problem with the installation of the software you should in the first instance 
contact your supplier. You can separately purchase support and maintenance which will also cover the 
supply of enhancements and upgrades.  
 
GOVERNING LAW: This agreement shall be governed by the laws of England.  
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Welcome to NetSupport Manager 

NetSupport Manager continues to lead the way with innovative 
features to aid in remote PC management. From a desktop, laptop, 

tablet or smartphone, monitor multiple systems in a single action, 
deliver hands-on remote support, collaborate and even record or play 
back sessions. When needed, gather real-time hardware and software 
inventory, monitor services and even view system config remotely to 
help resolve issues quickly. 
 

Designed to operate over your LAN, WAN or the internet, securely 
and without the need for firewall configuration, NetSupport Manager 
provides a single, high speed solution for the remote management of 
multi-platform computers, without the need for a third-party service 
or ongoing subscription costs – making it the perfect tool of choice for 
any IT team. 
  

NetSupport Manager offers comprehensive multi-platform support 
from Windows, Mac, iOS and Android to any Windows, Android, Mac, 
Linux (legacy) and Chrome OS devices. 

 
This user manual contains instructions for installing and running 
NetSupport Manager. 
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Conventions used 

The following logical and easy to understand conventions are 
used in this manual:  

• Step-by-step instructions, which should be performed in 

sequence, are shown as numbered paragraphs beneath a clearly 
stated, ‘How to Do’ heading.  

• As there is often more than one way of carrying out a task, you 
will find ‘Or’ options also included. 

• Additional tips or explanatory notes regarding these instructions 
are enclosed in a border under the heading ‘Note’. 

 

Terminology used 

Control

  

The ‘Control’ is the workstation or device that shows 

to or views/takes over the Client.  

Client  The ‘Client’ is the workstation or device that is being 

shown to, viewed or taken over.  

Available 
Client  

When the NetSupport Client program has been 
installed on a workstation, it becomes available for 
connection by a Control. A Client must be available 
before a Control can connect to it. 

Selected 
Client   

When a connected Client is selected, a "one to one" 
session is established. A Control can then view, 
show or send a message etc. to that Client only. A 
Control can also watch, control or share the selected 

Client's screen, keyboard and mouse. A Control can 

switch between multiple Clients, making each of 
them, in turn, the selected Client.  

Connected 
Client   

All available Clients or groups of Clients can be 
chosen for simultaneous connection. A Control can 
only remote control a Client to which they are 
connected. 

Known 
Clients  

Having connected to Client machines, NetSupport 
stores a list of Clients in the All Computers folder 

in the Tree view. These are Known Clients. 
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About NetSupport Manager

  
 
In this chapter … 
 

You will be introduced to the main features and benefits of 

NetSupport Manager. 
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Features 

NetSupport Manager contains a wealth of features to assist you to 
train, support, monitor and manage Clients. 

 
Environment 
• Browse, locate and connect to all systems across your LAN, WAN 

or over the internet. 
• Install on Client workstations without the need to visit the 

individual machines using NetSupport Manager’s Remote 

Deployment utility. 
• Connect over TCP/IP or HTTP protocols (legacy support provided 

for IPX and NetBIOS).  
 

Remote control 
Watch, Share or Control the screen, keyboard and mouse of a Client, 
irrespective of colour resolution, network protocol or operating 

system. 
  
Monitor Mode 

The Monitor Mode feature allows a user to display a thumbnail view of 
all connected Client workstations simultaneously. The size of these 
thumbnails can be adjusted to suit. In addition, the user can mouse 
over a specific thumbnail for an expanded view of each selected PC. 

  
View 
View more than one Client screen at the same time, or sit back and 
watch each connected Client screen in Scan mode. The ability to 
record the activity on a Client workstation while it is remotely 
controlled, capture a Client’s print output and cut and paste between 

workstation applications comes as standard. 
  
Scan 
Scan multiple systems, cycle through one or multiple workstations 
displaying their screens on the Control workstation. 
 
Auto-grouping of remote systems 

The Control Tree view provides an instant overview of your IT 
infrastructure by grouping the remote systems based on pre-defined 
criteria such as platform and operating system. For example, you can 

easily identify machines running a particular Windows OS. This is 
particularly helpful when planning upgrades or the rollout of new 
technology. You can also create custom groups to reflect your 
company structure. 
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Geolocation 

When a user connects to a remote PC, if enabled, the location of the 
device will be calculated based on its external details. 
  
This information allows NetSupport Manager to provide an 
approximate location of each remote device, displaying the town, 
state and country (with supporting flag) within the Control 

application. Devices are automatically grouped by country for easier 
management. The feature can be enabled or disabled at both the 

Control and Client or simply managed via Group Policy. 
  
Show 
Show your screen, a selected monitor or just a selected application, 
video or replay file to any number of connected computers for real-

time instruction. 
  
Chat 
Conduct a two-way chat session in real-time between the Control and 
one or more users.  

  
Message 

Send a message to one or more chosen Clients, or even broadcast to 
all Clients on the network. 
 
Annotate tools 
Annotate your screen with a range of drawing tools during a Remote 
Control session or Show session to highlight areas of focus for an end 

user or to aid in your presentation or training. 
 

Screen capture 
Capture screenshots during a session for future reference. 
 
Screen recording 
Record screen activity to a video “replay file” for training or security. 

  
Support tools 
Remote inventory and system information 
A user can obtain a real-time view of the hardware and software 
installed on each remote PC workstation directly from within their 

NetSupport Control. NetSupport Manager collects a wealth of 
information, specifically about the hardware or environment of each 

PC. In addition, a full software inventory of current installed 
applications is provided as well as all installed OS hotfixes. To aid 
further in remote support and diagnostics, a user can also remotely 
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view and, security permitting, control applications in memory, all 

processes running and currently installed services. 
  

Power management 
Remotely power on/off, log on/off and reboot Client workstations to 
minimise power consumption. 
  

Request help 
Users can create help requests that can be directed to all or specific 

Control systems based on custom criteria. 
  
Multimedia 
NetSupport Manager provides full audio and video support. 
 

Launch commands 
A local command prompt and a PowerShell window can be launched 
allowing you to execute commands at Clients. 
 
Registry edit 

Remotely edit the registry of a remote system. 
 

Scripting and scheduling 
NetSupport Manager includes a powerful integrated Scripting 
Language and Scheduler that allows you to automate repetitive tasks 
from the NetSupport Manager Control and run them at a time when 
most convenient to you. 
 

Move information 
File transfer and distribution 

Transfer files between workstations using a simple drag and drop 
interface. Directories can be automatically synchronised on two 
workstations and appropriate file types can be edited. NetSupport 
Manager utilises intelligent Delta File Transfer to reduce data transfer 
times when overwriting files that already exist, by checking individual 

blocks of data within a file and only transferring changed data. 
 
Moving files from one PC to another may be useful, but the real 
benefits come with NetSupport Manager’s ability to copy files from 
one PC to many in a single action – or “File Distribution”. 

  
NetSupport Manager also features live folders. When initiating a file 

transfer to a remote PC, the path to any open folders (Explorer 
windows) on its desktop is displayed at the top of the file transfer 
view to ease quick selection. 
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Launch applications 

Remotely launch applications on remote computers. 
  
Connectivity 
• Dynamically find and list all Clients on the network. 
• Define a range of subnets for extended network browsing 

capabilities locally. 

• Connect directly to known computers by PC name, DNS name or 
network address. 

• Connect via a database of known Clients. 
• Discover and connect to any number of devices in real time 

across differing environments. 
• Connect to machines that have Intel vPro capability. 
 

Utilising the internet 
Delivering seamless remote control between PCs that may be located 
behind different firewalls, the NetSupport Connectivity Server module 
provides a stable and secure method for NetSupport-enabled systems 
to locate and communicate via HTTP. The NetSupport Manager 

Gateway component needs to be installed on a PC allocated with a 
static IP and accessible to both Control and Client PCs, even though 

both the Control and Client systems will be securely located behind 
their respective firewalls. The Gateway will only allow connections 
from computers using the same Gateway security key. 
  
PIN connect 
Allows a technician to locate a user anywhere across the enterprise 

instantly, simply by both parties entering a matching and unique PIN 
code. Rather than browsing to discover the user's PC and needing to 

know their PC name, address details etc, the PIN process allows both 
parties to handshake seamlessly. The new PIN Server module can run 
alone or alongside the Gateway module and is included as standard 
with NetSupport Manager. 
  

Security 
NetSupport Manager provides an exceptional range of security 
options to meet all needs, including: 
 

• Password protection of all systems. 

• User acknowledgement (User must be present and authorise each 
inbound connection request). 

• Data encryption – configurable from 56-bit DES to 256bit AES. 
• Set unique security keys on both Control and Client. 
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• Limit connectivity by user account or originating IP address and 

control HTTP access based on the IP address (only allow 
connections from known locations). 

• Record and replay remote control sessions to keep a history of all 
activity during a session. 

• Dialback security for dial-up connections. 
• Disable file transfer or specific files and directories. 

• Allow a Control to Watch only. 
• Auto logout of a remote system on disconnect (avoids a system 

being mistakenly left in a logged in state). 
• User-defined Inactivity Timeout on open connections. 
• Centrally deploy and manage security configurations from a single 

location. 
• Integrates with existing NT user profiles and security. 

• Integrate directly with Active Directory profiles for user 
validation. 

• Supplied with Active Directory templates to enable system-wide 
compliance with pre-defined Client configurations. 

• Profiled functionality – allow different functionality to be available 

depending on the authenticated user making a connection. 
• Full event and history logs including integration with OS event 

logs. 
• Smartcard support - any login performed on the Control PC is re-

directed and applied on the Client PC. 
• Smartcard authentication - user validation for connections 

supports authentication using a Smartcard PIN as well as the 
existing remote login support. 
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Installation  
 
In this chapter … 
 

How to install the required NetSupport Manager components 

on your Windows-based PCs.  
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Planning an installation 

Installing NetSupport Manager is exceptionally easy and you should 
be up and running within a very short time. 

 
Decide what functions to install  
On the workstation from which you will remote control other PCs and 
devices, you will need to install the Control. 
 
On every machine or device that you wish to connect to, you will 

need to install the Client. 
 
Decide whether you need to customise your installation with 
advanced NetSupport Manager features, such as using Scripting and 
Deploy, or using the machine as a Gateway. 
 
Also supplied with NetSupport Manager is the NetSupport School 

training tool. This provides trainers with the ability to instruct and 
visually/audibly monitor, as well as interact with their trainees, 
individually, as a pre-defined group or to the whole class. 

 
Decide what network protocol to use  

Decide what networking protocol you have available on the 
workstation. NetSupport Manager supports TCP/IP and HTTP and 
provides legacy support for IPX and NetBIOS. 
 

While NetSupport is multi-protocol, which means that the same 
Control can connect to Clients running on different protocols, you 
must choose a default. You can change this later. 
 

Note: By default, the Control will be configured to use TCP/IP. If 
you are using a different protocol, you must configure this 
the first time you start the Control. 

 
You are now ready to install NetSupport Control and Client programs. 
 
For details of how to install on: 
Mac machines, refer to Installing NetSupport Manager on a Mac-
based system.  

Google Chrome, refer to Installing a NetSupport Client on Google 

Chrome devices. 

Android devices, refer to Installing a NetSupport Manager Android 
Client. 
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Note: NetSupport Manager provides support for Windows 64 bit on 
Intel EM64 and AMD64 platforms. The NetSupport Manager 
Windows Installer can be used to install the NetSupport 64 bit 
Client. For further information, please visit 

www.netsupportsoftware.com/support 

 

System requirements 

Some areas of NetSupport’s functionality rely on the presence of 

certain files/applications; please ensure these are available before 
installing NetSupport Manager: 
 
PC requirements:  

Windows 11, Windows 10, Windows  8/8.1 (32bit and 64 bit), 
Windows Server 2022, 2019 and 2012, Windows 7* (32bit and 
64bit), 2008 (32bit, 64 bit and R2), Vista (32bit and 64 bit) and 2003 
(Service Pack 1). 

 
* For the NetSupport Manager Control to run on Windows 7, Aero 

needs to be enabled. Choose Start > Control Panel. In the 
Appearance and Personalization section, click Customize Color. 
Choose Windows Aero from the Color Scheme menu and then click 
OK. 

 
TCP/IP, HTTP or legacy (IPX and NetBIOS). 
 
NetSupport Manager offers full integration with thin and zero Client 
environments as well as compatibility with MultiPoint, MultiSeat and 
virtual desktop environments from WYSE Technologies, Microsoft, HP, 

NComputing (X-series and L-series), MiniFrame (SoftXpand) and 

many others. 
 
Mac requirements: 

The NetSupport Manager macOS Control runs on macOS 10.15 
(Catalina) and above. 
 
The NetSupport Manager Client for macOS is available on macOS 
10.14 (Mojave) and above. 
 

Mobile Control:  

The NetSupport Manager Mobile Control for iOS and Android provides 
mobile remote control for existing NetSupport Manager remote 
control users from any iPad, iPhone, iPod, Android Tablet and 

smartphone or Kindle Fire. 

http://www.netsupportsoftware.com/support/
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The NetSupport Manager Mobile Control is available for free download 

from appropriate App Stores. Visit 
www.netsupportmanager.com/mobile.asp for more information. 
 
Android Client app: 

The NetSupport Manager Client for Android can be installed on each 
Android device (5 or later) and connected from the Windows Control 
(12.5 or above). 
 

Chrome OS Client: 

For use in an existing or new NetSupport-managed environment, the 
NetSupport Manager for Chrome Client extension can be installed on 

each Chrome OS device. From the Control, you can then connect to 
each system, enabling you to monitor the screens and interact with 
each Chrome OS device quickly and efficiently. 
 
Legacy platform support 

Legacy support is provided for the following platforms:   
 

Windows NT4, Windows 2000, Windows XP and Windows 2003 (pre 

Service Pack 1). 
 
Mac: 

The NetSupport Manager Mac Client supports macOS version 10.9 – 
10.13 and later on Intel platforms. 
 

Linux requirements: 

At the time of release, the NetSupport Manager Linux Client supports: 

OpenSUSE 11.2 and later, SUSE Enterprise 11, SUSE Enterprise 
Server 11, Ubuntu/Edubuntu 9.04 and above, Debian 5 and 6, Red 
Hat Enterprise Linux 6, Linux Mint 9 and above and Fedora 12 and 
above. 
 

Desktop Managers: GNOME, KDE, Unity 2D, Ubuntu Classic (No 
Effects Only), MATE and Cinnamon. 
 

Pocket PC: 

Operating system: Pocket PC 2003 or Windows Mobile 2003 and 

above. 
Processor: Strong ARM processors. 
ActiveSync / Wi-Fi wireless LAN capabilities. 
Device RAM: 32Mb (64Mb recommended). 
Storage: Minimum 2Mb, full installation 10Mb required. 
 

http://www.netsupportmanager.com/mobile.asp
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Windows CE: 

Operating System: Windows CE 4.2 or above. 
Processor: Strong ARM processors, X86 Compatible. 

ActiveSync capabilities. 
Device RAM: 32Mb (64Mb recommended). 
Storage: 5Mb free space required. 
 

Note: An earlier version of NetSupport Manager may be required on 
these platforms and can be downloaded from  

 www.netsupportmanager.com/downloads.asp   

 

Starting the installation 

Download your copy of NetSupport Manager from 
www.netsupportmanager.com/downloads.asp 

 
Click the appropriate language from the menu and select the option 
to install NetSupport Manager.  
 

Select which installer to use: setup.exe or MSI file. If an Active 
Directory deployment is required, you will need to install using the 

MSI file. 
 

Notes: 
• If you are upgrading your Windows operating system, you must 

ensure that you uninstall NetSupport Manager prior to 
upgrading. NetSupport Manager can then be re-installed once 
the operating system upgrade has been completed.  

• When installing, make sure that you are logged in as an 

Administrator. 

 

http://www.netsupportmanager.com/downloads.asp
http://www.netsupportmanager.com/downloads.asp
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NetSupport Manager setup program 

The setup program Welcome screen will appear.  

 

Click Next to continue. 
 

NetSupport Licence Agreement 

The NetSupport Licence Agreement will be displayed. Please read the 
Licence Agreement carefully and select “I accept the terms in the 
Licence Agreement” and click Next to continue. 
 

If you reject the Licence Agreement (“I do not accept the terms in the 
Licence Agreement”), click Cancel. NetSupport Manager will not be 
installed and you will be directed to exit from the install program. 

 

Licence information 

Select Register and enter the NetSupport Manager licence details 
you have been provided with. 
  
If you are evaluating NetSupport Manager, select 30-day evaluation 
and click Next. 
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Select Setup Type  

 

Choose the setup type to install on the workstation. 

• Typical  
Installs all the components that a Control user would generally 
need. Excludes the Gateway and NetSupport School components. 
See below for a description of each NetSupport Manager 

component. 

• Client  
Installs the Client software. This feature should be installed on 

workstations to be remote controlled. 

• Custom  
Enables you to individually select the mix of components that are 

appropriate for the workstation.  
 
Click Next to continue. 
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Custom Setup 

If you have chosen to perform a Custom Setup, you will be able to 
select the required components individually to suit the requirements 
of each workstation. 

 

Client 
Install this component on workstations you want to remote control. 
 

Student 
Installs the Student component of NetSupport's training tool, 

NetSupport School.  
 
Configurator 
Client settings and security are established using the Client 
Configurator. Basic settings can be entered at the end of the 
installation process but to set more advanced options, install the 
Configurator component. 

 

Control 
Install this component on workstations that will be taking control of 
Client workstations. It is recommended that the Client component is 
also installed in order to use the full range of NetSupport Manager 
functions, for example, Show. 
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Tutor 

Installs the Tutor component of NetSupport's training tool, 
NetSupport School. 
 
Tech Console 
Installs the Tech Console component of NetSupport School. This 
provides lab technicians and network managers with the main 

NetSupport School features. 
 

Gateway 
NetSupport Manager’s Gateway feature provides a means of 
connecting Clients and Controls across the internet, thus delivering 
web-based remote control without the need for modifications to 
existing Firewall configurations. There is no direct connection between 

the Client and Control; all data is passed via the Gateway. The 
Gateway component can, therefore, be installed independently of the 
Control and Client. If you choose to install the Gateway component, 
the Gateway Configuration dialog will appear after the installation has 
finished. 

 

Note: The Gateway can't be installed on a machine that has the 
NetSupport DNA Local (Server) Gateway installed on it. 

 
PIN Server 
Installs NetSupport Manager's PIN Server. The PIN Server provides 
the central point where a unique PIN code is created when using the 
PIN Connect feature. 

 
Remote Deployment Utility (supported on Windows XP and 

above) 
The NetSupport Manager Deploy utility enables you to perform 
multiple NetSupport Manager installations without the need to visit 
each individual workstation. See the NetSupport Manager Deploy 
section of this manual for more information. 

 
Scripting 
Install NetSupport Manager’s integrated Scripting and Scheduling 
suite. Create scripts to automate manual tasks and schedule them to 
run at specific times. Ideal for overnight updates. See the NetSupport 

Manager Scripting section of this manual for more information. 
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Install Desktop Icons 

Choose whether to create desktop icons, e.g. for the NetSupport 
Manager Control, the  NetSupport School Tutor or the NetSupport 
School Tech Console, to allow easy access to the programs. 
 
Install Start Menu Icons 
Choose whether to create Start menu icons for the components you 

are installing. 
  

Note: NetSupport Manager provides exceptional multimedia 
support. The NetSupport Manager Video Player enables you 

to run video files on Client workstations, enhancing training 
sessions and demonstrations. This is installed by default with 
the Tutor component. 

 
Install to: 
By default, NetSupport Manager will be installed in the folder 
C:\Program Files\NetSupport\NetSupport Manager. If you want to 
install in a different folder, click Change. 

   
Click Next to continue. 

 

Ready to install 

To start the installation, click Install. To change any of the previous 

selections, click Back. To quit the installation, click Cancel. 
 

Note: If you have elected to install a Client, setup will make the 
required amendments to your System.ini and/or registry to 

load the Client as Windows initialises. NetSupport Manager 
will not replace any of your existing drivers. 

 

Installation complete 

This final screen confirms that the installation has been successful.  
 

Run Client Configurator 
At the end of the installation process, you will have the opportunity to 
run the Client Configurator. This enables you to set basic Client 

information and security. If the Configurator is being installed as one 
of the selected components, you will be able to access more 
advanced configuration options.  
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Run Remote Deploy 

Selecting this option will run the NetSupport Manager Deploy utility 
after the installation process. This allows you remotely to install and 
configure NetSupport Manager on multiple workstations. 
 
Click Finish to exit the Setup program.  
 

Note: If you choose to install the Gateway component, the 
NetSupport Connectivity Server dialog will appear. This allows 

you to create a security key for the Gateway. 

 

Existing installation detected  

This screen will appear if a copy of NetSupport Manager is already 
installed on the workstation. 

  

• Modify 

Change the program features that are installed. 
 
• Repair 

Repair any installation errors in the program. 

 

• Remove 

Remove NetSupport Manager from the computer. 
 

Select the required option and click Next. 
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Uninstalling NetSupport Manager 

The standard method for uninstalling NetSupport Manager is to select 
NetSupport Manager in Control Panel – Add/Remove Programs. 

 
For Windows XP and above workstations, NetSupport Manager Deploy 
can be used to perform multiple uninstalls from a remote location. 
Refer to the NetSupport Manager Deploy section of this manual for 
more information. 
 

Evaluation kit 

NetSupport Manager is available as an Evaluation kit either from 

distributors or free as a downloaded copy from the internet. This 
allows you to trial NetSupport Manager before your purchase. The 
Evaluation Kit software is fully functional, apart from the following 
restrictions: 
 
• A maximum of ten Clients can be active on the network 

simultaneously. 

• The Client and the Control programs will not run after the expiry 
date has passed. 

 
Upon purchase, these restrictions are removed once serialisation has 
been completed. This process upgrades the Evaluation Kit into a fully 
licensed copy.  
 

To upgrade an evaluation kit to a fully licensed copy 

1. Click Help  on the caption bar and select About. 
2. Select the License tab. 

3. Click Update License. 

Or 
 
In the directory that you have installed the Program Manager group 
‘NetSupport Manager’, open the file PCILIC.EXE. 

 
The NetSupport Manager Licence dialog box will appear asking you to 
enter your licence details. Please note that all entries are case 
sensitive.  

 
When you have entered the correct licence details, click Generate. 

You now have a fully licensed copy of NetSupport Manager. 
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Advanced installation  
 

In this chapter……. 
 

How to prepare and run ‘silent’ installations across a network. 

Using the NetSupport Manager Deploy utility to perform 

multiple installations. 

Installing NetSupport Manager on a Mac based system. 

Installing a NetSupport Manager Client on Google Chrome. 

Installing a NetSupport Manager Android Client. 

NetSupport Manager Mobile Control for iOS and Android. 
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Creating an administrative (network) 

installation 

An administrative installation (distribution copy) of NetSupport 
Manager is designed to assist Administrators to install NetSupport 
Manager on networked PCs where the installation media or licence 
details may not be readily available and it is anticipated that a 
number of installs will be performed either at once or over a period of 

time. 

 
This type of installation can also be pre-configured to set up 
NetSupport Manager with certain options, therefore ensuring that all 
NetSupport Manager installations are configured in the same way. 
 

Once created, the distribution copy can be used when performing a 
standard installation, a silent installation, or as part of a NetSupport 
Manager Deploy routine. 
 
To set up a distribution copy of NetSupport Manager on a 

Server 
1. Create a folder on the network that is accessible to all PCs that 

you may want to install on. 
2. Copy, from your original source media, the file Setup.exe.  
3. Create and copy a valid NSM.LIC file to this folder. If a licence file 

is not present in the folder when running the install, NetSupport 
Manager will be installed using the default Evaluation licence. 

4. Create and copy a Client32u.ini file to this folder. 

 

Note: You can make the network folder ‘read only’ to avoid the 

configuration being altered by unauthorised users. 

 
To install NetSupport Manager from a server onto individual 
workstations 
1. At the required workstation, navigate to the network folder 

containing the NetSupport Manager setup files. 
2. Run Setup.exe. 
3. Follow instructions in the Starting the Installation section.  
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Silent/unattended installations  

A silent installation is one which that requires no input from the user, 
providing a convenient method for performing a set installation at 

several machines. 
 
To perform a silent install 
1. Create a distribution copy of NetSupport Manager containing the 

required NetSupport Manager installation files.  
2. To determine the properties for the installation, run INSTCFG.EXE 

from the NetSupport Manager program folder. The Install 
Configuration Options dialog will appear. (See the Install 
Configuration Options dialog section below for a full description of 
this dialog). Your chosen properties are stored in a parameter 
file: default name NSM.ini.  

3. Choose {File}{Save} and save the ‘NSM.ini’ file to the folder 
containing the distribution copy of NetSupport Manager. 

4. To perform the silent install at the required workstation, from the 
folder containing created above, run: 

msiexec /i "NetSupport Manager.msi" /qn (MSI installer) 

setup /S  /v/qn (setup.exe installer) 
 

Note: NetSupport Manager can be installed via Active Directory. The 
software installation group policy object (GPO) must be applied 
to organisational units (OUs) containing computer accounts 
rather than users. Please note that for software installation to 

take effect immediately, it is necessary to enable the "Always 
wait for the network at computer startup and logon" 
parameter in the Computer Configuration| Administrative 

Templates| System| Logon| leaf of the group policy controlling 
the computers that are subject to software installation. This 
change will affect login times for Windows XP machines that 
have this applied. Without this change, an additional log off / 

log on cycle is required to effect installation. 
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Install Configuration Options dialog  

When performing a silent installation or using NetSupport Manager 
Deploy, you can customise the installation to suit individual 
requirements. This dialog, accessed by running INSTCFG.EXE from 
the NetSupport Manager program folder if performing a silent 
installation or, if using NetSupport Manager Deploy, via the Install 

Properties General tab, enables you to specify the properties for the 
installation. The information is stored in a parameter file, NSM.ini. 

 

Select the relevant checkboxes to indicate which NetSupport Manager 
components will be installed. Choose whether to create a desktop 
icon for the Control, the School Tutor and the Tech Console and Start 
menu icons for the components you are installing. 
 
Client Parameters (optional) 

If you have created a particular Client configuration file for use after 
the installation, specify the path and file name here. Depending on 

the location of the file, you may need to provide a set of user 
credentials (name and password) to give Clients access to the file. In 
order to specify the parameters in the correct format, it is suggested 
that you create them in the NetSupport Manager Client Configurator 
and copy them to this field.  
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Leave the field blank if you are installing from your distribution copy 

or if you want to use the default configuration file contained in the 
NetSupport Manager setup package. 
 
To specify Client parameters 
1. Open your NetSupport Manager Program folder by choosing 

{Start}{Programs}{NetSupport Manager}{NetSupport  Manager 

Configurator}. 
2. Choose Advanced. 

3. Select {Profiles}{Client Parameters} from the Configurator drop-
down menu. 

4. The Client Parameters dialog will appear. 

 

5. Click Add to specify the parameters. 

Notes: 
• If user credentials are required, they must precede the 

configuration file name. 
• Each set of parameters must be added separately. 

6. If required, enter the user credentials (user name and password). 
Click OK. The appropriate strings will appear in the dialog. 

7. Click Add to specify the location of the configuration file. Click 
OK.  

 

When the Client Parameters dialog contains the required strings, copy 

them individually to the Install Configuration Options dialog (use 
Ctrl+C to copy, Ctrl+V to paste). 
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Install Directory 

Specify the directory where NetSupport Manager will be installed. 
Leave blank to install in the default directory \Program 
Files\NetSupport\NetSupport Manager. 
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NetSupport Manager Deploy – NetSupport 

Manager’s Remote Install Utility 

The NetSupport Manager Deploy Utility provides network 
administrators with the facility to install and configure NetSupport 
Manager on multiple workstations without the need to visit the 
machines individually.  
 
Within the NetSupport Manager Deploy utility, you have the ability to 

deploy using an IP address range (specified IP ranges or computers 

with an IP range local to the Control), Windows domain or, 
alternatively, you are provided with a view of your network. These 
methods allow you to pick and choose which computers you want to 
deploy to.  
 
The NetSupport Manager Deploy utility can be used to deploy to 
computers running the following operating systems: 

 
• Windows XP 

• Windows 2003 
• Windows Vista 
• Windows Server 2008\2008r2 
• Windows 7 

• Windows Server 2012 
• Windows 10 
• Windows Server 2019 
• Windows 11 
• Windows Server 2022 
 

Note:   Due to operating system limitations, the NetSupport Manager 
Deploy utility does not work with Windows XP Home, 
Windows Vista Home Premium or Windows 7 Starter/Home 
edition. 

 
With NetSupport Manager Deploy, you can: 

• Remotely install a NetSupport Manager package on multiple 
workstations simultaneously. 

• Create and download specific Client configurations to multiple 
workstations. 

• Remotely update NetSupport Manager licence details on multiple 
workstations. 

• Remotely uninstall a NetSupport Manager package from multiple 
workstations simultaneously. 
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Notes: 
• When deploying to a Windows Vista (or later) PC within a domain, 

the console user must be either logged onto the domain or enter 
the user credentials (when prompted) of a domain account that 

has local administrator rights to the target PC. 
• The Deploy Prompt User option is not supported on Windows 

Vista and above. 

 

Installing the Deploy Utility 

When installing NetSupport Manager, select Typical Installation to 

install the NetSupport Manager Deploy Utility automatically. 
Alternatively, you can also choose it as part of a custom installation. 

 
Planning 
NetSupport Manager Deploy is a powerful utility that makes installing 
NetSupport Manager packages on multiple workstations a quick and 
easy process. However, while we endeavour to ensure that there are 
no limitations or incompatibility issues in the use of the software, it is 
recommended that a trial deployment is performed on a small 

number of workstations to ensure there are no conflicts with other 
similar products such as remote control or desktop security packages. 
In addition, for added security and protection, you must have 
appropriate administrator rights for the machines you are deploying 
to.  
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Deploying on Windows XP and above 

To deploy NetSupport Manager on Windows XP Professional and 
above, you need access to the Admin$ share on the remote machine 
in order to transfer the package to be deployed. By default, there is 

no access allowed to Admin$ share. 
 
To enable network access: 
1. In Administrative Tools, select Local Security Policy. 
2. Select {Security Settings}{Local Policies}{Security Options}. 

3. Select {Network access: Sharing and security model for local 

accounts}. 
4. Alter the setting for this policy to {Classic – local users 

authenticate as themselves}. 
 
The Admin$ share will now be available and you can deploy as 
normal. 

 

If upgrading from Microsoft Windows XP Service Pack 1 to Service 

Pack 2, Windows Firewall will by default block all network activity 

produced by NetSupport Manager. To enable NetSupport Manager to 
function correctly, we have provided a utility that will configure 
Windows Firewall. 
 
To enable NetSupport Manager in the Windows Firewall 

Configuration 
1. Download the ICFCONFIG.EXE File (link at 

www.netsupportsoftware.com/support). 
2. Run this utility on a machine with NetSupport Manager installed 

using the following command: 

                 ICFCONFIG -e NSM 

3. This will create all the required entries in the Windows Firewall 

configuration to allow NetSupport Manager to function correctly. 
 
The ICFCONFIG utility can also be used to remove a NetSupport 
Product from the Windows Firewall configuration. See our website  
www.netsupportsoftware.com/support/ for all the ICFCONFIG 
Command line options. 
 

http://www.netsupportsoftware.com/support/
http://www.netsupportsoftware.com/support/
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How does NetSupport Manager Deploy work? 

Once the Deploy options have been configured, the NetSupport 
Manager Deploy Utility works by connecting to the target computer 
using File and Print Sharing. 

 
This method requires access to the target computer’s Admin$ and will 
need to connect as a user with local administrator access (user 
details may be requested). 
 

Once authenticated, the NetSupport Manager package files are copied 

to the following folder on the remote PC using the connection to the 
Admin$ share: 
 
C:\Windows\pcirdist.tmp\ 
 
Finally, once the files have been sent to the target PC, the installer 
file is executed using the Remote Procedure Calls (RPC) Service. 

 

What are the requirements? 

In order to successfully deploy NetSupport Manager components to 

your target PCs, the following items are required: 
 
• File and Print Sharing must be enabled on the target PC. 
• The Sharing and Security for local accounts policy must be set to 

{Classic} on the target PC. 
• The user account used to connect to the target PC must have 

local administrator permissions on the target PC. 
• Network discovery must be enabled on Windows Vista and 

Windows 7 target PCs. 
• UAC Remote Restrictions must be disabled for target PCs running 

Windows Vista and Windows 7 in a workgroup environment. 
 

Starting NetSupport Manager Deploy  

1. Select NetSupport Manager Deploy from your NetSupport 
Manager Program group. 

2. The NetSupport Manager Deploy main window will appear. 
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NetSupport Manager Deploy main window  

 

The Deploy main window is divided into the following 
sections: 
Menu bar 
The menu bar contains a series of drop-down menus that can be used 

to access the various tools and configuration utilities for the deploy 
process. 
 
Left-hand pane 
Contains three tabs: Network, Log Files and Security. 
 
Network and Security tabs 

Lists, in a Tree view, the available networks, domains and 
workgroups that can be selected for a deploy routine. 
 

Log Files tab 
Lists, in a Tree view, a history of previous deployments.  
 

Right-hand pane 
With the Network tab selected, you are provided with a range of 
general information about the workstations located on the selected 
network/domain (machine name, Client address and MAC address). 
 
The Log Files tab provides a breakdown of past deployments 
categorised by type. 

 
The Security tab also lists information specific to each individual 
workstation located on the chosen network/domain. In addition to the 
machine name and IP address, you will be able to see the platform 
the machine is running on, determine if the machine already has a 
NetSupport Manager Client installed and which version is running, 
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whether the Client is password protected or has user 

acknowledgement set. With this information to hand, you can decide 
in advance which machines to include or exclude from the 
forthcoming deployment. For example, if a current NetSupport 
Manager Client is already installed at some of the workstations, you 
might choose to ignore it. 
 

Preparing a deployment routine  

Choosing who to deploy to 

1. From the main window, select the Network or Security tab. 
2. A list of available networks, domains and workgroups will appear 

in the left-hand pane. Expand or reduce the tree list by clicking 

on the arrows. 

Note:  You can also deploy to specific IP ranges by adding the 
appropriate address range to the tree. Select 
{Tools}{Add IP Range} from the menu bar. 

3. Highlight the required group. 
4. The names of the workstations belonging to the selected group 

will appear in the right-hand pane. You can change the 
appearance of the list view by selecting {View} from the menu 
bar. 

5. Select the workstations to include in the deploy routine. (You can 
use CTRL-Click or SHIFT-Click). Before deciding to include or 
exclude a workstation, you can view its properties by right-
clicking on the machine name. 

 

Note: A Wake on LAN can be sent to machines that are not turned 
on, ensuring deployments are sent to all required machines. 

Select the required machines and choose {View}{Wake 
Selected (WOL)} from the menu bar. 
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Choosing what to deploy 

You can choose:  

•  NetSupport Manager package. 

•  Client configuration. 
•  NetSupport Manager licence file. 
•  Uninstall NetSupport Manager. 
 

Note: The properties for each of the above can also be pre-defined if 
it is not convenient to deploy immediately. See pre-define 

settings for a future deployment. 

 
Deploy a NetSupport Manager package  

A NetSupport Manager package is created as standard when the 

Deploy component is selected with the installation. To distribute the 
package, select the required workstations: 
 
1. Choose {Deploy}{NetSupport Manager Package} from the Deploy 

main window drop-down menu. 

Or 
Right-click on the selected workstations and choose {Deploy-

NetSupport Manager Package}. 
2. The Deploy Summary dialog will appear.  

 

This dialog provides a summary of the options you have selected 
for the deployment. Click Properties to amend the information 
for the deployment. 

3. The Install Properties dialog will appear. 
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4. To amend the properties for the deployment, select the relevant 

tab. 
 

General tab 
Used to specify the NetSupport Manager package to deploy and 

which components are to be installed. 
 
The description for the package will be set to NetSupport 
Manager. 
 
By default, the location of the package to be installed is set to the 

Deploy folder where the NetSupport Manager package has been 
created. 
 
Click Edit to specify the components to install. The Install 
Configuration Options dialog will appear. (See the ‘Install 
Configuration Options Dialog’ section of this manual for a full 
description of this dialog.) 

 

Note: Because of the way NetSupport Manager Deploy handles 
restarting workstations, leave the Restart Machine box 

un-checked. This is only relevant when performing a 
silent install where The Install Configuration Options 
dialog is also used for specifying the options to install. 
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When you have completed this dialog, choose{File}{Save} to 

save the NSM.ini file to the folder containing the distribution copy 
of NetSupport Manager. 
 
Choose {File}{Exit} to return to the Install Properties dialog. 
 
Options tab 

Use the information supplied in the Network and Security tabs to 
identify which machines may already have NetSupport Manager 

installed. You can then choose to: 
 
• Ignore them by checking the Skip machines already 

running NetSupport Manager box. 
• Update the machines with the latest version by checking the 

Update new or older systems to current version box. 
• After deploying the package, you can confirm that the Client 

is running by checking the Verify Client running after 
restarting box. Ensure that workstations are restarted 
automatically after the deploy for this option to work. See 

Restart tab. 
 

Acknowledgement tab 
Consider whether the workstations will be in use when 
commencing the deploy. You can choose to: 
 
• Install NetSupport Manager Immediately. No prompt will be 

received at the workstations being deployed to. 

• Warn user before installing NetSupport Manager. The user will 
receive a prompt and needs to click OK for the install to 

commence. Users cannot cancel this. 
• User can postpone NetSupport Manager installation. You can 

specify the number of times a user can postpone the 
installation. If the user does choose to postpone, they will be 
re-prompted at hourly intervals or the next time they restart 

the workstation, whichever comes earlier. 
 
Message tab 
You can specify a custom message to be displayed at each 
workstation while the installation is in progress. 

 
Restart tab 

These options are only applicable if the target PCs require a 
forced restart to complete the installation. 
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Note: If you have asked for verification that the Client is running 
(see Options tab), you must choose an option that will 
force the workstations to be restarted immediately. 

 
• Advise user to restart machine. At the completion of the 

deployment, a message will be displayed at workstations 
asking the user to restart the PC at the next convenient 

opportunity. Do not choose if the above note applies. 
• Insist user restarts machine. A message will be displayed at 

workstations advising the user to restart the PC to complete 
the installation. 

• Force restart. At the end of the deployment, a message is 
displayed advising users that the workstation will be 
restarted. A time bar is displayed indicating how many 

seconds it is before the restart commences. 
• Automatic restart if not logged on. If the workstation being 

deployed to is not logged on, a restart will commence 
automatically. 

 

5. Click OK to return to the Deploy Summary dialog.  
6. Click Deploy to commence the installation. A progress dialog will 

appear, enabling you to monitor the deployment as it installs on 
each workstation. 

 

The dialog has two tabs:  
 
Log tab enables you to monitor the deployment as it reaches 

each workstation.  
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Status tab lists the stage the deployment has reached on each 

workstation. For example, the installation may be complete on 
one machine but still in progress on another. 

7. Click Close to return to the Deploy main window when the 
installation is complete.  

  

Deploy a Client Configuration  

Using NetSupport Manager Deploy, you can remotely deploy a Client 
configuration file containing specific Client settings. For more 

information on configuring Clients, see the Configuring the Client 
section of this manual. 
 

1. Select the required workstations. 
2. Choose {Deploy}{Client Configuration} from the Deploy main 

window drop-down menu. 
Or 
Right-click on the selected workstations and choose 
{Deploy}{Client Configuration}. 

3. The Deploy Summary dialog will appear. 

4. Click Properties to enter the details for the deployment.  
5. Click Browse to specify the folder containing the Client 

configuration file that is to be deployed. The default configuration 
file is CLIENT32U.ini and is stored in the NetSupport Manager 
installation directory. 

Note: The default configuration file for Clients pre-v12.50 is 

called CLIENT32.ini. 

6. Click Edit to access the Advanced Client Configurator in order to 
make changes to the configuration file. See the Advanced Client 

Configuration section of this manual for more information. 
7. You can specify additional Client parameters if required. For 

example, this may be the location of an additional configuration 
file to which you want to add specific user credentials (name and 
password). 

8. For the new settings to take effect immediately, the Client service 
will be automatically restarted after the deployment. If a restart 
is not required, uncheck the Restart the Client service box. 

9. Click OK to return to the Summary dialog. You can view the 

contents of the configuration file by clicking on the file name. 

10. Click Deploy. A progress dialog will appear, enabling you to 
monitor the status of the deployment. 

11. Click Close when complete. 



NetSupport Manager v14.00 

 

 48 

Deploy a NetSupport Manager licence file  

When installing a NetSupport Manager package, a licence file is sent 
to each workstation. However, there may be occasions when the 
licence information needs updating. For example, you have purchased 
additional licences and the licence file needs updating to reflect this. 
By using NetSupport Manager Deploy, you can remotely update the 

file on user workstations. 
 
1. Select the required workstations. 

2. Choose {Deploy}{NetSupport Manager Licence file} from the 
Deploy main window drop-down menu. 
Or 

Right-click on the selected workstations and choose 
{Deploy}{NetSupport Manager Licence file}. 

3. The Deploy Summary dialog will appear. 
4. Click Properties to enter the details for the deployment.  
5. Click Browse to specify the folder containing the licence file that 

is to be deployed. The default file is NSM.LIC.  
6. For the new settings to take effect immediately, the Client service 

will be automatically restarted after the deployment. If a restart 
is not required, uncheck the Restart the Client service box. 

7. Click OK to return to the Summary dialog. You can view the 
contents of the licence file by clicking on the file name. 

8. Click Deploy. A progress dialog will appear, enabling you to 
monitor the status of the deployment. 

9. Click Close when complete. 
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Remote uninstall  

Using NetSupport Manager Deploy, you can remotely uninstall a 
NetSupport Manager package. 
 
1. Select the required workstations. 
2. Choose {Deploy}{Uninstall NetSupport Manager} from the 

Deploy main window drop-down menu. 
Or 
Right-click on the selected workstations and choose 

{Deploy}{Uninstall NetSupport Manager}. 
3. The Deploy Summary dialog will appear. 
4. Click Properties to enter the details for the deployment. The 

Uninstall NetSupport dialog will appear. 

 

5. Enter the properties for the deployment by selecting the four tabs 
in turn. 

 
General tab 
Provides a description of the package being uninstalled. 

 
Acknowledgement tab 
Consider whether the workstations will be in use when  

commencing the deploy. You can choose to: 
 
• Uninstall NetSupport Manager Immediately. No prompt will be 

received at the workstations being deployed to. 
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• Warn user before uninstalling NetSupport Manager. The user 

will receive a prompt and needs to click OK for the uninstall to 
commence. Users cannot cancel this. 

• User can postpone uninstall of NetSupport Manager. You can 
specify the number of times a user can postpone the uninstall. 
If the user does choose to postpone, they will be prompted the 
next time they restart the workstation. 

 
Message tab 

You can specify a custom message to be displayed at each 
workstation while the uninstall is in progress. 
 
Restart tab 
To completely remove all NetSupport Manager files, the  

workstations must be restarted. 
 
• Insist user restarts machine. A message will be displayed at 

workstations advising the user to restart the PC to complete 
the process. 

• Force restart. At the end of the deployment, a message is 
displayed advising users that the workstation will be 

restarted.  time bar is displayed indicating how many seconds 
it is before the restart commences. 

• Automatic restart if not logged in. If the workstation being 
deployed to is not logged in, a restart will commence 
automatically. 

 

6. When you have completed all four tabs, click OK to return to the 
Deploy Summary dialog. You can review your selections and edit 

if required. 
7. Click Deploy to commence the uninstall. A progress dialog will 

appear, enabling you to monitor the deployment as it uninstalls 
each workstation. 

8. Click Close when complete. 
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Pre-define settings for a future deployment 

There may be occasions when you want to defer a deployment until a 
more convenient time of the day. With NetSupport Manager Deploy, 
you can prepare the settings in advance and choose when to perform 
the deployment. 
 

Note: You select the workstations to deploy to when you are ready 
to run the deployment. 

 
To prepare the settings for a future deployment 

1. Choose {Deploy}{Configuration} from the Deploy main window 
drop-down menu. 

2. The Deploy List dialog will appear. Select the required Deploy 
Option. (Package, Client Configuration, Licence File or Uninstall) 

3. Click Properties and enter the required settings. 

4. When all settings are entered, click Close to return to the Deploy 
main window. 

 

To run the deployment 

1. Select the workstations to Deploy to. See Preparing a 
Deployment. 

2. Choose {Deploy} from the main window drop-down menu. 
Or 
Right-click on the selected workstations and choose Deploy. 

3. Select the required Deploy option. 
4. The Deploy Summary dialog will appear, showing your pre-

defined selections. You can edit these if required. 
5. Click Deploy to start the deployment. 
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Log files  

When using NetSupport Manager Deploy, information about each 
deployment, whether a package install, licence update, configuration 
download or uninstall, is recorded. This provides a useful reminder 

each time you use the utility of what you have previously deployed. 
The information is stored in a log file. 
 
To view log files 
1. From the NetSupport Manager Deploy main window, select the 

Log Files tab. 

 

2. In the left-hand pane of the main window, increase or decrease 
the Tree view to see a description of each type of deployment, 
the date and time the deployment took place and the 
workstations that were deployed to. 

3. As you select an item from the left-hand pane, itemised 

information about that deployment will appear in the right-hand 
pane. 

 
Printing a log file 
1. Select the required Log File in the Tree view. 
2. Choose {Log}{Print} from the Deploy main window drop-down 

menu. 
 
Deleting a log file 

1. Select the required Log File in the Tree view. 

2. Choose {Log}{Delete} from the Deploy main window drop-down 
menu. 
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Installing NetSupport Manager on a Mac based 

system 

A NetSupport Manager Control and Client can be installed on Mac 
systems, allowing you to remote control other workstations/devices 
from a Mac and also enabling a Control to connect, view the screen of 
the remote user and perform a variety of remote control tasks.     
 

Notes:  

• The NetSupport Manager macOS Control runs on macOS 10.15 
(Catalina) and above. 

• The NetSupport Manager Client for macOS is available on macOS 
10.14 (Mojave) and above. 

  

Installing NetSupport Manager 
1. NetSupport Manager is provided as a standard macOS .pkg file, 

this is available from our downloads area at 
www.netsupportmanager.com/downloads.asp (full installation 
instructions will also be available here). 

2. Download the .pkg file and double click it to run the package. 
3. The installer will automatically run, follow the on-screen 

instructions.  
 
For information on using the NetSupport macOS Control, click here. 
 
 
 
 

http://www.netsupportmanager.com/downloads.asp
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Installing and configuring NetSupport Manager 

on Google Chrome OS devices 

NetSupport Manager provides remote control capabilities for any 
Google Chrome OS device running the NetSupport Manager Chrome 
OS Client extension.  
 
The NetSupport Manager Client for Google Chrome extension can be 

installed on each Client machine running the Google Chrome OS. 

From the technician’s desktop, you can then connect to each system, 
enabling you to monitor and interact with each client quickly and 
efficiently. 
 
Planning an installation 

For a NetSupport Manager Control to be able to connect and interact 
with Chrome OS devices, the NetSupport Connectivity Server must be 
installed on a Windows Server; the NetSupport Manager Control 
(Windows, Mac or Mobile) must be installed on the technician’s 
computer, and the NetSupport Manager Chrome Client extension 

installed onto each Chrome device.  
 

The NetSupport Manager Client for Chrome OS can be used with your 
existing NetSupport licences already purchased (as long as you have 
sufficient unused licences), or additional Chrome OS only Client 
licences can be purchased from your NetSupport reseller.  
 
Installing and configuring the NetSupport Manager Client for 
Google Chrome extension 

1. Download the NetSupport Manager for Google Chrome extension 

from the Google Chrome store. 
https://chrome.google.com/webstore 

2. Enter the URL chrome://settings/extensions to access the 
‘Extensions’ configuration page. 

3. Locate the NetSupport Manager Client for Google Chrome 

extension and click Options. 
4. Enter the Gateway address and port number of the Gateway. 
5. Optionally, enter a name that identifies this Client. 
6. Click Save. 
 

Chrome Incognito Mode: 
To ensure that you maintain full control of your Clients, it is 

recommended that you 'disallow' Incognito mode in the Chrome OS 
User Settings. This can be done centrally via the Google Management 
Console. 
 

https://chrome.google.com/webstore/detail/dilkdnaihnkfembidikggnigimnbjcjn
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Key features when connecting to Chrome OS ‘Client’ systems include: 

 
Environment 
• A NetSupport Manager Control communicates, via HTTP, with 

Google Chrome OS devices that are running the NetSupport 
Manager for Chrome Client extension. For help installing and 
configuring the required components, please refer to the 

documents below.  
 

Remote Control 
• A crystal clear thumbnail of each Chrome OS Client screen can be 

viewed by the Control in a single view. 
• The Client's screen can be discreetly monitored (Watch mode) or 

remote controlled in real-time (Share mode). 

• For real-time instruction or demonstrations, the Chrome OS Client 
can be shown the Control (Windows or Mac) screen - in a browser 
tab or in full screen mode. 

• The Client can also be shown an application running on the 
Control desktop. 

• Multi-monitor support – monitor Chrome OS devices running 
multiple monitors. 

• The Client's mouse and keyboard can be ‘locked’ remotely. 
• Chrome OS Clients can join a text ‘chat’ session initiated by the 

Control. 
• Chrome OS Clients can receive messages sent by the Control. 
 
Support tools 

• Remote Clipboard - the content of the Client’s clipboard can be 
remotely retrieved by the Control during a view session. Clients 

can also be sent a copy of the Control’s clipboard. 
• Request Help facility - Clients can send a request for help to a 

Control. 
 
Flexibility 

• PIN Connect - the Client can initiate an instant connection with a 
Control simply by both parties entering a matching PIN code via a 
central PIN Server module. 

 
Security 

• User Acknowledgement – the Client can authorise each inbound 
connection request.  
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Installing and configuring the NetSupport 

Manager Android Client 

The NetSupport Manager Android Client app gives an existing 
NetSupport Manager Control user the power to connect to Android 
tablets and smartphones in use across your enterprise, enabling real-
time interaction and support. 
 

The NetSupport Manager Android Client app works on Android v4.0 or 

later tablets and is available for free from the Google Play store. 
 

Note: NetSupport Manager v12.50 or later Windows Control 
application required.  

 

Set up and configure the NetSupport Manager Android Client 

Launch the NetSupport Manager Client app, press  and select 
Settings.  
 
General 

Displays the name of the device. This can be customised to a name of 
your choosing. 
 

Security 
Security Key 
This sets a security key that must be the same as that set at the 
Control before the Control will be allowed to connect. This setting is 
optional. If there is no security key set here, any Control may 
connect, regardless of the security key set at the Control.  
 

TCP/IP 
Default port 
The default registered port for NetSupport Manager is 5405. 
 
Multicast address 
This is the IP multicast address that the Client is listening on.  

 
HTTP 
Use Gateway 
Enable this option if you want the Client's current IP address to 

register with a designated 'Gateway' on start-up. Enter the IP address 
of the Gateway along with the matching Gateway key. A secondary 
Gateway address can be added. 

 
 
 

https://play.google.com/store/apps/details?id=com.netsupportsoftware.manager.client&hl=en
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PIN Server 

Enter the IP address of the workstation where the PIN Server is 
installed to allow Clients to connect using PIN Connect. 
 

To save the configuration settings, select . 
 
Features supported on Android: 
• Connect by PIN: NetSupport’s quick and easy PIN Connect 

feature allows seamless and secure connectivity between Control 

and Client devices simply by sharing a matching code. (The PIN 
Server module, included as standard with NetSupport Manager, 

needs to be installed on a Windows PC).                       
• Sending Messages: The Control user can broadcast messages 

to one, selected, or all connected Client devices. 
• Chat: Both the Client and Control can initiate a one-to-one text 

Chat session. The Client can also be invited to join a group 
discussion initiated by the Control. 

• File Transfer: The Control user can transfer files to and from the 

Client device. 

• Screen Capture: During a remote control session, the Control 
can capture screenshots from the Client device. 

• Wi-Fi/Battery Indicators: The Control can view the current 
status of wireless networks and display battery strength for 
connected Client devices.  

 

Additionally, for supported devices*: 

• The Control can view thumbnails of all connected Android devices. 

• Zoom in to view a larger thumbnail of any selected device. 
• The Control can discreetly view (Watch mode) or remote control 

(Share mode) the screen of any connected Client device. 
 
* Supported devices are from those vendors who have provided the 
additional access privileges needed for screen monitoring on their 

devices. Devices running Android 5 or later already have built-in 
screen capture capabilities.
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NetSupport Manager Mobile Control for iOS 

and Android 

The NetSupport Manager Mobile Control for iOS and Android provides 
mobile remote control for existing NetSupport Manager remote 
control users from any iPad, Android Tablet or Kindle Fire. 
 
The Mobile Control allows a user to quickly search and connect to 
local computers by either IP address or PC name or to browse, 
connect and view remote computers using the free NetSupport 

Manager Internet Gateway component. 
 
The NetSupport Manager Mobile Control provides full remote control 
of any remote PC running an existing NetSupport Manager Client 
(version 11.04 or later), as well as chat and message capabilities. 
 
The NetSupport Manager Mobile App can be downloaded from Google 

Play, the Apple iTunes store or the Amazon app store.  

 

https://play.google.com/store/apps/details?id=com.netsupportsoftware.manager&feature=search_result#?t=W251bGwsMSwyLDEsImNvbS5uZXRzdXBwb3J0c
https://play.google.com/store/apps/details?id=com.netsupportsoftware.manager&feature=search_result#?t=W251bGwsMSwyLDEsImNvbS5uZXRzdXBwb3J0c
https://itunes.apple.com/us/app/netsupport-manager-control/id548622961?ls=1&mt=8
http://www.amazon.com/dp/B009CC0VY2/ref=cm_sw_su_dp
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Using the Control 
 
In this chapter … 
 

You will discover how to use the wealth of features available to 

a Control user. From how to initiate a remote control session 

to how you then monitor and manage activity at the end-

user’s desktop.  
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Starting the NetSupport Manager Control 

To start the NetSupport Manager Control program 
1. Double click on the NetSupport Manager Control icon in your 

NetSupport Manager Program group. 
Or 

Click the NetSupport Manager Control desktop icon (if you 
installed a desktop icon for the Control). 
Or 
Choose {Start}{Programs}{NetSupport Manager}{NetSupport 

Manager Control} from your operating system. 
 
As NetSupport Manager initialises, you will see a window in the 

middle of your screen with the NetSupport Manager logo and version 
information. This only appears for a few seconds while NetSupport 
Manager loads, after which the Control window will be displayed and 
the Welcome wizard will appear. From here, you can configure the 
network protocol(s) to use, view the getting started guide and see 
what’s new in this version of NetSupport Manager. To just start the 

Control program, click Start. 

 

Note: By default, the Control is configured to support the TCP/IP 
protocol; however, it can support multiple protocols 

simultaneously. If you receive a protocol error message when 
starting the Control or want to configure it to support Clients 
running on different protocols, click Configure in the 
Welcome wizard or click the Change the settings for the 

current Configuration icon  on the caption bar in the 
Control window and go to the Connectivity section. 
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The Control window 

The Control window is the primary interface for:  
• Configuring the Control 

• Connecting to Clients 
• Maintaining Client information 
• Selecting which Clients to work with 
• Selecting tasks to carry out. 

 

The caption bar 
The caption bar indicates that you are in the Control window and 
displays the name of the NetSupport Manager Control workstation. 
The following options are available: 
 

 Show or hide the ribbon. 

 

 NetSupport Manager allows you to set up multiple 
profiles for different Control users. Here, you can access 
the Configurations dialog, where you can create and 
manage profiles.  
 

 Access the settings for the current Control configuration 
(profile). 
 

 
Shows how many windows are open. From here, you 
can access the Window menu. 
 

 
Access the online help and version number, licensee, 

Technical Support and compression information. 
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The ribbon 

The ribbon provides access to all the features, tools and settings. 
Positioning the cursor over an icon will display a brief description of 
its function. The ribbon is organised into the following tabs: 
 

• Home 
Provides quick access to the tools needed for browsing, locating 

and connecting to Clients. You can also access some commonly 
used Client commands here. 

 
• Group 

Provides access to the group functions within NetSupport 
Manager. From here, you can connect, organise and carry out 
tasks on groups of Clients. 

 

Note: This tab will only appear when you have a group selected. 

 
• Remote 

Here, you'll find the remote and manage features, such as view, 

file transfer, power on/off and scan. You can also communicate 
with Clients using the Chat , Message  and Audio features. 

 
• Desktop 

From here, you can show your screen and applications to Clients, 
record and playback replay files and send a message or 
announcement to Clients. 
 

• Tools 
Provides access to additional tools such as File Manager, File 

Distribution and User-Defined Tools. 
 

• View 
Allows you to customise the look of the List and Tree view and 
search for Clients and objects in the Tree view. 

 

Note: If you have a Client selected, a tab will appear in the ribbon 
displaying the Client name. From here, you can access a 

range of tools and you can view and edit the details for the 
Client machine. If more than one Client is selected, a 

Selection tab appears, allowing you to perform functions to all 
selected Clients. 
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The quick access bar  

The quick access bar allows you to view Clients/groups you have 
recently connected to. From here, you can perform a number of 
commonly used functions, including connecting to and viewing the 
Client. 
 

Note: Clicking Recent will display a drop-down menu, allowing you 
to switch between recent connections and pre-defined groups. 

 

The Tree view 
The Tree view is where NetSupport objects such as Clients and 
groups are created, displayed and organised. Each set of objects is 
stored in its own folder and when the folder is selected, the contents 
are displayed in the adjacent List view. 

The List view  
The List view displays the contents of the currently selected folder in 
the Tree view. You can switch the display mode between large icons, 
small icons, details view or Thumbnail view. The information within 

the List view can be customised to show specific information relevant 
to you.  
 

The status bar 
The status bar is displayed at the bottom of the Control window. It 
shows the number of items in the folder selected in the Tree view, 
along with the number of connected Clients. You can also select 
which objects to work with, how they are displayed in the List view 
and access the thumbnail settings. 
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Quick access bar 

The quick access bar allows you to view Clients/groups you have 
recently connected to. From here, you can see an overview of the 
Client details and perform a number of commonly used functions, 

including connecting to and viewing the Client. 
 
Clicking Recent will display a drop-down menu, allowing you to 
switch the quick access bar between recent connections and pre-
defined groups. 

 

Clicking a Client name brings up a Remote Management pane, and 
from here, you can see details of the Client and perform a variety of 
functions. 
 
By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed alongside the Client on the quick access 

bar. You can customise what is displayed and choose to show the 
Client's logged-on user name, IP address, operating system, 

enclosure type and location by right-clicking on the quick access bar.  
 

Note: Changing the Client display options here will also change them 
on the caption bar, connected Clients list on the status bar 
and when zooming into thumbnails. 

  

Click  to connect to all Clients and  to disconnect from all 
Clients. 

 

To hide the quick access bar 
The quick access bar is displayed by default but can be hidden if 
required.  
 

1. Select the View tab in the ribbon and click Quick Access. 

Note: Click again to show the quick access bar. 
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Tree view 

The Tree view is where you access the information about the various 
NetSupport Manager objects. An object may be an individual Client, a 
group or even a collection of help requests generated by Clients.  

 

Each set of objects is stored in its own folder in the Tree view. The 
individual objects in a folder are displayed in the adjacent List view. 
So, for example, selecting the Active folder will result in the List view 
changing to display all currently connected Clients. 
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The Tree view can be expanded or contracted (depending on the 

detail you require) by clicking the  icon to the left of a folder. 
 

Notes:  
• The height of the items in the Tree view can be reduced if 

required. Select the View tab in the ribbon and click the Compact 
Mode icon. 

• You can hide the Tree view, providing more space when working 

with objects in the List view. Select the View tab in the ribbon 
and click the Show Tree icon. 

 
The available folders are: 
All Computers 
A list of all known Clients that have been connected either during the 
current or previous sessions. It is very quick and easy to connect to a 

Client from this folder as it removes the need to first perform a 
browse or know the network address of the Client. 

 
You can organise individual Clients into groups. Once a Client is 
included in a group, the whole of that group can be connected to and 
worked on simultaneously without the need to connect and select 
them individually. 

 

Clicking the  icon next to All Computers will show any groups that 
have been created. 
 

Auto Group 

Clients will be automatically grouped according to the predefined 
criteria, allowing you to quickly and easily see what operating system 
Clients are using, the NetSupport Manager Client version, the type of 
device and the Client location. These groups are fixed and cannot be 
amended, but you can create your own groups to reflect the company 
structure. 
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Browse 

This is a list of Clients discovered by running a browse action in the 
current session. Connecting to a Client from this folder causes its 
details to be stored for later use in the All Computers folder. 
 
Active 
Any Client that is currently connected will be displayed in this folder. 

 
Help Requests 

NetSupport Manager includes a function at the Client that enables the 
Client user to send a request for help. If a Control is connected when 
a Client sends a help request, the Control will be immediately 
notified, as the Help Requests folder is highlighted. If the Control is 
not connected, its Help Requests folder will be highlighted the next 

time it connects to that Client.  
 
vPro Management 
NetSupport Manager can locate PCs that have vPro capability and 
perform a variety of functions. All PCs with vPro capability will be 

displayed in the List view. Select a vPro machine to access the 
available functions in the Home tab of the ribbon. 

 
Search 
You can search for Clients and objects in the Tree view and the 
results will be displayed here. This folder will only be displayed if you 
have performed a search. 
 

Remote Networks 
This refers to Clients that have to be connected over a dial-up link. 

They may be Clients on a LAN in another building or even standalone 
workstations. In either event, they are referred to as remote 
networks and the information concerning the telephone number to 
dial and the type of connection is stored in this folder. 
 

This folder is hidden by default. To view this, click the Change the 

settings for the current Configuration icon  on the caption bar. 
Select Control Interface - Settings and clear the Hide Dial 

Directory checkbox. 
 

Internet Gateways 
The primary role of a NetSupport Manager Gateway is to facilitate 
seamless remote control between PCs that may be located behind 
different firewalls. The Gateway provides a stable and secure method 

for locating Clients via HTTP and delivers web-based remote control 
without the need for modifications to existing firewall configurations. 
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A list of your Gateways will appear here, and you can add, edit and 

browse a Gateway. 
 
Automation 
Scripts created using the NetSupport Manager Script Editor can be 
added to this folder. The List view shows the names of each script 
and enables you to add new scripts to the list. Select a script to 

access the available functions in the Home tab of the ribbon. 
 

Note: You can hide folders that you don't need to see in the Tree 
view. Click the Change the settings for the current 

Configuration icon  on the caption bar. Choose Control 
Interface - Settings and select the options you wish to hide. 
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List view 

The List view displays the objects stored in the corresponding folder 
in the Tree view. For example, if you select the Active folder, then 
the List view will contain the details of the currently connected 

Clients. Similarly, if you perform a browse action, the results of that 
browse will be displayed. 
 
You can expand the List view by hiding the Tree view, giving you 
more space to work in. Select the View tab in the ribbon and click the 

Show Tree icon. Click this again to show the Tree view. 

 
You can easily select which objects to work with and how they are 
displayed in the List view by selecting the View tab in the ribbon and 
clicking the appropriate icon in the List section or clicking the 
appropriate icon on the status bar. 
 
When viewing in large icons, the operating system, Wi-Fi and battery 

indicators and location flag (if enabled) will be displayed. Details view 
will also display the Wi-Fi and battery indicators next to the Client 

icon. Further information is available in Details view by customising 
the columns displayed. 
 
By default, the Client location flags are enabled. To disable these, 
click the Change the settings for the current Configuration icon 

 on the caption bar. Select Control Interface - Settings and 
clear the Show Client location checkbox. 

 

Note: By default, double-clicking a Client in the List view opens a 

View window. You can customise the action taken in the 
Control configuration - Control Interface Settings. 

 
To customise the List view 
1. Select the View tab in the ribbon and click Columns. 

Or 
Right-click in a blank area of the List view and select Columns. 

2. The Client List Columns dialog will appear. 
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The tabs shown at the top of the List view relate to each of the Client 

List windows that are available for the Control. 

Select the desired tab: the left-hand window highlights columns that 
are available for inclusion; the right-hand window shows those 
already included. Simply select the column name you require and 
then Add or Remove. 
 

The arrows to the far right of the window are used to adjust the order 
in which each column is displayed; the higher up the list represents 
the position from the left of the List view. 
 

Note: When viewing in details view, you can apply filters to the 

column headings, allowing you to easily search for specific 
Clients. Select the View tab in the ribbon and click the Filter 
Bar icon. 
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Status bar 

The status bar is displayed at the bottom of the Control window. It 
shows the number of items in the folder selected in the Tree view 
along with the number of connected Clients. You can see a list of the 

connected Clients by clicking Connected (you can also disconnect a 
Client from here). By default, the Client name, wireless and battery 
indicators (if applicable) and security status (shows if TLS or 
encryption are enabled or not) are displayed. You can customise what 
is displayed and choose to show the Client's logged-on user name, IP 

address, operating system, enclosure type and location by right-

clicking Connected.  
 

Note: Changing the Client display options here will also change them 
on the quick access bar, caption bar and when zooming into 

thumbnails. 

 
Note: If a Client disconnects, the Connected icon will turn red to 
notify you. You can see which Client has disconnected by opening the 

list and you can choose to reconnect or remove them from the list. 

 

To disconnect all connected Clients, click . 
 
You can easily select which objects to work with in the List view by 
clicking the appropriate icon:  
 

 Selects all objects. 

 Selects all connected Clients. 

 Reverses the current selection. 

 Clear the objects selected. 

  
The appearance of displayed items in the List view can be switched 
between large icons, small icons, list, details and thumbnail view by 
clicking the appropriate icon: 
 

 Details view. 

 List view. 

 Small icons view. 

 Large icons view. 

 Thumbnail view. 

 
If you are in thumbnail view, use the slider to adjust the thumbnail 

size. Click  to adjust the thumbnail update frequency. By default, 



NetSupport Manager v14.00 

 

 72 

when you mouse over a thumbnail, you zoom into the Client's screen. 

Click  to turn this on or off. 
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Finding Clients  

Before you can open a View window for remote control or to work 
with Clients, you must first connect to them. 

 
Rather than having to know all the Client names and their network 
addresses in advance, NetSupport Manager provides a browse facility 
that enables you to auto-discover them. 
 
When you run a browse action, the Control sends a message on all 

protocols for which it has been configured, asking all Clients to “sign 
in” with their name, network address and protocol. 
 
The responses are added to the Browse folder in the Tree view and 
their details are displayed in the List view. You can then connect and 
work with these Clients directly or organise them into groups for later 
use. 

 
Once you have connected to a Client discovered by the browse 
function, its details are automatically stored in the All Computers 

folder in the Tree view. These Clients then become known Clients and 
you can subsequently connect to them without the need to run a 
browse action first. 
 

Note: You may be using NetSupport’s Gateway facility to establish 
Client connections, in which case you can choose to include 
Gateway Clients when browsing. Although these will appear in 

the Browse folder along with any network Clients, they are 
not stored in the Known Client list.  

 

To find a Client on a network 
1. Go to the Home tab on the ribbon. 
2. In the Prefix field, enter the Client name (a partial name can be 

entered or leave blank to browse for all Clients). 

Note: Select the drop-down arrow to choose from a list of 
previous entries. 

3. Optional criteria can be specified, such as only browsing for 
Clients who have requested help or including Gateway Clients in 
the search. 

4. Click Browse. 
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Or 

 
1. Select the Browse folder in the Tree view and double-click Look 

for Clients in the List view. 
2. The Browse dialog will appear.  

 

Enter a partial Client name or leave blank for all Clients 

Type in the first part of a Client name here to narrow the search. 

If you have many Clients on your network, you may only be 

interested in those that begin with a certain word or letter. If you 
have Clients that begin with ADMIN, typing this in would return 
Clients such as ADMIN1, ADMIN_OFFICE and ADMINISTRATOR. To 
find all available Clients leave this field empty. 
 
Only Clients Requesting Help 
Select this checkbox to browse only for Clients that have 

requested help.  
 

Include Gateway Clients 
Select this checkbox to include Gateway Clients when browsing. 
 
Click OK to begin the browse. A dialog will advise you that the 
Control is browsing for Clients.  
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Click Cancel to abort your browse for Clients. This will take a few 

seconds, after which a list of available Clients on the network meeting 
the criteria will be displayed in the Browse folder. You can then 
right-click on individual Clients to connect to them, display their 
properties or carry out tasks. 
 
If the expected Clients are not found, it may be because NetSupport 

Manager has not been configured to browse the required networks. 
See  ‘Configuring the NetSupport Manager Control for subnet 

browsing’ for more information. 
 
If you only want to browse for Gateway Clients, selecting the 
Gateway from the Internet Gateways folder in the Tree view will 
change the Browse section in the ribbon to only search for Gateway 

Clients. Alternatively, double-click Browse Gateway in the List view. 
Clients browsed for in this way will not appear in the Browse folder. 
 

Note: You can also search for existing Clients in the Tree view by 
entering the search criteria in the Search section of the View 

tab. 
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Connecting to Clients 

Before you can remote control a Client, you must first connect to it.  
 

To connect to Clients 
1. Select the Client you want to connect to in the All Computers or 

Browse folder.  
2. Select the Home tab in the ribbon and click Connect. 

Or 
Right-click on the Client icon and choose Connect. 

Or 
Double-click on the Client icon to connect and view it 
immediately. 
 
If the Client has been configured with security passwords, you 
will be prompted to enter a user ID and the correct password. 
This must be equal to the user ID and password that has been set 

in the Client’s profile.  

 

Note: NetSupport Manager provides a PIN Connect feature which 
allows you to quickly locate and connect to a Client anywhere 

across the enterprise without knowing the Client's computer 
name or IP address. A PIN Server generates a unique PIN 
code which both the Control and Client enter to establish a 
connection. 
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Connecting to Clients using PIN Connect 

NetSupport Manager provides a quick and easy way to connect to 
Clients without having to know the PC name or IP address. A PIN 
Server generates a unique PIN code; this is then entered at both the 

Client and Control and the connection is created. 
 

Note: A PIN Server must be installed and configured at both the 
Client and Control to use this feature. 

 

Installing and configuring a PIN Server 

The PIN Server can be installed as a standalone component on a 
machine or along with other NetSupport Manager components. 
 
To install the PIN Server component, you must select Custom when 
choosing the type of NetSupport Manager installation to perform.  
 
Client configuration 

1. From the basic or advanced Client Configurator, select 
Connectivity - PIN Server. 

2. Enter the IP address and port (default 443) for the PIN Server 
machine. 

3. If you are using a proxy server to connect to the PIN Server, 
enter the server address and an appropriate port. 

Note: This only applies to Windows 8 machines and earlier. 

Windows 8.1 and above machines use automatic proxy 
configured in Windows Settings. 

4. To use the same settings as the NetSupport Gateway, click Copy. 
5. Click OK. 

 
Control configuration 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar. 
Or 
To apply the setting to a specific profile, click the Profiles icon 

 on the caption bar. Select the required profile and choose 
Connectivity and Startup Settings. 
Or 

Select the Home tab in the ribbon, click PIN Connect and then 

click PIN Server Settings (you can skip step 2). 
2. Select Connectivity – PIN Server. 
3. Enter the IP address and port (default 443) for the PIN Server 

machine. 



NetSupport Manager v14.00 

 

 78 

4. If you are using a proxy server to connect to the PIN Server, 

enter the server address and an appropriate port. 
5. You can use the same settings as a NetSupport Gateway. Select 

the required Gateway and click Copy. 
6. Click OK. 
 
Generating a PIN from the Control 

1. Select the Home tab in the ribbon and click PIN Connect. 
2. Click Create PIN. 

3. The PIN Server will generate a unique code. When advised, the 
Client enters the PIN and a connection is established. 

 

Note: The PIN code can be emailed to the Client or copied to the 
clipboard by clicking the appropriate icon. 

 
Entering a PIN at the Control 
1. The Client will advise you of the PIN code. 
2. Select the Home tab in the ribbon and click PIN Connect. 
3. Click Enter a PIN. 

4. A keypad will appear. Enter the PIN code and click Connect. 
 

Generating a PIN from the Client 
1. Double-click the NetSupport Manager Client icon in the system 

tray. 
2. The Client Information window will appear. 
3. Click Create PIN. 
4. The PIN Server will generate a unique code. When advised, the 

Control enters the PIN and a connection is established. 
 

Note: The PIN code can be emailed to the Control or copied to 
the clipboard by clicking the appropriate icon. 

 
Entering a PIN at the Client 
1. The Control advises the Client of the PIN code. 

2. Double-click the NetSupport Manager Client icon in the system 
tray. 

3. The Client Information window will appear. 
4. Click Enter a PIN. 
5. A keypad will appear. Enter the PIN code and click Connect. 
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Quick Connect 

Quick Connect allows you to directly connect to a Known Client by 
Client name, logged-in user name, or by network address. This saves 
you from having to perform a network browse before selecting the 

desired Client from the List view. 
 
Clients configured for HTTP/HTTPS connections through a NetSupport 
Gateway can also be selected. 
 

To connect to Clients 

1. Select the Home tab in the ribbon. 
2. In the Quick Connect section, enter the Client machine name, 

logged-on user name or network address in the Text field (click 
the drop-down arrow to choose from a list of previous entries) 
and select the required Connect By icon: 

 Connect by logged-on user name. 
 

 Connect by machine name. 

 Connect by IP address. 

 

Note: If the Client is configured for HTTP connections through a 
Gateway, in addition to the name or user name of the 

Client, you will need to choose the appropriate Gateway 
name from the list provided. 

3. Click Quick Connect. 
4. A dialog box will inform you that NetSupport Manager is trying to 

connect to the named Client.  
 

If the connection attempt is successful, the Active folder will be 
opened and the Client details displayed in the Client status. You can 
then view the Client or conduct other one-to-one or group tasks. 
 

Note: If connecting by user name and more than one Client machine 
matches this criteria, a list of Clients will appear for you to 
select from. 
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Connecting to Clients on different protocols 

NetSupport Manager supports connecting to Clients on multiple 
transports. The supported transports are TCP/IP and HTTP with 
legacy support for IPX and NetBIOS (within NetBIOS, there are 8 

logical adapters). 
 
Transports can be configured and tested for Clients within the 
Connectivity section of the basic or advanced Client Configurator. 

When the Control performs a browse, it looks over all configured 
transports. Once Clients have been found, you can connect to them 

by highlighting them and clicking Connect on the Home tab in the 
ribbon. 

Connected Clients on different transports happily coexist within the 
Control. Operations such as File Distribution, Show and Scan work 
over different transports. 
 
If you know that you only have Clients on one particular transport, 

then the Control will initialise slightly quicker if you only configure it 
for this transport. 
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Configuring the NetSupport Manager Control for 

subnet browsing 

Most corporate networks are made up of a number of small networks 
that are connected together in order to provide end users with access 
to network resources. NetSupport Manager incorporates features that 
allow a NetSupport Manager installation on one network to be used to 
remotely manage computers on another interconnected network. 
 

Using NetSupport Manager in its default configuration will enable you 

to remotely manage computers on a remote LAN if connectivity to 
that remote LAN is provided by a WAN. 
 
However, there are some configuration changes that are required to 
allow a NetSupport Manager Control to browse for Clients on remote 
LAN’s. The configuration changes required are dependent on the 

network transport that you will be using with NetSupport Manager. 
The two most common transports that are used over WAN’s are 
TCP/IP and IPX.  
 

Configuring the NetSupport Manager Control for IP subnet 
browsing 
Before configuring NetSupport Manager to browse on a remote IP 

subnet, it is useful to understand how IP addresses are made up and, 
in particular, what an IP broadcast address is.  
 
For further information, see ‘Understanding IP Addresses’ in the 
Technical Reference section of this manual. 
 

To configure the NetSupport Manager Control to browse IP 

subnets 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar. 
Or 

To edit a named configuration file, click the Profiles icon  on 
the caption bar. Select the required configuration and click 
Connectivity and Startup Settings. 

2. Select Connectivity - TCP/IP. In the Browsing section, click 
Settings. 

3. The Configure TCP/IP Client Browsing dialog will appear. 
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4. Click Add and enter the broadcast address of the network you 

wish to browse if known. 

 

To enable NetSupport Manager to calculate the broadcast 
address, click Advanced and enter a target IP address followed 
by the subnet mask or enter the required address range. 

 

5. Click OK. 

 

Notes: 
• When adding the address of a remote subnet, you must ensure that 

the broadcast address for the local subnet is also present. If not, 

the Control will not find any local Clients when you perform a 
browse. 

• Some network routers will suppress broadcast packets from being 
transmitted across WAN links. If this is the case, then even if the 
Control is correctly configured, you will not be able to browse the 
remote subnet. 
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Configuring the NetSupport Manager Control to browse 

remote IPX networks 
Before configuring a NetSupport Manager Control to browse a remote 
IPX network, it is useful to understand how IPX addresses are 
formatted. You will need to have the IPX network numbers for each 
IPX network that you wish NetSupport Manager to browse. This 
includes the IPX network number for the local network on which the 

NetSupport Manager Control is installed.  
 

For further information, see ‘Understanding IPX Addresses’ in the 
Technical Reference section of this manual. 
 
To configure the NetSupport Manager Control to browse 
remote IPX networks 

1. Click the Profiles icon   on the caption bar. 
2. Select the required configuration and click Connectivity and 

Startup Settings.  
3. Select Connectivity - IPX. 
4. Check the Use IPX and Record Clients’ Network Numbers 

options. 
5. In the Use Networks field, enter each of the IPX network 

numbers that you wish NetSupport Manager to browse. If 

multiple network numbers are required, separate each with a 
comma. 
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NetSupport Connectivity Server  

The key to a successful remote support solution is the ability to locate 
and connect to devices no matter where they are.  NetSupport 

Manager provides a range of connectivity methods as standard. 
 
The NetSupport Connectivity Server (Gateway) is a central hub for 
managing all your NetSupport connections across the internet.  From 
the console, you can see what NetSupport Connectivity components 
are installed and in use.   

 

NetSupport Connectivity Server Console 

To open the NetSupport Connectivity Server, right-click the 

NetSupport Connectivity Server icon in the system tray and 
select Open or double-click the icon.  
 

An overview of how many Clients are currently connected is 
displayed.   

 

Further information can be found in each of the tabs:   
 
• Features 

Shows you what components of the NetSupport Connectivity 

Server are installed. 
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• Clients 

Displays a list of all the NetSupport Clients currently connected to 
this NetSupport Connectivity Server and any Connectivity Servers 
known to this one. Details for the Clients are displayed along with 
the NetSupport Connectivity Server they are connected to.  
 

Note: A secure indicator  will appear next to the Client if it's 
running over a secure SSL/TLS connection. 

 

• Active Sessions 
Displays a list of current connections between a NetSupport 
Control and a NetSupport Client with the date and time that the 

connection started. 
 

Note: Only sessions on this NetSupport Connectivity Server are 
displayed. 

 
• Services (only applicable to the Name Server) 

Displays a list of NetSupport School Tutors that are active in 

Room mode. This allows NetSupport School Clients to connect to 
the room through the Name Server. 
 

• Servers 
Displays a list of Servers known to this NetSupport Connectivity 
Server. From here, you can see details of the servers, such as the 

status, number of Clients connected and any active sessions. 
 

Note: You can filter the contents of the Clients, Active Sessions and 
Services tabs so that only items meeting certain criteria are 

displayed. Enter the search term in the Filter field under the 
required column heading and the matching items will be 

displayed. Click  to clear the filter. 

 

Exporting data 
Data can be exported to a .CSV file, allowing further analysis. Select 
the tab you want to export data from and select {File}{Export} from 
the drop-down menu bar. 
 

To configure the settings for the NetSupport Connectivity Server, 

select {File}{Configure Connectivity Server} from the drop-down 
menu bar. 
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Connecting to Clients/Controls via a NetSupport 

Gateway  

The primary role of a NetSupport Gateway (NetSupport Connectivity 
Server) is to facilitate seamless remote control between PCs that may 
both be located behind different Firewalls. The Gateway provides a 
stable and secure method for locating and connecting Clients/Controls 
via HTTP, delivering web-based remote control without the need for 
modifications to existing Firewall configurations. 

 

Typically, companies protect their internal network by using a 
Firewall, only allowing connections if specific TCP/IP ports have been 
opened. On occasions, you may find that a direct connection between 
a NetSupport Manager Control and Client is blocked because the 
Firewall’s they are protected by are configured to prevent outgoing 
connections on all but the standard TCP/IP ports.  

 
A NetSupport Gateway solves this problem by acting as a third party 
that sits between the Control and Client, the HTTP/HTTPS protocol, 
rather than TCP/IP, being used for communications. 

 

Notes: 
• Client and Control configurations can have both TCP/IP and 

HTTP/HTTPS enabled simultaneously, thus ensuring that local 
connections are still valid. 

• In version 9.10, port 443 was introduced as the default for HTTP 

communications, 3085 being used previously. Gateway settings 
will be preserved for existing customers who subsequently 
upgrade, enabling 3085 to continue to be used, but there may be 

scenarios when upgraded Controls and Clients will need the HTTP 
port manually reconfiguring to ensure operability. 
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Gateway installation 

The Gateway is designed to run on a machine that is accessible from 
both the Client and Control. It must, therefore, have a fixed or static 
IP address.  
 
The Gateway can be installed as a standalone component on the 
machine you wish to use or along with other NetSupport Manager 

components. 
 

To install the Gateway component, you must select Customwhen 
choosing the type of NetSupport Manager installation to perform and 
ensure the Gateway component is selected. 
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Gateway configuration 

At the end of the installation, the NetSupport Connectivity Server 
Configuration utility will be displayed, allowing you to configure the 
properties for the Gateway. The following tabs are available: 
 
• General tab 

 

Listening Port and Interfaces 
Listen on all IP interfaces 
The NetSupport Connectivity Server uses HTTP port 443 by 
default. This can be changed to any open port to fit the 
environment. 
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Notes:  
• Multiple ports can be configured. Separate ports with a 

comma, for example, '443,3085C'. 
• Adding a capital 'C' to the end of the port number makes it 

'Client only'. Only Client machines can report using this port. 
• If the Control and/or Client are located behind a firewall, you 

will need to enable port 443, or the configured port(s), within 
the configuration of your firewall. 

• In version 9.10, port 443 was introduced as the default for 

HTTP communications, 3085 being used previously. 
NetSupport Connectivity Server settings will be preserved for 

existing customers who subsequently upgrade, enabling 3085 
to continue to be used, but there may be scenarios when 
upgraded Controls and Clients will need the HTTP port 
manually reconfiguring to ensure operability. 

 
Listen on specified IP interfaces 
You can add multiple IP addresses or enter a specific IP address, 
select Add and enter the IP address. 

 
Comms. Management Packet Interval 

CMPI (secs): 
When configured for NetSupport Connectivity Server connections, 
the Client workstation confirms its availability by periodically 
polling the NetSupport Connectivity Server. By default, a network 
packet is sent every 60 seconds, but you can change this if 
required. 

 
Event Log Files 

Gateway activity during an active session is recorded in a text 
file, default GW001.LOG. This can be useful for checking which 
Clients and Controls have connected through the NetSupport 
Connectivity Server. 
 

Location: 
By default, the log file is stored in c:\program files\common 
files\nsl\ connectivity server\GW001.log. Select Browse to 
specify an alternative path. 
 

Max File Size (KB): 
Over a period of time, the log file could become quite large, you 

can manage this by specifying a maximum file size. When the 
limit is reached, the existing information in the file is overwritten 
by the new records.  
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Note:  For changes to the log file settings to take effect, you will 
need to restart the Gateway32 service. 

 

Automatic recovery after service stops abnormally 
By default, the Gateway service will automatically recover if there 
is an abnormal shutdown. 
 

• Keys tab 

 
 

Connectivity Server Keys 
This acts as a form of security key. The NetSupport Connectivity 

Server will not accept connections from a Control or Client unless 

a “Connectivity Server key” is specified, and that same key is also 
present at both the Control and Client end. The NetSupport 
Connectivity Server can support multiple keys. At least one key 
must be specified.  
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Connectivity Server key data is sent encrypted between 

Client/Control and the NetSupport Connectivity Server. Once 
connected to the NetSupport Connectivity Server, all 
Client/Control security such as user names and security keys will 
function normally. 
 
Select Add to specify the key. The key must be at least 8 

characters. 
 

• Operators tab 

 

To enhance security, you can restrict remote control access to 

specified operators and also set the operator to verify themselves 
using two-factor authentication before they can connect to Clients 
on the Gateway. 
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Restrict remote control access to the following users: 

Select this option to restrict access to specified operators. At the 
Control, a user will be required to configure a 
username/password in order to browse a NetSupport Connectivity 
Server and connect to Clients. 
 
To enter the operator details and set a password, click Add. If 

two-factor authentication is required for this operator, select 
Require 2FA. If you're using Duo Push, you can link this 

operator to an existing enrolled Duo username.  
 

Notes:  
• For two-factor authentication to function, operators must only 

be associated with one user. 
• Click Reset Account/QR code to reset the account and send 

a new QR code to the operator. 

 
• Servers tab 
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By default, this Connectivity Server will be set to be a standalone 

Primary Connectivity Server. You can set this Connectivity Server 
as a standalone Secondary Connectivity which will act as a 
backup if the Primary Connectivity Server is unavailable. Load 
Balancing Connectivity Servers can also be set up to spread the 
load of Clients across multiple servers. 
 

Operate as a standalone Primary connectivity server 
Select this option if you want this Connectivity Server to operate 

as a standalone primary Connectivity Server (this option will be 
enabled by default). 
 

Note: If Operate as part of a load balanced cluster is 
selected, this option will change to Operate as the 
primary connectivity server. 

 
Operate as a standalone Secondary connectivity server 
(backup) 
Select this option if you wish to use this Connectivity Server as a 

Secondary NetSupport Connectivity Server. 
 

Note: It is recommended that your Secondary Connectivity 
Server is also configured to be a Load Balancing 
Connectivity Server so that configuration changes made at 

the Primary Connectivity server are automatically 
propagated to the Secondary and the Client load is 
shared. If you do not wish your Clients to load balance 
between the Primary and Secondary, set the weight of the 
Secondary Connectivity Server to 0. If this 

recommendation is not followed, any changes in 
configuration will have to be made separately to the 

Primary and Secondary Connectivity Servers. 

 
Enter the fully qualified domain name (FQDN) and port (443 is 

used by default) of the Primary Connectivity Server. 
 

Note: This changes to Operate as a cluster member server if 
Operate as part of a load balanced cluster is selected. 

 

Operate as part of a load balanced cluster 
Select this option if you are using load balancing.  
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If this Connectivity Server is going to be the Cluster Primary 

Connectivity Server, select Operate as the primary 
connectivity server. Set the weight of Clients this will take. By 
default, this is set to 1000 and is based on the network 
connection speed of the Connectivity Server machine.  
 
If this Connectivity Server is to be a Load Balancing Server, select 

Operate as a cluster member server and enter the fully 
qualified domain name (FQDN) and port of the Primary 

Connectivity Server. 
 
Load Balancing Servers 
This only appears if the Connectivity Server is a Cluster Primary 
Connectivity Server, and is where you add, edit or disable the 

Load Balancing Connectivity Servers. 
 
Click Add. Enter the fully qualified domain name (FQDN), port 
and weight for the server and click OK. If you want the Load 
Balancing Connectivity Server to also act as a backup for the 

Cluster Primary Connectivity Server, click Operate as 
Secondary Server for cluster. 

 

Notes:  
• There is a limit of 20 Load Balancing Connectivity Servers. 

• Any changes made here require the Gateway service to be 
manually restarted. 
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• Licenses tab 

 
Displays all licences stored in the NetSupport Manager directory. 
If you do not have an internet connection, you can manually 
activate your NetSupport Manager licence here. 

  
An activation code is required. Contact NetSupport or your 
reseller for this. Click Activate and enter the code. You will then 

need to restart the NetSupport Connectivity Server.  
  

Note: If an internet connection is available, the licence will 
activate automatically and the NetSupport Connectivity 

Server does not need to be restarted. 
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• Security tab 

The NetSupport Connectivity Server provides support for an 
enhanced level of encryption to be used when initiating 
communications from remote computers. 

 

Enable encryption of communications to remote computers 
When enabled all communications in the connection process are 

encrypted.  
  

Note: The remote computers (Controls and Clients) need to be 
running version 11.00.005 or later. 

 
Block any remote computers not using encrypted 
communications 

Earlier versions of the Control and Client programs do not support 
the enhanced level of encryption. Selecting this option will block 
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connections from remote computers running versions of the 

Control or Client software that does not support this.  
 
Certificate for SSL/TLS 
SSL or TLS certificates can be used to ensure that all data being 
sent across the Gateway is encrypted. If you already have an 
SSL/TLS certificate, you can enter it here or allow the Gateway to 

create and use a Let's Encrypt certificate. 
 

Note: You can configure a Client to only connect to a Gateway if 
it has a valid SSL/TLS certificate. Select the Require 

HTTPS option in the Client configurator. 

  
DNS name 

Enter the DNS name for the Gateway. 
 
Use Let's Encrypt Certificate 
Select this option to use a Let's Encrypt certificate. The Gateway 
will automatically create a certificate that is valid for 90 days and 

renew it every 60 days.  
 

By selecting this option, you are agreeing to the terms of service. 
Click View Terms to read the Let's Encrypt Subscriber 
Agreement. 
 

Notes: 
• The Gateway must have a public DNS name. 
• Port 80 must be open. 

 

Use other certificate 
If you already have an SSL/TLS certificate, you can add it here. 
Click Set Certificate and browse for the certificate.  
 
View Certificate 

Once a certificate has been applied, you can view it here. 
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• 2FA (two-factor authentication) tab 

 

Two-factor authentication provides an extra layer of security 
when Control users connect to Clients on a Gateway. NetSupport 
Manager supports time-based one-time password (TOTP) and 
Duo Push. 
 

Note: You can enable two-factor authentication for individual 
operators in the Operators tab. 

 

TOTP 

Issuer 
Enter an issuer name. This defaults to the licence name and is the 
account name that will be displayed in the authenticator app. 
Duo 
API hostname 
Enter the API hostname. 
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Auth API 

Integration key 
Enter the integration key. 
 
Secret key 
Enter the secret key. 
 

Admin API 
Integration key 

Enter the integration key. 
 
Secret key 
Enter the secret key. 
 

Notes:  
• This information can be copied from the Duo Admin Panel 

Dashboard. 
• An 'owner' level Duo administrator's account is required to 

obtain the Admin API information. 

• The Gateway must use port 443 for Duo Push. 

 
Username suffix 

You can enter an operator user name suffix (this ensures the 
username is unique to the Gateway). 

 
Timeout 
This is the time that the validation lasts before you need to re-
authenticate (unless the Control is restarted). By default, this is 

set to 12 hours. If required, enter a different time here. 
 

Notes:  
• The primary Gateway and all devices running authenticating 

apps must be synchronised with UTC regardless of the time 
zone. 

• If the timeout is set to 0, then two-factor authentication is 
required for every connection to a Gateway device. 

 

To display the NetSupport Connectivity Server icon  in the 
system tray, choose {Start}{Programs} {NetSupport 

Manager}{NetSupport Manager Connectivity Server Console}. 
Double-clicking this icon will display the NetSupport Connectivity 
Server Console, allowing you to manage your NetSupport connections 
across the internet. You can also access the NetSupport Connectivity 
Server Configuration utility by right-clicking the NetSupport 
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Connectivity Server icon and selecting Configure Connectivity 

Server. 
 

Note: You will need to note the IP address of the NetSupport 
Connectivity Server machine as this will be required when 
configuring the Control and Client machines. In addition, you 
will also need the address of your proxy server if this is to be 
used for routing communications. 

 

Client configuration 
The Client machine needs to be configured to use the HTTP/HTTPS 
protocol and be given the appropriate Gateway access details. 

 

1. From the Basic or Advanced Client Configurator, select 
Connectivity - HTTP. 

2. Check Use HTTP/HTTPS. Port 443 will be configured by default. 

3. To require a secure connection over HTTPS, select Require 

HTTPS.  

Note: An SSL/TLS certificate needs to be applied to the Gateway. 

4. Confirm which Gateway to use by entering the IP address (or fully 

qualified domain name (FQDN) if you have selected Require 

HTTPS) of the Gateway machine. You can enter details for the 
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secondary Gateway, which will take over if the primary Gateway 

is unavailable. 
5. Enter the appropriate Gateway key set at the Gateway machine. 
6. You can override the Comms. Management Packet Interval that is 

set at the Gateway by entering a time here. 
7. NetSupport Manager can be configured to route communications 

through a proxy server if required. Enter the server address and 

an appropriate port, 8080 recommended. 
8. Click OK. 

 
Control configuration 
As with the Client, HTTP also needs to be enabled at the Control.  
 
1. To apply to the current profile, click the Change the settings 

for the current Configuration icon  on the caption bar and 
choose Connectivity - HTTP. 
Or 

To apply the setting to a specific profile, click the Profiles icon 

 on the caption bar. Select the required profile, click 

Connectivity and Startup Settings and select Connectivity - 
HTTP. 

2. Check the Use HTTP box. Port 443 is configured by default. 
3. Click OK. 
 
Add Gateways 
The Control can communicate with multiple Gateways and the details 
of each need to be added at the Control end. 
 

1. From the Control window Tree view, select the Internet 
Gateways folder and choose Add a Gateway. 
Or 

Select the Home tab in the ribbon, click New and select 
Gateway. 

2. The Add a Gateway wizard will appear. 
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3. Enter a name and description for the Gateway. Click Next. 
4. Enter the IP address (or fully qualified domain name (FQDN) if 

requiring HTTPS/TLS) of the machine where the Gateway is 
installed and confirm the port number to use – 443 will be 
specified by default. If required, enter a secondary Gateway to be 
used if the primary Gateway is unavailable.  

5. To require a secure connection over HTTPS, select Require 
HTTPS/TLS (an SSL/TLS certificate needs to be applied to the 
Gateway). If this Gateway is to communicate through a proxy 
server (Windows 8.0 and earlier), enter the IP address and port 
to use. 

6. Click Next. 

7. Enter the Gateway key. This must match the key set at the 
Gateway and Client end.  

8. If an operator username and password has been set up at the 
Gateway (this restricts the use of browsing and controlling 
remote Clients and decides if two-factor authentication is required 
for the operator), you will need to enter it here. Click Finish. 

9. The new Gateway will be added to the list view. 

10. Repeat the above process for any other Gateways that the 
Control needs to use. 
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Control – Gateway - Client communications 

Now that all the elements are in place, you are ready to attempt 
connections through the Gateway. The Gateway serves three basic 
purposes: 
 
To receive and store Client registrations 
For a Client to be available to a Control, it must connect and stay 

connected to the Gateway. The Client indicates its readiness by 
periodically polling the Gateway that it has been configured to use. 

The Gateway stores the Client details in an internal table. 
 
Respond to browse commands from the Control 
Once the Control has added the required Gateways, it can browse 
them for Clients. The Gateway responds by scanning through its list 

of available Clients and returning those that match the browse 
criteria.  
 

Note: Unlike a standard network browse, where known Client 
details are stored for future use, Gateway Client details are 

lost when the Control closes. This is because the details are 
maintained at the Gateway end. Although the Client is 
permanently connected to the Gateway, the Control is not 
and therefore needs to browse the Gateway each time it 
wants to find Clients. 

 
1. From the Internet Gateways folder in the Control window Tree 

view, select the required Gateway and double-click Browse 

Gateway. The Browse Gateway dialog will appear. Enter a partial 
Client name or leave blank to search for all available Clients. 

Or 
Right-click on the Gateway name in the Tree view and select 
Open.  

2. The Browse Gateway dialog will appear. Enter a partial Client 
name or leave blank to search for all available Clients. Click OK. 

3. Found Clients will appear in the List view and you can now 
connect and remote control them in the usual way. 

4. If you have enabled two-factor authentication, you will need to 
scan a QR code using an authenticator app on your mobile device 
(for first-time connection) and either enter a one-time password 

code (TOTP) or use the Duo Mobile app to validate the Client 
connection (this is only required for the first Client you connect 

to). 
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Note: You can ask for a combined network and Gateway browse. 
When browsing for Clients in the Home tab of the ribbon, 
select the Include Gateways option. All found Clients will 
appear in the Browse folder in the Tree view. The Gateway 

Clients will not be added to the Internet Gateways folder. 

 
Pass all data between connected Controls and Clients 

Although data is transferred between the connected Control and 
Client via the Gateway, this will appear seamless and performance 

will not be affected. 
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Set up Load Balancing Connectivity Servers 

The NetSupport Connectivity Server (Gateway) allows you to use load 
balancing to automatically spread Client connections across multiple 
cluster member servers. When connections occur, the Primary 

Connectivity Server will either accept them or automatically allocate 
them to one of the other Load Balancing Connectivity Servers using a 
round-robin method. You can specify the capacity of each of the Load 
Balancing Connectivity Servers and also set a Secondary Connectivity 
Server which will take over in the event the Primary Connectivity 

Server goes down. 

 

Notes:  
• You can set up a maximum of 20 Load Balancing Connectivity 

Servers. 

• Load balancing is only available for version 14.00 Clients and 
above. Pre-version 14.00 Clients will still be able to connect to 
the Connectivity Server, but they will not be distributed between 
Load Balancing Connectivity Servers. 

• Load balancing can't be enabled on a Connectivity Server if it is 

also a Notification Server for NetSupport Notify or if it has any 

classes defined in ClassLink One Roster or Google Classroom (this 
applies to NetSupport School). 

• It is NOT intended that NetSupport School students are to be 
accessible using HTTP connections from anywhere other than the 
local TCP/IP network. 

 
Step 1 - Set up a cluster Primary Connectivity Server 
1. Open the NetSupport Connectivity Server Configuration Utility on 

the machine to be used as a Primary Connectivity Server. 

2. Select the Servers tab. 

3. Select Operate as the primary connectivity server. 
4. Select Operate as part of a load balanced cluster. 
5. Set the weight of Clients this server will take. 

Note: By default, this is set to 1000 and is based on the network 
connection speed of the Connectivity Server machine. We 
recommend that the Primary Connectivity Server is set to 

90% to allow for the overhead of brokering connections. 
For example, if the Primary Connectivity Server has a 1Gb 

network, set the weight to 900.  

6. Click Apply. 
 

Step 2 - Set up the Load Balancing Connectivity Servers 
1. Open the NetSupport Connectivity Server Configuration Utility on 

the machine to be used as a Load Balancing Connectivity Server. 
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2. Select the Servers tab. 

3. Select Operate as part of a load balanced cluster. 
4. Select Operate as a cluster member server. 
5. Enter the fully qualified domain name (FQDN) and port (443 is 

used by default) of the Primary Connectivity Server.  
6. Click Apply. 
 

Notes:  
• The Gateway service will manually need to be restarted. 

• The Keys, Operators, Licenses, Classes and 2FA tabs in the 
NetSupport Connectivity Server Configuration Utility are disabled 

when the Connectivity Server is being used as a Load Balancing 
Connectivity Server.  

 

Step 3 - Configure the Load Balancing Connectivity Server(s) 
at the Primary Connectivity Server 
Once you have set up your load balancing server(s), you now need to 
configure these at the Primary Connectivity Server. 
 

1. Open the NetSupport Connectivity Server Configuration Utility on 
the Primary Connectivity Server machine. 

2. Select the Servers tab. 
3. Click Add. 
4. Enter the fully qualified domain name (FQDN) of the Load 

Balancing Connectivity Server and the weight of Clients it will 
take. 

5. If this Connectivity Server is to be used as a Secondary 

Connectivity Server, click Operate as Secondary Server for 
cluster. 

6. Click OK. 
7. The Load Balancing Connectivity Server will be displayed in the 

list. An icon will indicate whether the Primary Connectivity Server 
can communicate with it. 

Note: You can disable a Load Balancing Connectivity Server by 

clearing the checkbox next to the server name. 

8. Add any further Load Balancing Connectivity Servers and when 
done, click Apply. 

 

Note: The Gateway service will manually need to be restarted. 

 
For further information on setting up and configuring Load Balancing 
Servers, click here. 

https://www.netsupportmanager.com/pdfs/Implementing_a_NetSupport_Connectivity_Server_Cluster_for_load_balancing_and_failover.pdf
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Setting up and using two-factor authentication 

Two-factor authentication provides an extra layer of security when 
Control users connect to Clients on a Gateway. The Control user 

needs to be validated before the first Client connection can be made 
on a Gateway. This validation lasts for 12 hours (this can be 
customised) or until the Control is restarted. NetSupport Manager 
supports time-based one-time password (TOTP) or Duo Push. 
 

You’ll need an authenticator app to generate the required password 

codes on your mobile device. We support the following authenticator 
apps: 
 

• Google Authenticator 
• Microsoft Authenticator 
• Duo Mobile 
 

Note: The Primary Gateway and all devices running authenticating 
apps must be synchronised with UTC regardless of the time 
zone. 

 
Setting up TOTP 
1. Right-click the NetSupport Connectivity Server  icon in the 

system tray and select Configure Connectivity Server. 

2. Go to the 2FA tab. 
3. Select TOTP. 
4. If you want to apply the settings to existing operators, click Yes. 

Note: Operators can only be associated with one user. 

5. Enter an issuer name. This defaults to the licence name and is the 

account name that will appear in the authenticator app. 
6. If you need to add a new operator, go to the Operators tab. 
7. If not already enabled, select Restrict remote control access to 

specified operators. 
8. Click Add, enter the required details and ensure Require 2FA 

(TOTP) is selected.  

9. Click OK. 
10. Click Apply. 
 

Using TOTP 

1. Select the Internet Gateways folder in the Control window Tree 
view and choose the required Gateway. 

2. Browse for the Gateway Clients. 
3. Connect to a Client. A QR code is displayed the first time you 

connect using TOTP. Scan this with an authenticator app on your 
mobile device and click OK.  
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4. A dialog is displayed asking for a one-time password code.  

5. Open your authenticator app to generate this code.  
6. Enter the code and click OK. The Gateway will validate and allow 

the connection. 
 

Notes:  
• You only need to validate the first Client connection, and once 

you have entered the password code, no further codes need to be 
entered unless the Control is restarted. By default, the password 

code is valid for 12 hours (this can be customised in the 
NetSupport Connectivity Server Configuration Utility - 2FA tab). 

• You can reset an operator's account and send a new QR code to 
them the next time they connect to a Client. In the NetSupport 
Connectivity Server Configuration Utility - Operators tab, select 
the required operator, click Edit and select Reset Account/QR 
code. 

 
Setting up Duo Push 

Note: To use Duo Push, you must have a paid Duo subscription.  

 
1. Right-click the NetSupport Connectivity Server  icon in the 

system tray and select Configure Connectivity Server. 
2. Go to the 2FA tab. 

3. Select Duo. 
4. If you want to apply the settings to existing operators, click Yes. 

Note: Operators can only be associated with one user. 

5. Enter the API hostname along with the Auth API and Admin API 

integration and secret keys. 

Notes:  
• This information can be copied from the Duo Admin Panel 

Dashboard. 
• An 'owner' level Duo administrator's account is required to 

obtain the Admin API information. 

6. If you need to add a new operator, go to the Operators tab. 
7. If not already enabled, select Restrict remote control access to 

specified operators. 
8. Click Add, enter the required details and ensure Require 2FA 

(Duo) is selected. If you want to link this operator with an 
existing enrolled Duo username, enter the username here.  

9. Click OK. 
10. Click Apply. 
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Using Duo Push 

1. Select the Internet Gateways folder in the Control window Tree 
view and choose the required Gateway. 

2. Browse for the Gateway Clients. 
3. Connect to a Client. A QR code is displayed the first time you 

connect using Duo. Scan this with the Duo Mobile app and click 
OK. 

4. A push notification is received and you need to approve this in the 
Duo Mobile app. 

5. The connection is made. 
6. The Gateway will validate and allow the connection. 
 

Notes:  
• You only need to verify the first Client connection, and once Duo 

has validated this, no further verification is needed unless the 
Control is restarted. By default, the Duo validation lasts for 12 
hours (this can be customised in the NetSupport Connectivity 

Server Configuration Utility - 2FA tab). 
• You can reset an operator's account and send a new QR code to 

them the next time they connect to a Client. In the NetSupport 
Connectivity Server Configuration Utility - Operators tab, select 
the required operator, click Edit and select Reset Account/QR 
code. 

 
For further information on enabling and configuring two-factor 
authentication via Duo, click here. 

https://www.netsupportmanager.com/pdfs/Configuring_Duo_two-factor_authentication_in_NetSupport_Manager.pdf
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Connecting through firewalls and proxy 

servers 

It is possible to have NetSupport Manager Clients/Controls running on 
the inside of a firewall/proxy server and still be available for 
connection to workstations on the outside without compromising the 
security of the network. Likewise, you are able to connect to Control 
and Client workstations running outside firewalls/proxy servers. 

 

Note: While this section provides general guidance, NetSupport’s 
Gateway feature is specifically designed to provide seamless 

remote control between PCs that may both be located behind 
different firewalls. The Gateway provides a stable and secure 
method for connecting Clients and Controls and delivers web-
based remote control without the need for modifications to 
existing Firewall configurations. The HTTP protocol on port 
443 is used for Gateway communications. You will need to 
ensure that this port is open within your firewall 

configuration. 

 
Connecting to Controls and Clients INSIDE firewalls 

For a Control on the external network of a firewall to connect to 
Clients on the firewalls internal network, you must enable some form 
of address translation. This process translates the address of a 
workstation on the internal network, which would otherwise be 
invisible, into an address that is accessible from the external network. 
You should (depending on the firewall) be able to specify which IP 
addresses can access the internal workstation and which port is open.  

 

TCP/IP ports used by NetSupport Manager 
Control to Client 
The NetSupport Manager Control uses TCP/IP port 5405 to send IP 
requests to Clients, and the NetSupport Manager Client listens on 
port 5405 for incoming requests from the Control. 

 
Client to Control 
With the introduction of the Client Connect feature in NetSupport 
Manager 5.00, it was necessary for an additional port to be created to 
ensure that the two methods of connection (Control calling Client, 

Client calling Control) could run alongside each other without conflict. 
Port 5421 is registered for this purpose. 
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Connecting to Controls and Clients INSIDE proxy servers 

This will not be possible with proxy servers, as they will not provide a 
means of address translation. A proxy server, by design, will not 
allow connections into a protected network. 
 
Connecting from within a firewall or proxy server to a Client 
on the outside requires the following: 

• Port 5405 enabled for outgoing connections on your firewall or 
proxy server.  

• A Client on the other side listening on the same port number and 
visible to the Control on the inside of the firewall/proxy server. 

 
Client calling a Control 
1. Enable port 5421 for outgoing connections on your firewall or 

proxy server. 
2. Right-click the NetSupport Manager Client icon in the system tray 

and select Call Control. 
3. Enter either the hostname or IP address of the Control you wish 

to connect to. 

4. The Control will then receive a message stating that a Client is 
attempting to make a connection. They can choose to accept or 

disconnect the attempt.  
 

Note: Port 5421 is not configurable. 

 
Control calling a Client 
1. Select the Home tab in the ribbon. 

2. In the Quick Connect section, enter the Client machine name, 
logged-on user name or network address in the Text field and 

select the required Connect By icon: 
 

 Connect by logged-on user name. 
 

 Connect by machine name. 

 Connect by IP address. 
 

  
3. Click Quick Connect. 
 

Note: NetSupport Manager will not communicate directly with a 
proxy server via SOCKS and will only work if a TCP/IP direct 
connection is available. 
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Implementing NetSupport Manager in a 

Terminal Server environment 

A NetSupport Manager Control can connect to Clients within a 
Terminal Server environment. 
 
NetSupport Manager provides a quick and easy method to install and 
use NetSupport Manager in a Terminal Server Environment. From 

version 11, the Client is no longer started as an application when 

each Terminal Server Session is started. Instead, the NetSupport 
Manager Client Service installed on the Microsoft Terminal Server will 
spawn a new Client process for each new Terminal Server Sessions 
started. 
 

Note: The Client  Terminal Server settings can be configured in the 
NetSupport Manager Client Configurator. 

 
For further information regarding Terminal Server support, please 
visit our Knowledge Base and refer to product article Setting Up 

NetSupport Manager to run in a Microsoft Terminal Server 
Environment. 

https://kb.netsupportsoftware.com/knowledge-base/setting-up-netsupport-manager-to-run-in-a-microsoft-terminal-server-environment/
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Intel vPro support 

NetSupport Manager can connect to machines that have Intel® 
vPro™ technology. NetSupport Manager can browse and locate PCs 

that have vPro capability and perform a variety of functions. 
Connection can even be made to a machine before the operating 
system has loaded. 
 
The Intel Setup and Configuration Service (SCS) provides tools to 
centrally set up and configure vPro machines. SCS is a server for vPro 

and is also called a provisioning server. 
 
There are two modes vPro machines can be configured to use: 
 
Basic mode 
Scan for vPro machines on your network using an IP address range. 
Basic mode uses Digest authentication - a user name and password is 

required to establish a connection. 
 
Advanced mode 

Retrieve vPro machines from SCS. Advanced mode uses Kerberos 
authentication - a certificate is required to establish a connection.  
 

Notes:  
• To use Kerberos authentication, the Control must have Windows 

XP (service pack 3), Windows 2003 (service pack 2) or higher.  

• You can switch between modes in the Control configuration.  

 
To find vPro machines 

1. Select the vPro Management folder in the Tree view. 
2. Click the Scan for vPro machines icon. 

3. If the Control is configured for 'small business mode', an IP range 
will need to be entered. 

4. PCs that have vPro capability will be displayed in the List view. 
5. Select a PC to access the available functions in the Home tab of 

the ribbon. 

Note: You can also right-click on a PC to access the available 

functions. 

6. If connecting via basic mode, you will be required to enter a user 

name and password. If connecting via advanced mode, you will 
need to select a certificate to connect. 
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Functions provided are: 

• Power on 
• Power off 
• Reset 
• Boot to Bios 
• Boot to media 
• Web view (manage a machine using vPro through your browser). 
 

Notes:  

• A NetSupport Manager Client is not required to perform these 
functions. 

• Power off, reset and boot to Bios or device is similar to pulling the 
power cord. There will be no attempt to close any open 
applications, so data could be lost. 
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Searching for Clients 

You can easily find Clients and objects in the Tree view using the 
search feature. The search results will be displayed in the Search 

folder of the Tree view (this folder will only appear once you have 
performed a search). 
 

1. Select the View tab in the ribbon and enter the search term in the 
Search Text field. You can search for Clients by logged-on user 
name, PC name or IP address by clicking the relevant icon: 

 

 Search by logged-on user name. 
 

 Search by PC name. 

 Connect by IP address. 
 

2. By default, you will only search for Clients. To search for all 

objects in the Tree, click . 

3. To make the search case-sensitive, click . 
4. Click Search. 

5. The results will be displayed in the Search folder in the Tree view. 
 

Note: When you have performed a search, you can remove the 
search results (and remove the Search folder from the Tree 
view) by clicking the Close Search icon on the ribbon. 
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Disconnecting a Client 
When you have finished remote controlling connected Clients, you 
must disconnect from them before closing your NetSupport Manager 
session.  
 

To disconnect a Client 
1. Select the Client you want to disconnect in the List view. 
2. Select the Home tab in the ribbon and click Disconnect. 

Or 

Right-click on the Client icon and choose Disconnect. 
Or 
Click Connected on the status bar, select the required Client in 

the list and click . 

 

Disconnecting all Clients 

Rather than disconnecting Clients individually, you can disconnect all 
connected Clients in a single action. 

 

To disconnect all Clients 
1. Select the Home tab in the ribbon and click Disconnect All. 

Or 

Click  on the status bar. 
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Client automatic login 

If a generic naming convention is used for your PCs, you can 
automatically log the Clients in to save time. 

 
To automatically login Client machines 
1. Select the Client machine(s) you wish to login. 
2. Select the Remote tab in the ribbon and click Login. 

Or 
Select the tab displaying the Client's name in the ribbon (or the 

Selection tab, if more than one Client has been selected) and click 
Login. 
Or 

Right-click and select Login . 
Or 

Select the required group from the Tree view, choose the Group 
tab in the ribbon (or right-click the group) and click Login. 

3. The Login dialog will appear. 

 

4. Enter the user name, password and domain and click Login. The 
user name will appear once the login has been successful. 

5. You can also view Client screens from this dialog, select the 

required Client and click View. 

6. When you have finished, click Close to exit. 
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Client automatic update 

A quick and easy way to update Clients to the same version as the 
Control is to use the automatic update facility. Any NetSupport 

Manager components that are installed on the Client machine will be 
updated to the current Control version. 
 

Note: Only available on Windows-based Clients. 

 

To automatically update the Client 

1. Select the Client(s) that you wish to update. 
2. Select the tab displaying the Client's name in the ribbon (or the 

Selection tab, if more than one Client has been selected) and click 
Update. 

3. The Clients will be updated to the same version as the Control. 
 

Notes: 
• The Clients must either be logged in with administrator rights or 

logged off for the updates to take place. 

• The Remote Deployment Utilities must be installed on the Control 
machine to use this function. 

• If Disable File Transfer and Disable Execute are selected in 
the Client Configurator, you will not be able to update the Client. 
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Power management – Power on/power off  

Power consumption equates largely with heat generation and 
increased energy consumption. With millions of workstations in use 

and sometimes hundreds located in the same company, the desire to 
conserve energy has grown from a minor issue to a major issue.  
 
Power management is a technique that enables hardware and 
software to reduce system power consumption. It works by shutting 
down portions of the hardware during periods of downtime, meaning 

that the workstation is ready to work when you are and conserve 
energy when you are not. 
 

Client power on 

To power on a NetSupport Manager Client, the workstation must have 

a Wake-on-LAN network adapter and a BIOS that will support it 
(consult your network adapter documentation for more information). 
The Client must also be known to the Control. The Control sends a 
Wake-on-LAN packet to the Client network adapter, which instructs 

the workstation to power on. 
 
To power on a NetSupport Manager Client 

1. Select the icon(s) of the Clients you wish to power on. 
2. Select the Remote tab in the ribbon and click Power On. 
3. Select the tab displaying the Client's name in the ribbon (or the 

Selection tab, if more than one Client has been selected) and click 
Power On. 
Or 
Right-click and choose Power On. 

4. The Client workstations will now power on. 
 
To power on a group of Clients 
1. Open the All Computers folder in the Tree view and select the 

required group. 
2. Select the Group tab in the ribbon and click Power On. 

Or 

Right-click on the group and click Power On . 
3. The Client workstations will now power on. 
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Client power off 

NetSupport Manager uses the Advanced Power Management (APM) 
features of the Windows operating system (where supported) to 
provide Client power down capabilities. APM relies on the Client 
workstation having an ATX motherboard and ATX power supply.  
 

A Control can remotely power off a Client workstation using the 
NetSupport Manager Power Management function. 
 

To power off a NetSupport Manager Client 
1. Ensure all open applications at the Client workstations are closed. 
2. Select the icon(s) of the Clients you wish to power off. 

3. Select the Remote tab in the ribbon and click Power Off. 
Or 
Select the tab displaying the Client's name in the ribbon (or the 
Selection tab, if more than one Client has been selected) and click 
Power Off. 
Or 
Right-click and choose Power Off. 

4. The Client workstations will now power off. 
 
To power off a group of Clients 
1. Ensure all open applications at the Client workstations are closed. 
2. Open the All Computers folder in the Tree view and select the 

required group. 
3. Select the Group tab in the ribbon and click Power Off. 

Or 

Right-click on the group and click Power Off . 
4. The Client workstations will now power off. 
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Rebooting or logging out Clients  

Enables a Control to remotely reboot or log off Client workstations 
either individually or by selected group.  
 
To reboot or log out a Client 

1. Select the Client in the Control window List view. 
2. Select the Remote tab in the ribbon and click Reboot or Logout. 

Or 
Select the tab in the ribbon displaying the Client's name and click 

Reboot or Logout. 
Or 

Right-click on the Client icon and select Reboot or Logout 

. 
3. Click Yes, to confirm send reboot/logout. 
4. You will be immediately disconnected from the Client. 
 
Or 
 

1. While viewing the Client, select the Home tab in the View window 

ribbon and click Reboot or Logout. 
2. Click Yes, to confirm send reboot/logout. 
3. You will be immediately disconnected from the Client. 
 
To reboot or log out a group of Clients 
1. Select the required group from the Tree view. 

2. Select the Group tab in the ribbon and click Reboot or Logout. 
Or 

Right-click the group and select Reboot  or Logout . 
3. Click Yes, to confirm send reboot/logout to the group. 
4. You will be immediately disconnected from the members of the 

group. 
 

Note: Make sure that all workstations within the group are available 
and not being used by other staff before you use this 
function. 
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Sending Ctrl+Alt+Delete 

You can send Ctrl+Alt+Delete to a workstation that you are viewing 
or simply connected to. 
 
To send Ctrl+Alt+Delete to a connected Client 

1. Press the Ctrl+Alt+Esc keys simultaneously. 
 
Or 
 

1. Select the Remote tab in the ribbon and click Send CAD. 
Or 
Select the tab in the ribbon displaying the Client's name and click 

Send CAD. 
Or 

Right-click and select Send Ctrl+Alt+Delete . 
2. Click Yes, to confirm send Ctrl+Alt+Delete. 
 
To send Ctrl+Alt+Delete to a Client you are viewing 

1. Press the Ctrl+Alt+Esc keys simultaneously. 
 
Or 

 
1. Select the Home tab on the View window ribbon and click 

Ctrl+Alt+Delete. 
2. Click Yes, to confirm send Ctrl+Alt+Delete. 
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Viewing Clients 

Having connected to a Client, you can now remotely control it. This is 
called Viewing. The Client’s screen will be displayed in a window on 

the Control workstation. NetSupport Manager will allow you to view 
multiple Client screens, each in its own window, simultaneously.  
 

Note: While viewing a Client, you can drag and drop files from the 
Control Windows Explorer directly to the Client's desktop. 

 

To view a Client 
1. Select the required Client icon. 
2. Select the Home or Remote tab in the ribbon and click View 

Client. 
Or 
Select the tab in the ribbon displaying the Client's name and click 
View Client. 

Or 
Double-click the Client icon in the List view. 

Or 
Right-click on the Client icon and choose View. 
Or 
Click the appropriate Client icon on the Quick Access bar and 
select the View Client icon. 

3. The View window for that Client will now appear at the Control. 
To aid navigation of the Client screen, a thumbnail image of the 
screen is displayed, enabling you to scroll the Client desktop 
more easily. Click and drag inside the thumbnail to view specific 
areas. The navigation panel can be enabled or disabled by 

selecting Navigation from the View window ribbon. 
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The View Window 

The View window is the primary interface for interacting with 
individual Client’s. Each Client has its own View window. The Client 
View windows are used for displaying the screens of the Clients at the 
Control. You can have multiple Client View windows open and 
displayed simultaneously. 

 

The View window is divided into the following sections: 
  
The caption bar 

The caption bar displays the name of the Client that you are currently 
viewing.  Clicking the Client name brings up a Remote Management 
pane, and from here, you can see details of the Client and perform a 

variety of functions.  
 

By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed on the caption bar. You can customise 
what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 

right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 
on the quick access bar, connected Clients list on the status 
bar and when zooming into thumbnails. 
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The following options are available: 

 

 Show or hide the ribbon. 

 Access the View settings for the current configuration. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee, 

Technical Support and compression information. 

  
The ribbon 
The ribbon provides access to all features, tools and settings available 
to use at the Client you are currently viewing. Positioning the cursor 
over an icon will display a brief description of its function. The ribbon 
is organised into three main tabs: 

 
1. Home 

Allows you to select the mode in which the Client will be remote 
controlled, customise how the View window is displayed, cut and 

paste between applications on the Client and the Control 
workstations and launch an application at the Client.  
 

2. Tools 
Provides a selection of tools available to use at the Client you are 
currently viewing. 

 
3. Audio 

Allows you to enable audio between a Control and a Client and 

configure the settings. 

 

Note: A Monitor tab will appear in the ribbon when viewing a Client 
with multiple monitors. From here, you can choose to switch 
the view between monitors or view the whole desktop. 

 

The Client screen area 

This is used for displaying the screen of the Client. 
 
Status bar 

The status bar shows the current view mode, the number of 
connected Clients, the current keyboard layout (by default, this is set 
to international keyboard; click to change this), if print capture is on 
(click to enable) and the FPS counter. 
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You can see a list of all connected Clients by clicking Connected 

(clicking a Client name opens a View window for them). Right-click to 
choose how the Client is displayed in the list. 
 

Notes:  
• For acceptable performance while viewing, ensure that the 

Client’s Active Desktop is turned off. 
• If the Control and the Client are both using touch-enabled 

devices, the Control will be able to control the Client machine 

using touch commands.  
• You can customise the action taken when double-clicking a Client 

icon in the List view (by default, this opens a View window) in the 
Control configuration - Control Interface Settings. 

 

To return to the Control window 
1. On the caption bar, click . 

 

View Modes 

You can view a Client in three modes:  
Share 
The Client’s screen will be displayed at both the Control and the 
Client. Both the Control and the user at the Client will be able to 
enter keystrokes and mouse movements. 
 

Watch 
The Client’s screen will be displayed at both the Control and the 
Client. Only the user at the Client will be able to enter keystrokes and 
mouse movements. The user at the Control will be locked out.  

 
Control 
The Client's screen will be displayed at both the Control and the 

Client. Only the user at the Control will be able to enter keystrokes 
and mouse movements. The user at the Client will be locked out. 
 

To change the view mode 
1. While viewing the Client, select Share, Watch or Control on the 

View window ribbon. 
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Viewing multiple Client screens simultaneously  

NetSupport Manager enables you to view multiple Clients 
simultaneously, each in its own window. You can even scale their 
individual View windows to fit on the Control’s screen. 

 
To view multiple Client screens 
1. View each Client you want to include. 
2. On the caption bar of the Control window or any Client View 

window, click Window Menu , select Tile and choose which 
NetSupport Manager windows you want to display. 

 
Your chosen windows will be tiled on the Control’s screen. If you want 
to see the entire Client’s screen, click the Scale to fit icon on the 

ribbon of each Client’s View window. 
 

Note: Scale to fit is on by default. 

 



NetSupport Manager v14.00 

 

 128 

Blanking the Client’s screen while viewing 

For security reasons, you may require the Client screen to be blank 
while you are remotely controlling it. 
 

Note: This feature is only available on Clients running Windows 10 
v2004 and above (legacy support is provided for Clients 
running Windows 8 and below). 

 
1. Select the Home tab in the View window ribbon and click the 

Blank screen icon. 

2. The Client’s screen will be blanked. 
3. To restore the screen, click the Blank screen icon again. 
 

Viewing a Client full screen 

Viewing a Client in Full Screen mode removes the caption bar and 
ribbon and maximises the View window. What you see is exactly what 
would be seen on the remote workstation. 
 

To view a Client in full screen mode 
1. Click the Full Screen icon in the Client's View window ribbon. 

2. The Switch to Full Screen dialog will appear. 
3. A floating toolbar will be displayed while in Full Screen mode, 

allowing access to frequently used features and tools. Click  

to expand the toolbar and access the full range of tools. Click  
to switch back to windowed mode. 

 

Note: You can also return to windowed mode by using the hotkeys 
Ctrl+Left Shift+Right Shift. 

 

Scale to Fit Mode 

Scale to fit allows you to view a remote screen within the available 
size of the View window rather than providing you with a series of 
scroll bars so that you can pan around the screen. 
 
This allows you view multiple screens simultaneously to maintain an 

overview of a number of selected workstations. 
 

Note: Using scale to fit does impact on the quality and clarity of 
the view and is designed to allow you to monitor a screen as 

opposed to work on it. Try it for yourself and decide what 
level of scaling is acceptable for your purposes. 
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To view a View window to scale 
1. Click the Scale to fit icon on the View window ribbon. 

 
Displaying the View settings for a Client 

During any control session where you may be working with more than 
one Client, you can tailor how each Client interacts with the Control. 
For example, on one Client, you may want to use compression 

because it is on a slow link, but on another, you may want to turn 
compression off. NetSupport Manager allows you to do this by 
modifying the default settings for the current Control profile. 

 
To adjust View settings while viewing 
1. Select the Client to view. 

2. Click  on the View window caption bar.  
3. The Settings dialog will appear. 
4. Configure which options will be enabled when you start a View 

session. (Refer to the Control Configuration - Remote Control 

Settings section of this manual for detailed information about the 
available options) 

 

Note: If you edit the Client settings, the changes you make only 
apply to that Client during the current Control session. If you 
want to change the settings permanently, check the Update 
Configuration box. 
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Scanning  

The Scan function enables you to cycle through each connected Client 
in turn, displaying its screen on the Control. It is an alternative to 
viewing multiple Clients in scaled windows, which may cause their 
screens to be unreadable. 

 
Multiple Client screens can also be scanned in one Scan window. 
 

Scan one Client screen at a time  
1. Select the Clients to include in the scan. 
2. Click the Remote tab in the ribbon. 

 

3. Select the One Client at a time icon . 

4. Use this slider control to specify the interval before the scan is 
advanced to the next Client. The scan period can be set anywhere 
between five seconds to two minutes. 

5. Click Start. 
6. The Scan window will appear and immediately show you the first 

Client in the sequence. It will cycle through the selected Clients, 

showing their screens on the Control until you end the scan. 
 

Note: If you want to start scanning from a particular Client, select 
their name in the Scan dialog. 
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Scanning multiple Client screens 

Multiple Client screens can be scanned simultaneously in one Scan 
window. 
 

Note: You can display up to 16 Client screens in one Scan window at 
a time. 

 
To scan multiple screens simultaneously 

1. Select the Clients to include in the scan. 
2. Click the Remote tab in the ribbon. 

  

3. Select the number of Client screens to be displayed in the Scan 

window by clicking the relevant icon: 
 

 
Clients will be arranged 2x2. 

 
Clients will be arranged 3x3. 

 
Clients will be arranged 4x4. 

4. If you are scanning more than four Clients, you can select a scan 
interval by using the slider. The scan period can be set anywhere 
between five seconds to two minutes. 

5. Click Start. 
6. The Scan window will appear. 
 

To end the scan 

1. On the caption bar, click . 
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The Scan window 

The Scan window will cycle through the selected Clients, showing 
their screens on the Control until you end the scan. If you want to 
start scanning from a particular Client, highlight their icon before you 

start the scan. 

 

The Scan window is divided into the following sections: 
 

The caption bar 
The caption bar displays the name of the Client you are currently 
scanning (this will not appear when scanning multiple Clients 
simultaneously). Clicking the Client name brings up a Remote 

Management pane, and from here, you can see details of the Client 

and perform a variety of functions.  
 

By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed on the caption bar. You can customise 

what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 

on the quick access bar, connected Clients list on the status 
bar and when zooming into thumbnails. 
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The following options are available: 

 

 Show or hide the ribbon. 

 Access the settings for the current scan session. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee and 

Technical Support information. 

  
The ribbon 
The following icons are available for a single Client scan: 
 

• Previous, Auto Advance and Next  
Allows you to turn auto timing on or off, or choose to move 

forwards or backwards between individual Clients. The Previous 
icon shows the previous Client screen scanned. The Next icon 
shows the next Client's screen in the scan cycle. 

 

• Scale to fit 
It may be that the Client is running in a higher resolution than the 
Control. Selecting this option will resize its screen to fit the window 

in which it is displayed. 
 

• Full Screen 
Allows you to scan in Full Screen mode. You can use the Scan 
Floating toolbar to control the operation. 

 

• Screenshot 

A snapshot of the current Client window can be taken. 
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The following additional icons are available for a multiple Client scan: 

 

• Maximise 

Maximises a selected Client's window. You can also click  in the top 
right-hand corner of the Client window. 

 
• Lock 

Locks a selected Client's keyboard and mouse. 
 

• Chat 
Initiates a Chat session between a Client and the Control. 

 
• Share 

To view a Client in Share mode. 
 
The Client screen area 
This is used for displaying the screen of the Client or multiple Client 
screens when performing a scan. 
  

The Status bar 

The status bar shows the scan timer, which indicates how far through 
the scan interval you are. 
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Screen Capture 

Screen capture allows you to take a snapshot of the current Client 
screen whilst viewing or scanning and save this to a file. The Client 

name, date and time will be recorded when saved. 
 

Capture a Client's screen  
1. When viewing or scanning a Client, select the Home tab in the 

ribbon. 

2. Click Screenshot . 
3. The current Client screen will be captured and automatically saved 

as a .png to NetSupport Manager\Snapshots in your local Pictures 
folder.  

Note: An indicator will appear on the Screenshot icon showing 
the number of screenshots that have been taken. 

4. Clicking the Screenshot drop-down arrow lists the last nine 
screenshots taken (you can view or delete them as required) and 

you can open the folder where the images are stored.  
 

Note: When scanning multiple Clients, a Client screen must be active 
(highlighted) for screen capture to become available. 
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Thumbnail View/Monitor Mode 

Thumbnail view or Monitor mode allows a Control to display a 
thumbnail view of all connected Client workstations simultaneously, 

providing a quick and easy method for monitoring Client activity. 
While in Monitor mode, the Control still has access to the full range of 
NetSupport Manager features such as View, Chat and File Transfer. 

 

To switch to thumbnail view 
1. Display the required Client list by selecting the appropriate folder 

in the Control window Tree view. You would generally want to 
limit the number of displayed thumbnails to connected Clients 

only.  

2. Select the View tab in the ribbon and click Thumbnail. 
Or 

Click  on the status bar. 
Or 
Right-click on a clear area of the List view and select Thumbnail. 
 

The List view will display each Client thumbnail. By mousing over a 

thumbnail, you can zoom in to that screen (this can be turned off by 

clicking  on the status bar). Double-clicking a thumbnail will open a 
view session to that Client; right-click and you can select from the full 
range of available Client features. For example, by selecting multiple 
thumbnails, you can invite those Clients into a Chat session. 
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Note: You can change the action taken when double-clicking a Client 
in the Control configuration - Control Interface Settings. 

 
Each thumbnail will show the computer name underneath and if the 
thumbnail width is 144 pixels or larger, the current logged-on user, 
operating system and IP address will also be displayed. By default, 
battery and Wi-Fi indicators (if relevant to the device type) and 

security status (shows if TLS or encryption are enabled or not) icons 
appear on the thumbnail. You can customise what icons are displayed 

on the thumbnail and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
selecting the View tab in the ribbon and choosing the required options 
from the Display Options drop-down list. 
 

You can adjust the frequency at which the thumbnails are refreshed 

by clicking  on the status bar and selecting the required time 
from the list. 
 
If a Client is running multiple monitors, icons will be displayed on the 

thumbnail, allowing you to switch between each monitor or view the 

whole desktop. Click  to access the Dual Monitor menu and select 

what to view from the list. Click  to view the whole desktop. Click 

the number icon  to view that monitor. The icon will turn green to 
show which option is selected. 
 

Note: When zooming into a Client screen, you can switch between 

single and multi-monitor by clicking . 

 

Grouping Clients in the List view 

Clients can be conveniently grouped into categories using a range of 
criteria, including the Client platform, connection type etc. 
 
Organising Clients into categories 
1. Select the View tab in the ribbon and click Group By. 
2. Select the category you wish to organise your Clients by. 

3. The Clients will now be grouped by the category in the List view. 
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Launching applications  

This feature allows you to launch (execute) an application on an 
individual Client workstation or a group of Client workstations without 

the need to remote control them. 
 

Note: The application itself must be installed on or available to the 
Client workstations. 

 

To launch an application at a Client  
1. Select the required Client in the List view. 
2. Select the Remote tab in the ribbon and click Launch 

Application. 
Or 
Right-click the Client in the List view and choose Execute at 
Client. 

3. The Execute Application at Client dialog will appear. 

 

4. Select the Execute tab. 
5. Enter the name and path of the application to execute at the 

Client. 
Or 

Click  to browse for the application on the Control workstation. 
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Note: Check that Client applications are stored in the same 
location as the Control to ensure successful execution. 

6. Select Add to List to save it for future use in the Saved List tab. 

Confirm the description and path.  

Note: The application will be added to the Launch Application 
drop-down list in the ribbon. 

7. If you only want to execute applications to Clients that are logged 

on, select the option Execute only if the Client is logged on. 

8. If you don't want to view the result of the operation, click No 
result required. 

9. Click Execute.  
10. The application will now be launched at the selected Client and 

the result of the operation is displayed in the Results pane. 
 

Or 
 
1. If you have saved a list of applications, select the required 

application from the Launch Application drop-down list . 

2. Click Client must be logged on to launch the application at 
Clients that are logged on and if you don't want to see the results 
of the operation, click No result required. 

3. The application will be launched at the Client and the Execute 
Application at Client dialog will appear, displaying any results. 

 
Quick launching applications while viewing a Client 
A list of applications can be saved in the View window, allowing you 
to quickly launch these at the Client. 

 

1. Select the Home tab in the View window ribbon. 
2. Click Add. 
3. Enter the name and path of the application.  

Or 

Click   to browse for the application.  

4. Click OK. 
5. The application will be listed in the Quick Launch pane. 

 

Note: Click Manage to edit or remove a listed application. 
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6. You can now launch the application at the Client. Select the 

application in the list and click Launch or double-click the 
application. 

7. The application will run at the Client. 
 

Note: You can also remotely launch an application that isn't listed by 
selecting Launch Application, entering the name and path of 
the application and clicking Execute. 

 

To launch an application on a group of Clients 
1. Open the All Computers folder in the Tree view. 
2. Select the required group, go to the Group tab in the ribbon and 

click Launch Application. 
Or 

Right-click on the required group and choose Execute at Client.  
3. The Execute Application at Client dialog will appear. 
4. Select the Execute tab. 
5. Enter the full path of the application you want to run. 

Or 

Click  to browse for the application on the Control workstation. 

Note: Check that Client applications are stored in the same 
location as the Control to ensure successful execution. 

6. Select Add to List to save it for future use in the Saved List tab. 
Confirm the description and path.  

Note: The application will be added to the Launch Application 

drop-down list in the ribbon. 

7. If you only want to execute applications to Clients that are logged 
on, select the option Execute only if the Client is logged on. 

8. If you don't want to view the result of the operation, click No 

result required. 
9. Click Execute.  
10. The application will now be launched at all selected Clients in the 

group and the result of the operation displayed in the Results 
pane. 

 
Or 

 
1. If you have saved a list of applications, select the required 

application from the Launch Application drop-down list . 
2. Click Client must be logged on to launch the application at 

Clients that are logged on and if you don't want to see the results 
of the operation, click No result required. 
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3. The application will be launched at the Clients in the group and 

the Execute Application at Client dialog will appear, displaying 
any results. 

 
To save the details of your executed application for future use 
1. Select the Remote tab in the ribbon and click Launch 

Application. 

2. The Execute Application at Client dialog will appear. 
3. Click Add. 

4. The Add/Edit Application Details dialog will appear. 
5. Enter the name and path of the executable application. 
6. Click OK. 
7. The application will appear in the Saved List tab. 
8. Click Close.  

 
Or 
 
1. Select the Remote tab in the ribbon and click the Launch 

Application drop-down arrow. 

2. Click Add Application. 
3. The Add/Edit Application Details dialog will appear. 

4. Enter the name and path of the executable application. 
5. Click OK. 
6. Click Close. 

The application will now be available from the Launch Application 
drop-down list in the ribbon. 
 

Note: A list of applications to launch can also be saved in the View 
window. 

 

To edit a saved executable application 
1. Select the Remote tab in the ribbon and click Launch 

Application. 
2. The Execute Application at Client dialog will appear. 
3. Select the Application to edit. 
4. Click Edit. 

5. The Add/Edit Application Details dialog will appear. 
6. Make the required changes. 

7. When finished, click OK. 
 
To remove a saved executable application 
1. Select the Remote tab in the ribbon and click Launch 

Application. 

2. The Execute Application at Client dialog will appear. 
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3. Select the application to remove. 

4. Click Remove. 
5. A confirmation dialog is displayed, click Yes. 



NetSupport Manager v.14.00 

 

 143 

User Defined Tools 

As well as allowing a Control to launch applications on Client 
workstations, you can automatically run a task on a Control 
workstation using a defined tool. These tools can also be copied to 
other Control workstations for use. 

 
To add a tool 
1. Select the Tools tab in the ribbon and click Add in the User 

Defined section. 

2. The Add Tool dialog will appear. 

 

3. Choose to add a program or script tool by selecting the 
appropriate tab. 

4. Enter the required information. 
5. Click OK. 

6. The tool will be listed. 
7. Click Edit to change the properties of a listed tool or Delete to 

remove the tool.  
8. Click Close. 
 
To run a tool 
1. Select the Tools tab in the ribbon. 
2. Select the tool you wish to run from the User Defined pane and 

click Run. 
Or 

Double-click the tool in the User Defined pane. 
3. The tool will automatically run. 
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To copy user defined tool settings to other Control machines 

1. At the Control machine you want to copy the settings from, click 

the Change the settings for current Configuration icon  on 
the caption bar. 

2. Select File Locations. 
3. In the Tools file section, click Change. 
4. Specify an alternate location or name for the tools file. 
5. Make this file available to the Control machine that is going to 

adopt this tools file. 

6. Open the Control Configurator at this Control machine and follow 

steps 2 and 3. 
7. Select the new tools file, click Open. 
8. The new tools file will be implemented. 
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Showing the Control screen to Clients  

As well as enabling you to remote control Clients, NetSupport 
Manager allows you to show your screen to:  

 
• A selected individual Client 

• A pre-defined group of Clients 

• An ad hoc selection of Clients. 
 

Replay Files can also be shown to Clients. 
 

Notes: 

• During a Show, NetSupport Manager displays in real-time all 
actions undertaken by the Control. In addition, the Control has 
the option to enable ‘hotkeys’, ensuring that any key 
combinations (e.g. CTRL+V) used by the Control during the show 
are also visible to the Clients. If using a mixture of key 
combinations (e.g. ALT+V+T), NetSupport Manager will only 
display two consecutive keystrokes at any one time. The key 

combinations will not appear if the Control taskbar is not active. 

• To improve performance when showing to a large number of 
machines, NetSupport Manager's Broadcast Show facility is 
enabled by default. This results in the screen information being 
sent to all machines simultaneously, thus improving the speed of 

transfer. Turning this feature off results in the screen information 
being sent to each Client machine in turn. Whilst reducing overall 
network traffic generated by NetSupport Manager, using this 
feature will generate additional broadcast packets on your 
network. It is recommended that you consult your network 

administrator before using this feature. The Show can be sent to 

Clients using multicast. The broadcast will only be sent to 
machines included in the specified IP multicast address. 

To show a Control screen 
1. Select the Desktop tab in the ribbon and click Show Desktop. 

Or 
If showing your screen to a group of Clients, select the required 

group in the Tree view and click Show Desktop in the Group tab 
in the ribbon or right-click the group and select Show Desktop. 

2. The Show dialog will appear. 
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In this dialog, you select the Client (or Clients) that you will show 
your screen to and set any associated properties. 
  
Ready to start showing to: 
Select the Client or Clients that you will show your screen to. You can 
exclude Clients from the show by clicking the green tick next to their 

name (a red cross will appear). 
 
Create Replay File at Client 

The Show session can be recorded and stored in a Replay File, giving 
Clients the opportunity to play back the session at a later date. 
 

Show Hotkeys 
To ensure that all actions performed by the Control are visible to the 
Clients during a Show, you can enable the use of hotkeys. Any key 
combinations that the Control uses, e.g. CTRL+V, will be displayed at 
both the Control and Client screens. 
 

Note: If using a mixture of key combinations, e.g. ALT+V+T, 

NetSupport Manager will only display two consecutive 
keystrokes at any one time. 
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Enable Audio Support 

This turns audio support on. If you are showing to only one Client, 
both the Control and Client can speak. If you are showing to many, 
only the Control can speak (announce). See Using Audio Support for 
details. 
 
Set Show Mode at Client (Windowed, Full Screen or Maximise 

window) 
This option allows you to show at the Client either in a small window, 

full screen or maximised window. When showing in windowed and 
maximised window size, the Client’s mouse and keyboard are not 
locked. 
 
Screen Scrape 

NetSupport Manager’s favoured (and the most efficient) method for 
capturing screen data is to hook into the Video Driver of the 
workstation being viewed. However, there may be occasions when 
this method will not work because certain applications bypass the 
driver. In these circumstances, you can enable ‘screen scrape’ mode 

in order to take a snapshot of the screen. Although this will have a 
greater impact on the network, it will at least provide an accurate 

representation of the Client’s screen. 
 
Send Physical Fonts 
In order to reduce the volume of data being sent when sharing 
information of this nature, NetSupport Manager passes the font 
information by reference. The target workstation will refer to its own 

internal font mappings to find an appropriate match to the one that 
has been sent. In most cases, the same fonts will be available, but if 

there are instances where this isn’t the case, you can send the full 
information. Check this box to enable. 
 
Show Monitor: 
NetSupport Manager will identify if the Control is running multiple 

monitors, giving you the option to choose which one to show from the 
drop-down list. If you are unsure which is the correct screen, click 
Identify. Alternatively, select Whole Desktop to show all. 
 
To end the Show 

1. Double click on the Show icon in the taskbar.  
2. This will display the Showing dialog.  
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The buttons have the following purposes:  

End 
Ends the Show and releases the Clients’ screens and keyboards. 
 
Resume 

Resumes the Show. 
 
Continue 

The Clients’ screens and keyboards will remain locked while you 
prepare other work at the Control. They will not be able to see what 
you are doing. Effectively, the Show is suspended. 
 
Show Application 
The application being shown to Clients is displayed. To change the 

application, drag the icon to the required application on the Control's 

desktop and release (a pink border will appear around the selected 
application as you move the mouse around the desktop). 
 

Note: This option will only appear when showing an application. 

 
Or 

 
1. Right-click on the Show icon on the taskbar. 
2. Click End Show. 
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Showing a Client screen to Clients 

With NetSupport Manager, it is possible to show the Control’s screen 
to a number of connected Clients. It is also possible to show a Client’s 
screen to a number of other connected Clients.  
 
For example, it may be that workstation_1 has an application on it 

that you need to show to the Accounts department. Therefore, by 
viewing workstation_1 and then showing to all members of the 
Accounts department, they will now be able to see workstation_1’s 

screen. 
 
To show a Client’s screen 

1. Connect to the Clients you wish to show to and the Client you 
wish to view. 

2. View the Client whose screen you wish to show. 
3. Select the Desktop tab in the ribbon and click Show. 
4. The Show dialog will appear. 
5. Select the These Clients option. 

6. Exclude the Client you are currently viewing from the Show by 

clicking the green tick next to their name (this will change to a 

red cross). If you don’t do this, you will get an error saying that the 
Control cannot show to this Client while you are viewing it. 

7. Click Show. 

 
The Client’s screen that is being viewed will be shown to the other 
Clients. You can use features such as Scale to Fit and Full Screen to 
Show more of the Client’s screen. 
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Show Application 

The Show feature enables you to display the Control screen to 
Clients. However, if a number of programs are open at the Control, 
there may be occasions when you want to show a single application 
in isolation.  
 

To show an application 
1. Select the Clients to include in the Show. 

2. Select the Desktop tab in the ribbon and click Show Application. 
Or 
If showing the application to a group of Clients, select the 
required group in the Tree view and click Show Application in 
the Group tab in the ribbon or right-click the group and select 
Show Application. 

3. The Show Application dialog will appear. 

 

4. Drag the  icon to the required application on the Control’s 
desktop and release (a pink border will appear around the 
selected application as you move the mouse around the desktop). 

Or 

Click Select and choose the application from the displayed list. 

Note: NetSupport Manager will identify if the Control is running 
multiple monitors, giving you the option to confirm which 
one the selected application is sited on. If you are unsure 

which is the correct screen, click Identify. If only one 
monitor is detected, select Whole Desktop. 

5. Click Show. 
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Audio support 

NetSupport Manager allows you to use audible communications to 

connected Clients via microphones, headphones and speakers. The 
Control can also listen to microphone output and background sounds. 
This can be used while viewing a Clients screen, showing your screen 
to a Client on their workstation or outside of a remote control session 
by selecting the required Client. NetSupport Manager will only 

operate audio if the workstations have Audio Support installed. 

 

Using audio support 
1. Select the required Client in the List view. 
2. Select the Remote tab in the ribbon and click Audio. 

Or 
Right-click the Client and select Audio. 

3. Right-click the required Client in the List view and select Audio. 
4. The Audio toolbar will be displayed. 

  

From here, you can:  
• Turn audio on or off. 

• Enable only the Control or the Client to talk. 
• Listen to the Client. 
• Click Settings to set the microphone sensitivity and select 

the audio quality. 

 
Minimising the Audio toolbar will disable the current audio session, 

this can be re-started by activating the toolbar. You can start more 
than one audio session, but only one session can be active at any one 
time. 
 
To use audio support when viewing 
1. The audio options are displayed in the Audio tab of the View 

window ribbon. 
2. The Audio options will be displayed. These are the same options 

as on the Audio toolbar. 
 
The Mute icon turns the speaker and microphone on and off.  
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To use audio support when showing 

1. In the Show dialog box, select Enable Audio Support. 
2. The Audio settings set in the Control Configurator - Audio settings 

will apply during these sessions. 
 

Audio announcements 

This feature sends an audible announcement to all selected Clients 
headphones or speakers. They will be able to hear the Control but will 
not be able to speak back. 

 

Making an announcement 
1. Select the Desktop tab in the ribbon and click Announce.  
2. The Announce dialog will appear. Include (green tick) or exclude 

(red cross) Clients from the announcement and click Announce.  
3. A dialog will appear, indicating that you can now announce.  
4. Click OK when you have finished speaking. 
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Adjusting microphone and speaker volume   

You can adjust the audio settings within NetSupport Manager to 
match the capabilities of your multimedia workstations or to fine tune 
performance. However, you should note that the higher the quality of 
sound you select, the greater the volume of data that needs to be 
sent. This can affect screen update performance on slower 

workstations. 
 
To access the volume controls 

1. Right-click on the speaker icon in the taskbar. 
 
To change other options,  such as sound quality, do one of the 

following:  
 
Global method (changes default setting for all Clients): 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar. 
2. Select Remote Control – Audio. 

 
Individual Client method (while viewing): 
1. Go to the Audio tab in the View window ribbon and click Audio 

settings . 

 
In both cases, the Audio Setting dialog will be displayed. This allows 
you to set the following properties: 
 
Volume settings adjustments 
Threshold Microphone sensitivity. 

Microphone Volume of microphone. 
Speaker Volume of speakers. 
 
Enable options 
On  Turn audio on. 
Off  Turn audio off. 

Talk  Set the Control audio to talk function only. 
Listen  Set the Control audio to listen function only. 
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Video Player support 

NetSupport Manager provides exceptional multimedia support with 
full audio, video and remote control capabilities. This section deals 

specifically with the use of the NetSupport Manager Video Player.  
 

Note: The NetSupport Video Player is only available if you install the 
NetSupport School Tutor component during installation. 

 

While the NetSupport Manager Video Player can be used for viewing a 

video file on an individual workstation, the combination of NetSupport 
Manager’s remote control capabilities with full audio support allows 
you to use this tool to enhance training sessions and demonstrations. 
By running a Show, then launching the NetSupport Manager Video 
Player, all Clients will be able to watch video files from their own 
workstations, with full audio support.  
 

The Video Player supports all standard video files, for example, avi 
and mpg. The Video Player runs locally on each Client workstation, 

while the video file can be accessed locally or on a network drive. If 
video files are stored locally, network traffic is restricted to video 
player controls and synchronisation and is therefore minimal, making 
it possible to control video sequences running on a larger number of 
workstations simultaneously. 

 
If video files are stored on a network drive and Clients have to 
retrieve files across the network, there will be a greater impact on the 
network. For optimum performance, store the video files locally on 
each workstation, you may wish to use File Distribution to do this.  

 

Other influencing factors will be: 
• The number of Client workstations accessing the file 

• The speed of the network, e.g. 10/100 MB 

• The size of the video file 

• Client workstation memory/performance specification 

• Other traffic on the network. 
 

Notes: 

• If a Client workstation is required to retrieve files from a server 
for smooth operation, ensure that the Client workstation has 
sufficient access rights to the relevant drive and files. 

• The video adapter of the workstation and how the screen 
resolution is configured will affect the quality of the display. 
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To play a video file on a workstation 

1. Perform a Show to the Client workstations you want to watch the 
video file. 

2. While performing the Show, launch NetSupport Manager Video 
Player by double-clicking on the NetSupport Manager Video 
Player icon in the NetSupport Manager Program folder. 

3. The Video Player control panel will appear. 

4. Choose {File}{Open} from the Video Player drop-down menus to 
select the correct video file.  

5. The Video Player video screen will then appear below the toolbar 
with the selected file loaded, ready to be played. 

Note: NetSupport Manager’s Video Player utilises the Audio 
Support software and hardware installed on your operating 

system, please adjust these to suit your needs. 

6. Click on the Play button on the Video Player toolbar. 
Or 
Choose {Play}{Play} from the Video Player drop-down menus. 

 
To pause or stop a video file and return to the beginning while 

it is playing 
1. Click on the Pause or Stop button on the toolbar.  

Or  
Choose {Play}{Stop or Pause} from the Video Player drop-down 
menus. 
 

Note: The pause command blanks any Clients video screens you may 
be Showing the Video file to. 

 

To return to the beginning of the video file 
1. Click on the Start button on the toolbar to return to the 

beginning of the video file. 
Or 

Choose {Play}{Start} from the Video Player drop-down menus. 
 
To fast forward to the end of the video file 
1. Click on the End button on the toolbar to fast forward to the end 

of the video file. 
Or 

Choose {Play}{End} from the Video Player drop-down menus. 
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Video Player control panel  

The Video Player control panel operates in a similar manner to 
standard audio and visual aids.  

 

File menu 
The File drop-down menu contains the following options: 

 
Open 
Allows you to select and load the appropriate video file. 
 
Close 
Closes the open video file. 

 

Exit 
Shuts down the Video Player. 
 
View menu 
The View drop-down menu contains the following options: 
 

Toolbar 
Hides and displays the Video Player toolbar. 
 
Status Bar 

Hides and displays the status bar of the Video Player. 
 
Zoom 

Resizes the video screen 
 
Play menu 
The Play drop-down menu contains the following options: 
 
Play 

Starts the loaded video file. 

 
Stop 
Returns to the beginning of the loaded video file. 
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Pause 

Blanks the Client’s video screen and pauses the video file at the 
Control workstation. 
 
Repeat 
The video file will be repeated until the Control stops this. 
 

Start 
Returns to the beginning of the video file. 

 
End 
Fast forward to the end of the video file. 
 
Mute Clients 

If Clients are not using headphones while they are watching a video, 
the sound coming from each workstation can be distracting. This 
option turns audio off at the Client workstations but leaves it on at 
the Control machine. 
 

Help menu 
Provides access to the online help and general version information. 
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Replay files 

During a remote control session, the screen, keyboard and mouse 
activity at a Client or Control PC can be recorded, stored in a file and 
played back. If the PCs are configured for audio, any narration that 
takes place can also be recorded. 

 
A Control can determine how and when recordings take place by 
enabling the appropriate configuration options: 
 

• Local recording  
• At individual or all Client PCs.  
 

Recording local activity 

Activity at the local machine can be recorded and played back. If 

required, the replay file can also be ‘shown’ to remote Clients. 
 
1. Select the Desktop tab in the ribbon and click the Record icon. 
2. The Record Local Activity dialog will appear. 

 

3. In Folder 
Specify where you want the replay files stored. In order to 
identify each file, file names will be prefixed with ‘Local’ and the 
date and time of the recording. 

4. Include Audio 
In addition to the screen, mouse and keyboard activity, if the 
workstation is configured for audio, you can record any narration 

that takes place. Check this box to enable. 

5. Record Physical Fonts 
In order to reduce the volume of data being sent when sharing 
information of this nature, NetSupport Manager passes the font 
information by reference. The target workstation will refer to its 
own internal font mappings to find an appropriate match to the 

one that has been sent. In most cases, the same fonts will be 
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available, but if there are instances where this isn’t the case, you 

can send the full information. Check this box to enable. 
6. Click OK to start recording. The Recording icon will appear in 

the taskbar. 
7. To stop recording, double click the Recording icon. 
 

Recording replay files at Client PCs 

Activity at remote PCs is recorded when a Control ‘Views’ a Client that 
is configured to record replay files. The option can be enabled at 

individual Client level or set globally. 

 
Record replay files for all viewed Clients 
This procedure enables the Control to create a replay file each time it 
‘views’ a Client PC. The settings can be applied to the current control 
configuration or to a ‘named’ configuration. 
 

1. To update a specific Control profile, click the Profiles icon  on 
the caption bar, select the required profile and click Settings. 

Or 

Click the Change the settings for the current Configuration 

icon  on the caption bar if updating the standard Control 
profile. 

2. The Settings for Configuration dialog will appear. 
3. Choose Security - Replay Files and enable the appropriate 

options.  
 
Record replay files for individual Clients 

This procedure enables replay files to be created at machines where 

the Client configuration has the Record Replay Files option enabled. 
 
1. Run the Advanced Client Configurator at the required PCs. 
2. Select the profile to amend. 
3. Select Security - Replay Files and enable the appropriate 

options.  
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Watching recorded replay files 

Replay files can be watched by a Control with appropriate access 
levels to the files. These, in turn, can be shown to Clients. 
 

At a local level, the NetSupport Manager Client program also provides 
a Replay option enabling Clients to launch files. 
 
At the Control 
1. Select the Desktop tab in the ribbon and click Playback. 

2. A list of the last 20 replay files is displayed. Select the required 

replay file from the list or click Browse to open the folder where 
the replay files are stored. 

Notes:  
• By default, the list will be empty. New recordings and replay 

files that have been played will be automatically added to the 
list. To add a replay file to the list without playing it, click 
Browse, select the required replay file, clear the Playback 
now option and click Open.  

• You can delete a replay file by selecting the required replay 

file and clicking Delete File . The replay file will be moved 

to the recycle bin. 

3. The Replay window will appear. Use the Replay controls to 
start/stop the file. 

 
At the Client 
1. Double-click the NetSupport Manager Client icon in the system 

tray. 
2. The Client Information window will appear.  

3. Click the Replay icon. 
4. Navigate to the folder where the replay files are stored. 

5. Select the file to replay. 
6. Click Open. The Replay window will appear. Use the Replay 

controls to start/stop the file. 
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Showing replay files to Clients 

Replay files can be watched by individual Control’s and Client’s. The 
Control also has the option of ‘showing’ a specific file to multiple 
Clients. 

 
1. Select the Clients to show the replay file to. 
2. Select the Desktop tab in the ribbon and click Show Replay. 

Or 
If showing the replay file to a group of Clients, select the required 

group in the Tree view and click Show Replay in the Group tab 

in the ribbon or right-click the group and select Show Replay. 
3. The Show Replay dialog will appear. 

 

4. Browse for and select the required replay file. 
5. Click Show. 
6. The Replay window will open at the Control machine and start 

playing the replay file to the selected Clients. 

7. Click  on the Replay window caption bar to end the Show. 
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File Transfer 

The File Transfer window 
When you choose to perform a File Transfer operation on an 

individual Client, the File Transfer window is displayed. At its 
simplest, you transfer files by dragging them from one location to 
another. 

 

The File Transfer window is divided into the following sections: 
  
The caption bar 

The caption bar shows which Client this File Transfer window is 
working with. Clicking the Client name brings up a Remote 
Management pane, and from here, you can see details of the Client 

and perform a variety of functions.  
 

By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 

enabled or not) are displayed on the caption bar. You can customise 
what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 

on the quick access bar, connected Clients list on the status 
bar and when zooming into thumbnails. 
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The following options are available: 

 

 Show or hide the ribbon. 

 Access the File Transfer settings for the current 
configuration. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee, 

Technical Support and compression information. 
  

The ribbon 
The ribbon provides access to all the tasks and tools when working 
with a selected file or folder. Positioning the cursor over an icon will 
display a brief description of its function. 

 
The following sections are available in the Home tab of the ribbon: 
 

• Folder 

Provides access to the options for working with folders, such as 
copy, delete and rename. You must select a folder to work with 
before the options become available. 

 
• File 

Provides access to the options for working with individual files, 
such as copy, delete and rename. This section will only appear 
when you have selected a file to work with. 
 

• Select 

Allows you to select the files and folders in the List view that are to 
be transferred. 

 
• General 

Enables you to print the content of a selected folder or file list and 
access a list of recent files to send to the Client. 

 
• Favourites 

Add or remove the currently selected folder to the Favourites folder 
in the Tree view. 

 
When a file or folder is selected, a new tab displaying its properties 
will appear. The following sections are available: 

 
• Attributes 

View and set the attributes for the selected file or folder. 
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• Information 

Provides a summary of the selected file or folder.  
 

• Actions 
From here, you can perform actions such as open, copy, delete or 
rename. 

 

The local pane 
The local pane displays a Tree view of the folders of the Control on 

the left-hand side and a List view of the contents of those directories 
on the right-hand side. Right-click on any item in one of the columns 
in the List view and a range of context-sensitive functions becomes 
available. 
 

The remote pane 
The remote pane displays a Tree view of the folders of the Client on 
the left-hand side and a List view of the contents of those directories 
on the right-hand side. Right-click on any item in one of the columns 
in the List view and a range of context-sensitive functions becomes 

available. 
 

File information area 
The file information area is displayed at the top of both the local and 
remote panes. Use the arrows to go to the previous, next or parent 
folder in the Tree view. Click  to select from a list of previously 
selected folders. The current folder path will be displayed and you can 
enter a pathname here to go directly to a folder. You can filter, sort 

and choose how to view the contents of the List view. To provide 
more space when working with files and folders, you can maximise 

the local or remote pane by clicking Window . 
 
Status bar 
The status bar shows the number of connected Clients. You can see a 
list of all connected Clients by clicking Connected (clicking a Client 
name opens a File Transfer window for them). Right-click to choose 

how the Client is displayed in the list. 
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Arranging multiple File Transfer windows 

Just as you can view to more than one Client at a time, you can have 
more than one File Transfer window open at a time. These File 
Transfer windows can be easily arranged using the Window menu.  
 
To arrange multiple File Transfer windows 

1. Make sure a File Transfer window or the Control window is active.  

2. On the caption bar, click Window Menu  and select Tile - 
File Transfer Windows. 

3. All open File Transfer windows will be arranged so that they 
proportionality fill the Control screen.  

 

Notes: 
• When working with multiple File Transfer windows, refer to the 

File Transfer window’s caption bar to check which Client is being 
viewed in a particular File Transfer window.  

• You can use the Tile windows function to similarly arrange all 
open View and Control windows.  

 
Applying a filter to files in List view 

You can apply a filter to the contents of a local or remote List view, so 
that only file names which meet certain criteria or certain file types 
will be displayed. You do this by using the Filter field in the file 
information area (located above both panes’ List views). 

 
Any filter settings applied to the local List view will not affect the 
display of the remote List view and vice versa. 

  
Filter settings will remain applied until you reset them or close the 
File Transfer window. 
 

To apply a filter to files in the List view 
1. Click in the Filter field above the pane whose List view you wish 

to filter. 
2. To filter by file name, enter the search term followed by *.*. For 

example, if you wanted to view all file names beginning with the 
letter MKT, then you would type MKT*.* in the Filter text box. 

Or 

To filter by file type, enter the file extension in the Filter field 
(enter *. before the extension type) or click  to select from a 
list of current file types.  

3. Press Enter to apply the filter 
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To reset the filter to files in the List view 

1. Click the cross in the Filter field  above the pane 
whose List view you wish to reset. 

 
Changing the View format in the File Transfer 
window 

The contents of the List view of the local pane and remote pane can 
be displayed in different formats. You can also sort the contents of 

the List views in order to make them easier to navigate. 
 
There are three types of view in which you can display the contents of 
the List view in a File Transfer window: 

 

Icon view   Displays the files and folders as icons. 

Details view  Displays the files and folders as icons. 
 

Note: The column order can be changed by 

dragging and dropping the column 
headers. 

 

Small icon view  Displays the file and folder names only. 

 
By default, the contents of the List view will be displayed in Details 
view. You can change the view by clicking the relevant icon in the File 
information above the local or remote pane. 
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Changing the sort orders in a File Transfer window 

Typically, the contents of the List views in a File Transfer window can 
be sorted into the following orders: 
 

Sort Order Description 

By Name The contents will be sorted alphanumerically 
by file name. 

By Type The contents will be sorted alphanumerically 

by file extension. This is not applicable to 
drives and folders in the List view. 

By File Description The contents will be sorted according to the file 
description. 

By Modified Date The contents will be sorted according to the 
date they were last modified. 

By Size The contents will be sorted according to the 

size of the file. This is not applicable to drives 
and folders in the List view. 

  

Note: You can also specify whether the contents are to be sorted in 
ascending or descending order. 

 
To change the sort order 
1. Select the appropriate pane (local or remote). 

2. Click Sort  and select the required option from the list. 

 

Notes:  

• When the List view is displayed in Details view, you can click on 
the column headings, such as name and description, to sort the 
order by an appropriate column heading. Clicking on a column 
heading a second time will toggle the order direction. The current 
order direction will be indicated by a small arrow on the top of the 
column heading. For example, an arrow pointing up indicates the 
List is sorted in ascending order. 

• The order of the columns can be changed by dragging and 
dropping the column headers. 



NetSupport Manager v14.00 

 

 168 

Transferring files and folders 

NetSupport Manager includes sophisticated File Transfer functionality 
that enables you to transfer files to and from a Control and Client 
workstation. 

 

Notes: 
• To help improve performance, NetSupport Manager uses Delta 

File Transfer technology, meaning that only the changed parts of 
a file that may already exist in the destination folder are 

transferred. This can prove most useful when updating database 
files between two locations where either bandwidth usage or 
availability is an issue. 

• File Transfer functionality can be configured by clicking the 

Change the settings for the current Configuration icon  
on the caption bar and choosing File Transfer. 

• While viewing a Client, you can drag and drop files from the 

Control Windows Explorer directly to the Client's desktop. 

 

To transfer files between a Control and a Client 
1. Select the required Client in the List view. 

2. Select the Home or Remote tab in the ribbon and click File 
Transfer.  
Or 
Right-click on the Client icon in the list view and choose File 
Transfer.  
Or 

If you are viewing the Client, select the Tools tab in the View 
window ribbon and click the File Transfer icon. 

3. The File Transfer window to that Client will open. 
4. From the local or remote pane Tree view, select the destination 

drive or folder into which the items will be copied. 

Note: The path to any open folders (Explorer windows) on the 

Client desktop will be displayed at the top of the remote 
pane to enable quick selection. 

5. From the local or remote List view, select the item(s) to be 
copied. To select all files, click the Files icon on the ribbon. To 
select all folders, click the Folders icon. If you want to transfer 

all files and folders, click the All icon. 

Note: NetSupport Manager provides a list of files that the Control 
has recently worked with, which can be sent to a Client. 
Click Recent Files (the last 20 files are displayed) and 
select a file from the list. The file will be copied to the 
current folder at the Client. 
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6. Click Copy File. 

Note: The selected item(s) can also be ‘dragged’ from the List 
view and ‘dropped’ into the destination drive or folder. 

7. A confirmation dialog will be displayed. Click Yes. 
8. The Copy Progress dialog will appear, showing the progress. From 

here, you can choose to ignore any error messages and overwrite 
prompts until completion. These will then be displayed in a 
summary window at the end of the operation. 

 

To transfer files between Clients 
1. Display the File Transfer window for each Client. 
2. Arrange the File Transfer windows so you can see both Clients 

and simply drag files/folders from one to the other. 
  

Note: You can see more of a Client’s files and folders by clicking 

Window , located above the remote pane. 

 
Managing files and folders 

You can easily manage the file and folders you wish to work with 

during a File Transfer operation. 
 
To create folders 
New folders can be created at the Control or the Client. 
 

1. Select the local or remote Tree view. 
2. Select the drive or folder in which the folder you want to create 

will appear. 

3. Click the Create Folder icon on the ribbon. 
4. The Create Folder dialog will be displayed. 
5. Enter a name for the folder and click OK. 

 
Add a folder to Favourites 
Folders that need to be accessed regularly can be added to the 
Favourites folder in the Tree view. 
 

1. Select the required folder in the local or remote pane. 

2. Click the Add icon on the ribbon. 

3. The folder will appear under Favourites in the Tree view. 
 

To rename a file 
1. Select either the local or remote pane List view. 
2. Select the file to be renamed. 
3. Click the Rename File icon on the ribbon or press F2. 
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4. Enter the new name for the file. 

5. Press Enter. 

 
Changing file attributes 

You may want to change the attributes of a file, for example, to read-
only. 
 

1. Select the file whose attributes you want to view or change. 
2. Click the Properties icon on the ribbon. 

Or 
Right-click and choose Properties. 

Or 
Select the tab displaying the file name in the ribbon and click 
Modify. 

3. The File Properties dialog will appear. 
4. Check or clear the attributes you wish to set. 
 

Editing a remote file 

You can edit a file on the Client machine at the Control machine and 

send the updated version back to the Client. 
 

Note: You can quickly edit a file using NetSupport Manager's internal 
text editor by right-clicking the required file and selecting 
Quick Edit. 

 
1. Double click the required file in the remote pane. 

Or 
Select the required file in the remote pane. Click the Open Item 
icon on the ribbon to open the file using the default application or 

click the drop-down arrow to select an application to open the file 
with. 

Note: The Open Item icon is not available for certain file types 
such as .exe, .cmd and .bat files. You can choose an 
application to open these with by right-clicking the file, 
selecting Open With and clicking Choose Application. 

2. A dialog will appear asking you to confirm that you wish to upload 
the file and open it. Click Open.  

Note: This dialog won't appear for .bmp, .png, .jpg, .gif, .txt and 

.doc file types. You can add to and edit the list of safe file 
types in the File Transfer settings (even if .exe, .cmd and 
.bat file types are added to the list, you will still be 

prompted before you can choose an application to open 
these). 

3. Make the relevant changes to the file and save and close it. 
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4. A prompt will appear. Click Yes to send the updated file to the 

Client. You can change the name of the file by entering a new 
name in the Save As field. If you click No, the file won't be 
copied to the Client and any changes you made will be lost. 

Note: You will be advised if the file has changed while you were 
editing it. You can choose to save your copy of the file 
with a different name, overwrite the remote file at the 
Client or cancel and lose any changes you made. 

 

Deleting files and folders 
You can delete files and folders from either a Control or Client 
machine. 

  

To delete a file 
1. Select the file you wish to delete. 
2. Click the Delete File icon on the ribbon. 
3. A confirmation dialog will be displayed. Click Yes. 

To delete a folder 

1. Select the folder you wish to delete. 
2. Click the Delete Folder icon on the ribbon. 
3. The Remove Folder dialog will be displayed. 
4. Select the Include Contents checkbox. 
5. Click Yes. 

 

Notes: 
• You cannot remove more than one folder at a time. If you have 

several folders selected in the List view when performing the 

delete operation, only the last selected folder will be removed. 

• By default, all files deleted from the local pane will be sent to the 
Recycle bin. This can be changed in the File Transfer settings. 
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Print File Transfer list 

The File Transfer window provides an option to print a list of files 
from either the local or remote pane. This can be useful if a record of 
file transfer operations is required. 

 
You can print a complete folder tree or file list or a selected area. 
 
To print a folder or file list 
1. In either the local or remote pane, select the folder tree or 

individual file list to be printed. 

2. Select the Print icon on the ribbon. The Print Options dialog will 
appear. 

3. Confirm whether you are printing a folder tree or file list and if it 
is the full list or selected area. You can also choose to include the 
application icon appropriate to each file by checking the Print 
Images box. 

4. Click OK to print. 

 

Synchronising folders 

You can synchronise the contents of selected folders on the Control 
and Client. When you synchronise two folders, any new or updated 
files in either folder will be automatically copied to the other folder. 
 
To synchronise folders 
1. Select the folder from the local pane Tree view to be 

synchronised with the Client. 
2. Select the folder from the remote pane Tree view to be 

synchronised with the Control. 

3. Click the Synchronise Folders icon on the ribbon. 
4. The Synchronise Folders dialog will be displayed. 
5. Check the displayed paths of the two selected folders. 
6. Choose to include the subfolders by selecting Include 

Subfolders. 
7. To automatically overwrite newer versions of existing files, select 

Overwrite All. 

8. Choose OK. 
9. A confirmation dialog will be displayed, click Yes. 
10. The Folder Synchronisation Progress dialog will be displayed. 

11. When completed, the result will be displayed in the Folder 
Synchronisation Results dialog. 

12. Click OK. 
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File Distribution 

 

The File Distribution window 

The File Distribution window is used for distributing files to multiple 
Clients simultaneously. 

 

The File Distribution window is divided into the following sections: 

  
The caption bar 
The caption bar shows which group of Clients this particular File 
Distribution window is working with. The following options are 
available: 
 

 Show or hide the ribbon. 

 Access the settings for the current configuration. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee and 
Technical Support information. 

 
The ribbon 

The ribbon provides access to all the tasks and tools when working 

with a selected file or folder. Positioning the cursor over an icon will 
display a brief description of its function.  
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The following sections are available in the Home tab of the ribbon: 

 
• Clients 

Enables you to choose a destination folder on the selected Client to 
where the files will be sent and prevent the Client folders from 
being automatically updated when you change the local folder. 

 

• Folder 
Provides access to the options for working with folders, such as 

copy, delete and rename. You must select a folder to work with 
before the options become available. 
 

• File 
Provides access to the options for working with individual files, 

such as copy, delete and rename. This section will only appear 
when you have selected a file to work with. 

 
• Select 

Allows you to select the files and folders in the List view that are to 

be transferred. 
 

• General 
Enables you to print the content of a selected folder or file list and 
access a list of recent files to send to the Clients. 

 
• Favourites 

Add or remove the currently selected folder to the Favourites folder 

in the Tree view. 
 

When a file or folder is selected, a new tab displaying its properties 
will appear. The following sections are available: 
 

• Attributes 
View and set the attributes for the selected file or folder. 

 
• Information 

Provides a summary of the selected file or folder.  
 

• Actions 

From here, you can perform actions such as open, copy, delete or 
rename. 
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The local pane 

The local pane displays a Tree view of the folders of the Control on 
the left-hand side and a List view of the contents of those folders on 
the right-hand side. Right-click on any item in one of the columns in 
the list view and a range of context-sensitive functions become 
available. 
 

File information area 
The file information area is displayed at the top of the local pane. Use 

the arrows to go to the previous, next or parent folder in the Tree 
view. Click  to select from a list of previously selected folders. The 
current folder path will be displayed and you can enter a pathname 
here to go directly to a folder. You can filter, sort and choose how to 
view the contents of the List view. 
 
The remote pane 
The remote pane shows the Clients to whom the files will be 
distributed. Right-click on any item in one of the columns in the list 
view and a range of context-sensitive functions become available. 

 
Status bar 

The status bar shows the number of connected Clients. You can see a 
list of all connected Clients by clicking Connected. Right-click to 
choose how the Client is displayed in the list. 
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Distributing files 

You can distribute files to 
• All connected Clients. 
• Selected Clients. 
• A pre-defined group of Clients. 

 

Note: To improve performance when distributing files, NetSupport 
Manager's Broadcast File Distribution facility is enabled by 
default. This results in the files being sent to all machines 

simultaneously, thus improving the speed of transfer. If this 
feature is turned off, the files are sent to each Client machine 
in turn. 

 
Whilst reducing overall network traffic generated by 
NetSupport Manager, using this feature will generate 
additional broadcast packets on your network. It is 

recommended that you consult your network administrator 
before using this feature.  

 

          File Distribution can be sent to Clients using multicast. The 
broadcast will only be sent to machines included in the 
specified IP multicast address. 

 
To distribute files to a defined group of Clients 
1. Select the group of Clients you wish to distribute files to from the 

All Computers folder in the Tree view. 

2. Select the Group tab in the ribbon and click File Distribution.  
3. The File Distribution window will appear. 

4. From the Tree view, select the item(s) to be copied to the Clients. 
5. The location on the Client workstations where the files/folders are 

copied to is called the destination folder. Unless otherwise 
specified, the Client destination folder will be the same as the 

item(s) location on the Control workstation. If the Client does not 
have the same folder available, the item(s) will be copied to the C 
Drive by default and the folders automatically created. 
Or 
To set a specific destination folder on the Client workstation, 
right-click on the Client icon in the remote pane and choose Set 

Destination. Specify a destination, click OK. 

Note: To set the destination folder for all Clients in the group, 
click the Set Destination icon on the ribbon. You can lock 
the destination folder at Clients by clicking Lock Folder. 

6. Click Copy File. 
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To distribute files to a selected number of Clients 

1. Open the All Computers, Browse or Active folder in the Tree 
view. 

2. Select the Tools tab in the ribbon and click File Distribution. 
3. The File Distribution window will appear. 
4. In the remote pane, indicate which Clients you wish to copy files 

to by ensuring a green tick appears beside the Client name (click 

this to remove the Client from the file distribution). 
5. From the Tree view, select the item(s) to be copied to the Clients. 

6. The location on the Client workstations where the files/folders are 
copied to is called the destination folder. Unless otherwise 
specified, the Client destination folder will be the same as the 
item(s) location on the Control workstation. If the Client does not 
have the same folder available, the item(s) will be copied to the C 

Drive by default and the folders automatically created. 
Or 
To set a specific destination folder on the Client workstation, 
right-click on the Client icon in the remote Pane and choose Set 
Destination. Specify a destination, click OK. 

Note: To set the destination folder for all Clients in the group, 

click the Set Destination icon on the ribbon. You can lock 
the destination folder at Clients by clicking Lock Folder. 

7. Click Copy File. 
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File Manager 

The File Manager window 

The NetSupport Manager File Manager serves the same purpose as 
Microsoft Explorer. Rather than exiting the NetSupport Manager 
program and editing the Control workstation, do it from within 
NetSupport Manager. 

 

The File Manager window is divided into the following sections: 
 

The caption bar 

The caption bar shows that you are in the File Manager window. The 
following options are available: 
 

 Show or hide the ribbon. 

 Access the settings for the current configuration. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee and 
Technical Support information. 

 
The ribbon 
The ribbon provides access to all the tasks and tools when working 

with a selected file or folder. Positioning the cursor over an icon will 
display a brief description of its function.  
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The following sections are available in the Home tab of the ribbon: 

  
• Folder 

Provides access to the options for working with folders, such as 
copy, delete and rename. You must select a folder to work with 
before the options become available. 
 

• File 
Provides access to the options for working with individual files, 

such as copy, delete and rename. This section will only appear 
when you have selected a file to work with. 

 
• Select 

Allows you to select the files and folders in the List view. 

 
• General 

Enables you to print the content of a selected folder or file list. 
 

• Favourites 

Add or remove the currently selected folder to the Favourites folder 
in the Tree view. 

 
When a file or folder is selected, a new tab displaying its properties 
will appear. The following sections are available: 
 

• Attributes 
View and set the file attributes for the selected file or folder. 

 
• Information 

Provides a summary of the selected file or folder. 
 

• Actions 
From here, you can perform actions such as, open, copy, delete or 
rename. 

 
The local pane 
The local pane displays a Tree view of the folders of the Control on 
the left-hand side and a List view of the contents of those folders on 
the right-hand side. Right-click on any item in one of the columns in 

the list view and a range of context-sensitive functions becomes 
available. 

 
File information area 
The file information area is displayed at the top of the local pane. Use 
the arrows to go to the previous, next or parent folder in the Tree 
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view. Click  to select from a list of previously selected folders. The 

current folder path will be displayed and you can enter a pathname 
here to go directly to a folder. You can filter, sort and choose how to 
view the contents of the List view. 
 
Status bar 
The status bar shows the number of connected Clients. You can see a 

list of all connected Clients by clicking Connected (clicking a Client 
name opens a File Transfer window for them). Right-click to choose 

how the Client is displayed in the list. 

 

Managing files on the Control workstation 

You can manage files on a Control workstation using the File Manager 
window. This is similar to the File Transfer window but only displays 
the contents of the Control workstation.  
 
To display the File Manager window, select the Tools tab in the ribbon 
and click File Manager. 

 

The Tree view 
• To select a drive or folder in the Tree view, simply click on it. The 

contents of the selected item will then be displayed in the List 
view (on the right). 

• If the selected drive or folder contains subfolders that are not 
displayed, the following  icon will be displayed to the left of the 

item. 
• To expand the contents of a drive or folder so that its subfolders 

are visible in the Tree view, either double click on the drive or on 
the folder, or click on the  icon to the left of the drive or folder 

you wish to expand.  
 

The List view 
• To select an item in the List view, simply click on it.  
• To select multiple items in the List view: 

• If the items are adjacent to one another, select the first item, 
hold down the Shift key and then select the last item. 

• If the items are not adjacent to one another, then select the 
first item, then hold down the Control key and select each of 

the other items. 
• If all files and/or folders are required, click All in the ribbon. 

To select all files, click Files and to select all folders, click 
Folders. 

 



NetSupport Manager v.14.00 

 

 181 

When a file or folder has been selected, the icons on the ribbon will 

become active, allowing you to perform actions such as open, copy, 
delete or rename. A new tab will also appear in the ribbon displaying 
its properties, and from here, you can view and edit the attributes 
and work with the file or folder. 
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Control/Client Chat sessions 

NetSupport Manager allows you to ‘Chat’ to any number of connected 
Clients simultaneously via a scrolling text window.  

 
1. Select the Clients or group of Clients you want to chat to in the 

List view. If you do not select a Client icon, all connected Clients 
will be included. 

2. Select the Remote tab in the ribbon and click Chat. 
Or 

Right-click on an individual Client and choose Chat. 
Or 
If you want to chat to a group of Clients, select the required 
group in the Tree view and click Chat in the Group tab in the 
ribbon or right-click the group and select Chat. 

3. The Create Discussion dialog will appear.  

 

The dialog has the following options: 

Topic 
If required, enter a title or description for the subject to be 
discussed in the Chat session. This will appear in the Title bar of 
the Chat window that is displayed at the Client machines. If left 

blank, the Control name will appear. 

 
Options 
Members can decline to join 
If checked, a message will appear at the Clients machine inviting 
them to join the Chat session. They can choose to join or decline. 
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Members can’t leave the chat 
If checked, the option for Clients to leave the Chat session will be 
removed. 

Chat Window is always visible 
If checked, the Chat window remains on the Clients desktop for 
the duration of the Chat session. Members cannot minimise the 

window. 
 

Members 
To exclude a Client from the Chat session, remove the green tick 
next to the Client’s name. 
 
Click OK to start the Chat session. 

4. The Chat window will appear on the Control and Client 
workstations.  

 

The Chat window 

This window is displayed at each participating member’s machine and 

lists the progress of the Chat session.  
 
Unless the option is disabled in the Create Discussion dialog, Clients 
can choose to leave the session. 
 
The following options are available from the Chat window: 

Chat Menu 
The content of a Chat session can be stored for future reference. 
Choose Save to create a file containing the text or choose Copy to 

be able to paste the Chat content into another application or file. 
 
Should the Chat members not respond, you can send an audible beep 
to each workstation by selecting Send Beep. (The Client can also do 

this from their Chat window.) You can configure the Client and 
Control workstations to play the beep through either the PCs internal 
speaker, the default, or via the installed sound card to speakers 
attached to the PC. Select Client Configuration - Client Settings or 
Control Configuration - Settings. 
 

Window Menu 

Only the Control’s Chat window will have a window drop-down menu. 
This menu enables you to swap between opened screens or Tile 
them.  
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Chat Progress 

The main body of the Chat window is used to record the progress of a 
Chat session. It holds details of members who have joined or left the 
discussion, as well as the messages that have been sent by each 
member. 
 
Message 

This is where you type your comments. Type the message and hit 
Enter or click Send.  

 
Auto Send 
Each message is restricted to 128 characters. Check this box to 
automatically send the message when the limit is reached. 
 

Close 
Ends the Chat session. 
 
Members 
Members currently included in the Chat session are listed here. The 

Control can add or remove Clients from the Chat session as required. 
Unless disabled, Clients have the option to leave the session of their 

own accord. 
 
Invite 
The Chat Properties dialog is initially used to select the Clients to 
include/exclude from the Chat session. To add Clients when the Chat 
session is in progress, click Invite. The Add Members dialog will 

appear, select the required Clients and click Add. You can send a 
copy of the Chat progress to new members by checking the Send 

discussion history box.  
 

Note: Clients that have been removed or have decided to leave the 
Chat session can be invited back. 

 

Eject 
To remove Clients from the Chat session, select the Client in the 
Members list and click Eject. Ejected Clients can be invited back into 
the session if required. 
 

 

Note: Clients can initiate Chat sessions with the Control by opening 
the Client information window and clicking the Chat icon.  
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Disable Chat sessions 

The Chat feature can be disabled in a Client’s configuration, 
preventing either the Client or Control from initiating a Chat session. 
 
To prevent the Control from initiating a Chat session 
1. At the required Client workstation(s), choose NetSupport 

Manager Configurator from the NetSupport Manager Program 
group. The NetSupport Client Configurator will appear. 

2. Select Advanced and choose the profile to amend. 

3. Select Security - Access Privileges. 
4. Check the Disable Chat option. 
5. Click OK. 

6. Save the profile and restart the Client. 
 
If the Control attempts to open a Chat session, they will be advised 
that they do not have access rights to perform the task at that Client. 
 

Note: To prevent the Control from chatting to all Clients, disable the 

feature in the Control configuration. Click the Profiles icon  
on the caption bar, select the required configuration and 
select Settings. In the Settings for Configuration dialog, 
select Control Interface - Functions and check the Disable 
Chat option. 

 
To prevent the Client from initiating a Chat session 
1. At the required Client workstation(s), choose NetSupport 

Manager Configurator from the NetSupport Manager Program 

group. The NetSupport Client Configurator will appear. 

2. Select Advanced and choose the profile to amend. 
3. Select Client Interface - Client Settings. 
4. Check the Disable Chat option. 
5. Click OK. 
6. Save the profile and restart the Client. 

 
The Chat option will be unavailable at the Client. 
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Sending messages to Clients 

With NetSupport Manager, you can send a message to an individual 
Client, a group of Clients or all Clients on the network. 

 
To send a message 
1. Select the required Client in the List view. 
2. Select the Remote tab and click Send a message. 

Or 
Select the Desktop tab in the ribbon and click Broadcast 

Message. 
Or 
Select the tab in the ribbon displaying the Client's name and click 
Send a message. 
Or 
Right-click and choose Message.  

3. The Message dialog will appear. Choose whether to send the 

message to all available Clients, all connected Clients or only the 
currently selected Client(s). Enter the message and decide 
whether to show it at Client PCs for a specified time. 

4. Click Send. 

 

The message will be displayed in a dialog at the Client screens and 
will remain until the user closes the dialog or the specified time limit 
expires. In addition to the message itself, a customised title can be 

included. This is set in the Control configuration. Click the Change 

the settings for the current Configuration icon  on the caption 
bar and select General. 
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Dealing with help requests  

NetSupport Manager allows a user at a Client workstation to request 
help from a specified Control workstation.  

 
If a Control’s List view has been set to Details view and customised to 
display help messages, a Client's help request message will be 
immediately displayed in the List view. The Help Requests folder in 
the Tree view will also be highlighted. 
 

NetSupport Manager also allows you to configure a Control's help 
request warning settings and availability. 
 
To adjust a Control’s help request warning settings 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar. 
2. Select Control Interface - Help Requests. 
3. In the 'When a Help Request Arrives' section, there are three 

additional warnings that a Control can choose to receive when a 

Client sends a help request: 

• Have the Client selected in the List view. 
• Display an independent help request message on the 

Control’s screen. 
• Play a sound when a help request message arrives. 
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To adjust a Control’s help request availability 

A Control can also choose to be in one of three states of availability to 
receive Clients’ help requests. 
 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar. 
2. Select Control Interface - Help Requests. 
3. In the 'Control Status’ section, a Control can choose from the 

following three settings: 

• Available to take all help requests. 

• Unavailable to take any help requests. 
• Busy at the moment (ensure that you specify the number of 

Clients you wish to be connected to, in order to be considered 
busy).  

 

Note: When browsing for Clients, Controls have the option to browse 
only for Clients who have requested help. 

 

To clear a help request 

Once a help request has been dealt with, you can clear this. A Client 
can also clear previous help requests from the Request Help dialog. 
 
1. Select the Help Requests folder in the Tree view. 
2. Right-click on the required Client's request and select Clear 

Help. 
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Capturing a Client’s printed output 

Print capture redirects printer output from a local printer at the Client 
to the printer, PDF/XPS document or file at the Control. You would 
use this when running an application on a Client but want any printed 
output redirected to the printer that is local to you. 

 
To redirect a Client’s print output 

1. Click the Profiles icon   on the caption bar. 

2. Select appropriate configuration. 
3. Click Settings. 
4. Select Remote Control – Print Capture. 

 

5. Check the Enable Print Capture checkbox. 
6. Choose to send the Client’s printer output to a PDF/XPS 

document and whether to automatically print this. 
Or 
Select a printer to redirect the Client’s output to. The default 

printer will be displayed. Click Change to select another printer.  

Or 
Select a file to capture the print file to. 
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Note: In addition to enabling this option at the Control, you also 
need to ensure that print capture is enabled in the Client’s 
configuration. The privileges are enabled by default. 

 

Remote clipboard 

During a View session, you can copy the content of the clipboard 
between Control and Client PCs. 
 

The Clipboard section on the Home tab of the View window ribbon 

provides the following options: 
 
Send  
Used when copying from the Control to a Client and using the 
{Edit}{Cut/Copy} menu option. 
 
Retrieve  

Used when copying from the Client to the Control and using the 
{Edit}{Cut/Copy} menu option. 

 
Auto Clipboard 
When enabled, provides the quickest method for copying data. Use 
the shortcut keys (Ctrl+C and Ctrl+V) to automatically copy to and 
from the clipboard at both the Control and Client machines. 

  
Sending the content of the clipboard from a Control to a Client 
workstation 
1. View the required Client. 
2. Open appropriate applications on the Client and Control 

workstations. 

3. Select and copy the required data from the application at the 
Control. 
If Auto Clipboard is enabled using Ctrl+C copies the data 
directly to the clipboard. 
Or 
If you have used {Edit}{Cut/Copy}, return to the Client's View 
window and click the Send icon on the ribbon. 

4. To paste the data at the Client application, choose {Edit} from 
the Client Application drop-down menu, select Paste. 

Or 
Use the shortcut keys (Ctrl+V) to paste the data. 

 
Sending the content of the clipboard from a Client to a Control 
workstation  

1. View the required Client. 
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2. Open appropriate applications on the Client and Control 

workstations. 
3. Copy the required data from the application at the Client as 

above but, if using menu options rather than the shortcut keys, 
click the Retrieve icon on the ribbon. 

4. Return to the Control application and paste the data using the 
appropriate menu options or the shortcut keys (Ctrl+V). 
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Integration with Explorer  

NetSupport Manager integrates directly with Windows Explorer, 
allowing you to launch key functionality directly from your system 
without needing to first start the NetSupport Manager Control.  
 

By selecting a PC icon from within Network Places/Neighbourhood, 
you can establish a remote session and perform a range of common 
tasks. 
 

Notes: 
• The functionality is only available if the NetSupport Manager 

Control component is installed. 
• A remote control session will only be established if the target 

machine is running a NetSupport Manager Client and the Client 
name is set to the default machine name. 

 
To use NetSupport Manager functionality from within Explorer 
1. Open Explorer from your desktop and navigate to Network 

Places/Neighbourhood to find the list of available PCs. 
2. Right-click on the required PC. 

 

3. Select the appropriate NetSupport Manager function. You can 
choose: 

Remote 
Control 

To view the selected Client screen. 

Chat To open a Chat session with the selected    

Client. 
Inventory To retrieve a full hardware/software inventory     

of the selected PC. 
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To disable NetSupport Manager functionality 

If required, NetSupport Manager Explorer functionality can be 
disabled in the Control Configurator. 
 

1. Click the Profiles icon   on the caption bar. 
2. Select the Control profile to apply the changes to. 
3. Choose Settings. 
4. In the Settings for Configuration dialog, select Control Interface 

– Settings. 

5. Select the Disable Shell Extension option. 
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Remote Command Prompt 

By launching the Command Prompt window, a Control can remotely 
execute command line instructions at a connected Client.  

 
1. Connect to the required Client.  
2. Select the Home or Remote tab in the ribbon and click Remote 

Command. 
Or 

Right-click on the Client icon and select Remote Command 

Prompt. 
Or 
Select the tab displaying the Client's name in the ribbon and click 
Remote Command. 

3. The Remote Command Prompt window will appear.  

 

The window is divided into the following sections: 
 

The caption bar 
The caption bar shows the name of the Client the Remote 

Command Prompt window is open for. Clicking the Client name 
brings up a Remote Management pane, and from here, you can 
see details of the Client and perform a variety of functions.  
 
By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 

enabled or not) are displayed on the caption bar. You can 

customise what is displayed and choose to show the Client's 
logged-on user name, IP address, operating system, enclosure 
type and location by right-clicking the Client name.  
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Note: Changing the Client display options here will also change 
them on the quick access bar, connected Clients list on the 
status bar and when zooming into thumbnails. 

 
The following options are available: 

 

 Show or hide the ribbon. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee, 
Technical Support and compression information. 

 
The ribbon 
A range of tools is available via the ribbon, enabling you, for 

example, to clear the output window and change the displayed 
font. 
 
Output/results pane  

Shows the results of the command that has been run at the 
Client. 
 

Input pane 
This is where you enter the commands to run at the Client and 
can be resized if required. While the window is open, each 
command is stored by the Control -enabling you to recall previous 
instructions that you may wish to run again. Either scroll through 
the entries using the up and down arrow keys and press Enter 

when the required command is displayed or press F7 to show all 

commands in a window. Click on the required command and press 
Enter. 

 
A maximum of 50 commands is stored. To clear the history, press 
F8. Once the Control closes the Remote Command window the 
history is cleared automatically. 

 
Status bar 
The status bar shows the number of connected Clients. You can 
see a list of all connected Clients by clicking Connected (clicking 

a Client name opens a Remote Command Prompt window for 
them). Right-click to choose how the Client is displayed in the list. 
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PowerShell window 

A PowerShell window can be launched, allowing a Control to execute 
PowerShell commands at Clients. 

 

Note: PowerShell will not be available for Clients running versions 
prior to NetSupport Manager 12.50. 

 
1. Connect to the required Clients. 

2. Select the Home or Remote tab in the ribbon and click 

PowerShell. 
Or 
If launching a PowerShell at an individual Client, right-click the 
Client icon and select PowerShell or select the tab displaying the 
Client's name in the ribbon and click PowerShell. 
Or 
If launching a PowerShell at a group of Clients, select the 

required group in the Tree view and click PowerShell in the 
Group tab in the ribbon or right-click the group and select 

PowerShell. 
3. The PowerShell window will appear.  

 

The window is divided into the following sections: 

 
The caption bar 
The caption bar shows the name of the Client the PowerShell 

window is open for (or the currently selected Client if the 
PowerShell is for multiple Clients). Clicking the Client name brings 
up a Remote Management pane, and from here, you can see 

details of the Client and perform a variety of functions.  
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By default, the Client name, wireless and battery indicators (if 

applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed on the caption bar. You can 
customise what is displayed and choose to show the Client's 
logged-on user name, IP address, operating system, enclosure 
type and location by right-clicking the Client name.  
 

Note: Changing the Client display options here will also change 
them on the quick access bar, connected Clients list on 

the status bar and when zooming into thumbnails. 

 
The following options are available: 
 

 Show or hide the ribbon. 

 
Shows how many windows are open. From here, you 
can access the Window menu. 

 
Access the online help and version number, licensee, 
Technical Support and compression information. 

 
The ribbon 
A range of tools is available via the ribbon, enabling you, for 

example, to change the displayed font. If the PowerShell is 
launched at multiple Clients, they will be listed in the Clients 
pane, allowing you to easily access the required Client session. 

 
When a PowerShell is launched at multiple Clients, if any sessions 
report an error or there are any differences between them, you 

will be notified in the Errors and Differences sections in the 

ribbon. An indicator will appear advising how many errors or 
differences there are and you can scroll through these and clear 
them when required. 

 
Input/output pane 
This is where you enter the commands to run at the Client(s) and 

the results are displayed. 
 

While the window is open, each command is stored by the Control 
- enabling you to recall previous instructions that you may wish 

to run again. Either scroll through the entries using the up and 
down arrow keys and press Enter when the required command is 
displayed or press F7 to show all commands in a window. Click 

on the required command and press Enter. 
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Status bar 

The status bar shows the number of connected Clients and any 
errors or differences between multiple Client sessions. You can 
see a list of all connected Clients by clicking Connected (clicking 
a Client name opens a PowerShell window for them). Right-click 
to choose how the Client is displayed in the list. 
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Using the Client 
 
In this chapter … 
 

How the remote user can interact with a connected Control. 
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The Client Information window 

When a Client double clicks the NetSupport Manager Client icon in 
their system tray, the Client Information window appears.   

 
The Client Information window has three modes: full screen, small 
screen and connected. 
 
Full screen 

 

The Client is provided with an overview of their system and user 
details and the NetSupport Manager licence details. From here, the 
Client can: 

 
• Create or enter a PIN code 
• View Replay Files that are stored on the Client computer 
• View an inventory of the Client 
• Request help from the Control.  

 

Small screen 
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If the Client does not wish to view all their system information and 

licence details, they can click the  icon at the bottom of the window 
to switch to small screen mode. The Client will still be able to create 
and enter a PIN code, view Replay Files and inventory and request 

help from the Control. Click the  icon to switch back to full screen 
mode. 

 
Connected  

 

This mode will be displayed when a Control is connected to a Client. 
From here, the Client can see details of the Control that is connected 
to them. They also have the option to disconnect from the Control or 

chat with the Control. 

 

Note:  You can configure the items that are displayed in the Client 
Information window in the Client settings section of the 
NetSupport Manager Client Configurator. 
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Disconnecting from a Control 

When a Control is connected to a Client, the Client can choose to 
disconnect. 
 

Note: This option can be disabled at the Client in the Client settings 
section of the NetSupport Manager Client Configurator. 

 
To disconnect from a Control 

1. Double-click the NetSupport Manager Client icon in the system 
tray. 

2. The Client Information window will appear. 
3. Click the Disconnect icon. 
4. A dialog box will appear, listing the Controls to which you are 

currently connected. 
5. Select the Control(s) from which you want to disconnect.  

6. Choose OK to disconnect from the selected Control. 
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Raising a help request 

NetSupport Manager allows a user at a Client workstation to request 
help from a designated Control workstation.  
 

To request help at the Client 
1. Double-click the NetSupport Manager Client icon in the system 

tray and click Request Help. 
Or 
Press the hotkeys, usually ALT+LSHIFT+RSHIFT. 

2. This opens the Request Help dialog into which Clients type their 
name and help request message. 

3. Clients can also choose to cancel their previous help request by 
clicking Cancel Previous Request. 

4. Clients then click OK.  
 

If a Control is connected when a Client sends a help request, the Help 
Request folder will be highlighted, notifying the Control. If the Control 
is not connected, its Help Request folder will be highlighted the next 
time it connects to that Client. 

 

Chatting to a Control workstation 

When a Client is connected to a Control, they can initiate a chat 
session. 
  
To initiate a Chat session 
1. Double-click the NetSupport Manager Client icon in the system 

tray. 
2. The Client Information window will appear. 

3. Click the Chat icon. 
4. The Chat window will appear. 
5. Type the message and press Enter or click Send. 
6. If you need to alert the Control user that you have initiated a 

Chat session, choose {Chat}{Send Beep} from the Chat window 

drop-down menu. 
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Receiving messages from a Control workstation 

Client workstations can receive messages from Control workstations. 
These messages are automatically displayed on a Client’s screen in a 
message box.  

 

The message box’s title bar includes the name of the Control that has 

sent the message, along with the date and time the message was 

sent.  
 
Having read the message sent by a Control, click OK to remove the 
message.  
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Configuring the Client 
 
In this chapter … 
 

How to use the Client Configurator. 

 

Whether you want to secure the Client against unwanted 

connections or prevent Control users from performing certain 

tasks at selected Clients, NetSupport Manager provides a vast 

range of configuration options that can be set at individual 

Client level.  
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Configuring the Client 

NetSupport Manager Clients are configured using the NetSupport 
Configurator. This makes all the required changes to and sets up the 

initialisation commands. 
 
The configurator is started from the NetSupport Configurator icon in 
the NetSupport Manager Program group. This will display the initial 
Client Configuration dialog. 
 

You can also load the configurator from the command line by entering 
the appropriate parameters. For example, “c:\program 
files\netsupport\netsupport manager\pcicfgui.exe. If NetSupport 
School components have been installed, you can load the NetSupport 
School Client Configurator by entering, “c:\program files\netsupport\ 
netsupport manager\pcicfgui.exe” /s. 
 

Note: When performing a custom installation, the Configurator 
component must have been selected for this option to be 
available. 

 
The Client Configurator enables you to set all the possible options for 
the Client. It also enables you to test the network to ensure that the 
network stack that you are attaching the Client to is installed and 

operating correctly. 
 
You can run the configurator in two modes, basic or advanced. Some 
of the options are accessible in both modes. 
 

Basic Client configuration 

Basic configuration is used for standard settings such as the Client 
name, the transports that it will use and simple security such as a 
password before a Control will be allowed to connect to the Client. 
 

Note: Basic Client configurations can also be set as part of the 
NetSupport Manager installation process. 

  

Choose this option if:  
• You are using the Client Configurator for the first time. 

• You only wish to set simple security and configuration options. 
• You do not need to create multiple profiles for different Control 

users who might connect to this workstation. 
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Note: Do not use the Basic option if you have set up multiple 
profiles using the Advanced option, as this will also change 
the master profile in the Advanced Configuration. 

 
Advanced Client configuration 
The Advanced option provides access to NetSupport Manager’s 
wealth of configuration and security options. It lets you tailor the 

response of the Client to different Control users who may access the 
workstation and provides links to areas such as NT Security. 

 

Note: When performing a custom installation, the Configurator 
component must have been selected for this option to be 
available. 

 

Choose this option if:  
• You are an experienced user. 
• You need the Client to react differently depending on which 

Control user is connecting. 
• You wish to enable/disable individual features. 

• You want to link to NT Security. 
• You want to restrict a Control user’s access to specific drives, 

folders or files. 
 

Note: Any changes you make to the master profile in the Advanced 
option will overwrite any setting that you have made using 

the Basic option. 
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Editing or creating configuration files 

Choosing the Advanced option from the Client Configurator creates 
configuration files. This will display the Advanced Configuration 

window. 
 
The default configuration file is called Client32u.ini and is stored in 
the NetSupport Manager installation directory of the Client 
workstation. You can use either this file or a different file on a server 
to which the Client has access. 

 

Notes:  
• The default configuration file for Clients pre-v12.50 is called 

Client32.ini. 

• Once created, a configuration file can also be remotely deployed 
to multiple Client machines simultaneously using the NetSupport 
Manager Deploy utility.  

 

To create a new configuration file 
1. Choose NetSupport Manager Configurator from the 

NetSupport Manager Program group. The NetSupport Manager 
Client Configurator will appear. 

 

2. Choose Advanced. The NetSupport Manager Client Configurator 
will appear. 
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. 

3. Choose {File}{New} from the Advanced Configuration window 
drop-down menu. 

4. A new file will be created with a default master profile. 

 
To open the default or an existing configuration file 
1. Choose {File}{Open} from the Advanced Configuration window 

drop-down menu. 
2. Select the configuration file you want and click Open. 
 

To set the configuration file the Client will use 
The configuration file that the Client uses when it initialises can be on 
the same workstation or on another workstation or server to which 
that workstation has access. Multiple Clients can share the same 

configuration file for ease of administration. The configuration file to 
use is set by choosing {Profiles}{Client Parameters} from the 
Advanced Configuration drop-down menu. 
 

To set the Client name 
1. Choose {Profiles}{Client Parameters} and insert a Client name. 
 

Note: The Client name is separate from the configuration file and is 
stored on the local workstation. Make sure that you do not 
choose the same Client name as is used on another 

workstation. Setting the Client name to be an asterisk is a 
useful strategy, as the Client name will then be set to be the 
same as the computer name. The computer name should 
always be unique. 
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To create a new profile 

1. Open or create the configuration file you want to use. 
2. Choose {Profile}{Add} from the Advanced Configuration window 

drop-down menu. 
3. Enter the name for the profile. 
 

Note: You can combine profiles from other configuration files by 
choosing the Include File option. This is useful where you 
are using configuration files on the local workstation but want 

to include information stored on a central configuration file or 
vice versa. For example, if the local workstation was using a 

different NetBIOS adapter number. Each profile contains a 
number of property sheets where the actual parameters are 
set. 

 

To edit an existing profile 
1. Open or create the configuration file you want the Client to use. 
2. Select the profile you want to edit. 
3. Choose {Profile}{Edit} from the Advanced Configuration window 

drop-down menu. 
4. Edit the profile.  
 

Note: If you leave the checkboxes greyed, the settings from the 
master profile will be used. 
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Basic Client configuration 

For use in a simple environment where you do not require the Client 
to react differently according to the Control user connecting to it and 
do not need to enable/disable individual functions. 
 

To open the Basic Client Configurator 
1. Open your NetSupport Manager Program folder by choosing 

{Start}{Programs}{NetSupport Manager}{NetSupport Manager 
Configurator}.  

Or 

Double click the Configurator icon in the NetSupport Manager 
group.  

2. Select Basic. The Basic Client Configurator covers three areas: 

• Connectivity  
• Security  
• Audio  
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Advanced Client configuration 

The NetSupport Manager Client is exceptionally configurable and 
supports the ability to set differing levels of security and response 
according to the identity of the Control user that is connecting. This is 
achieved by the use of configuration files at the Client, which 

determine the appropriate level of access for each Control user by 
means of a profile. 

Configuration file 

A configuration file is a text file consisting of sections called profiles. 
 
You can specify the configuration file that the Client will use when it 
initialises. The configuration files themselves are stored in a check-
summed file, normally Client32u.ini. 
 

Note: Clients pre-v12.50 will use a configuration file called 
Client32.ini. 

 
This file can be either on the Client workstation or on another 

workstation (such as a server) to which the Client workstation has 
access. You can even set the Client to use a fallback configuration file 

if the server is unavailable. 
 
Profile 
A profile is a set of parameters that determines how the Client will 
respond to a particular Control user and what functionality it will 
allow that Control user to have. 
 

For example, one Control user may be allowed to view the Client in 

watch-only mode, while another may be allowed full functionality, 
including File Transfer. You can even set up the profile to pre-
determine exactly what file access a Control user will have. 
 
A profile set at the Client overrides a profile set at the Control. 
Security is, therefore, always ensured. 

 
When connecting to a profiled Client, the Control user will be 
prompted for a user ID and a password. The NetSupport Manager 

Client will then interrogate the first matching profile in its current 
configuration file to determine what level of functionality has been 
assigned to that Control user. 
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Master profile 

Each configuration file must contain a master profile. This is the 
standard profile and is the one used if you only set a basic 
configuration. Whatever is set here will, by default, apply to all other 
profiles you create. 
 
However, you can then amend those profiles to enable or disable 

particular features for Control users whose user ID and password 
match those set in the profile. 

 
As the master profile is the first one that the Client checks, you 
should always set maximum security features here to avoid leaving a 
security back door open. 
 

The master profile is also used for setting a number of global 
parameters that apply across all individual profiles. 
 
Individual profile 
An individual profile allows you to enable or disable individual 

features for a particular Control user or group of Control users. When 
they connect, the Client will prompt them for a user name and 

password. It will then search its internal profiles until it finds a match 
and then apply the settings to the subsequent Control session. 
 

Note: For further information on creating and applying profiles, click 
here. 

 

The advanced Client Configurator covers seven areas: 
 

• Connectivity 
• Security 
• Remote Control 
• Client Interface 
• Profile Options 

• Terminal Services 
• Advanced 
 

Note: A search bar is provided at the top of the window, allowing you 
to locate the settings you're looking for. Type in the search 

bar (you can enter a full or partial term) and click . Any 
sections containing the search term will be highlighted. Click 

 to close the search. 

 
 

https://kb.netsupportsoftware.com/knowledge-base/creating-multiple-client-profiles-within-netsupport-manager/
https://kb.netsupportsoftware.com/knowledge-base/creating-multiple-client-profiles-within-netsupport-manager/
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Connectivity options  

The Connectivity options are used to set which protocols the 
transport will allow a Control to connect to it by. The NetSupport 

Manager Client supports multiple protocols meaning that you can set 
it to respond to NetSupport Manager Controls whether they are 
talking over TCP/IP, IPX or NetBIOS. You can also configure the Client 
for remote communication via a modem or establish a connection 
through a NetSupport Gateway. The Gateway provides a method for 
connecting via HTTP and delivers web-based remote control without 

the need for modifications to existing Firewall configurations. You can 
also configure the Client to use the PIN Server, enabling you to 
connect to Clients using the PIN Connect feature. 
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Set TCP/IP connection 

 

Use TCP/IP 
Check this option if you wish the Client to be able to communicate 
over TCP/IP. 
 
Port 
The TCP/IP protocol requires that a port number be allocated for 

applications to communicate through. To enable the Control to 

communicate with a Client and for the Client to receive the incoming 
request, the default registered port for NetSupport Manager is 5405. 
 
Select IP Address to Listen on: 
This option can prove useful for preventing unwanted connections 
when the Client has multiple network cards installed, for example, 
when both a public and private network are used. You can force 

connections on the required network by specifying the IP address that 
the Client uses to listen for incoming Control connections.  

 
Multicast address: 
This is the IP multicast address that the Client is listening on. 
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Click Test to check that the protocol is correctly installed on this 

workstation. 
 

Notes: 
• Changing the port could interfere with other TCP/IP applications. 

• If you are using routers, you must ensure that they are 
configured to pass through data using this port. 

• To enable Clients to initiate a connection to the Control, the 
default registered port is 5421.  

 
Set IPX connection 

 
 
Use IPX 
Check this option if you wish the Client to be able to communicate 

over IPX/SPX.  
 

Click Test to check that the protocol is correctly installed on this 
workstation. 
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Set NetBIOS connection  

 

Use NetBIOS 
Select this option if you wish the Client to be able to communicate 
over NetBIOS/NetBEUI. If you are using NetBIOS, you must also 
select a NetBIOS adapter number.  

 
Click Test to check that the protocol is correctly installed on this 
workstation. 
 
Adapters (select one or more) 
As you can have more than one NetBIOS stack loaded, Windows uses 
the concept of adapter numbers. Each stack is allocated an adapter 

number by the operating system. So, for example, NetBEUI may be 
allocated adapter 1, NetBIOS over TCP, adapter 2 and so on. 

 

By default, the Client uses adapter number 0. Depending on how your 
network is configured, this may not be the correct adapter number 
for your workstation. To overcome this, you must select the required 
stack from the list. 
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Note: NetSupport Manager allows you to select multiple NetBIOS 
adapters. Make sure only the ones you want are selected. If 
changing the selected adapter, you must first deselect the 
existing or default adapter number. 

 
Set HTTP connection  

This option enables you to configure the Client to accept connections 
via a NetSupport Gateway. (For more information see, Connecting to 

Clients/Controls via a NetSupport Gateway) 

 

Use HTTP/HTTPS:  
Check this option to enable the Client to communicate over HTTP. 
 
Require HTTPS 
Select this option to require a secure connection over HTTPS. The 

Gateway must have an SSL/TLS certificate and a public DNS name. 
 

Note: You can apply an SSL/TLS certificate at the Gateway in the 
NetSupport Connectivity Server utility - Security tab. 
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Gateway Address: 

Enter the IP address of the workstation where the NetSupport 
Gateway component is installed. 
 
Secondary Gateway (optional): 
If required, enter the IP address of the secondary Gateway. 
 

Port: 
NetSupport Manager’s default port for HTTP communications is 443. 

 

Note: In version 9.10, port 443 was introduced as the default for 
HTTP communications, 3085 being used previously. Gateway 
settings will be preserved for existing customers who 

subsequently upgrade, enabling 3085 to continue to be used, 
but there may be scenarios when upgraded Controls and 
Clients will need the HTTP port manually reconfiguring to 
ensure operability. 

 
Gateway Key:  

The key set here must also be set at the Control and match the key 
that has been configured in the Gateway itself. This provides 
additional security that enables Control users to connect only if they 
have specified the same key as at the Client. 

 
CMPI (secs): 
You can override the CMPI that is set at a Gateway by entering a 
value here. By default, the CMPI is set to 60 secs at the Gateway. 
 
Use a proxy server to connect to the Gateway 

NetSupport Manager can be configured to route communications 

through a proxy server if required. Enter the server address and an 
appropriate port, 8080 recommended.  
 

Note: This option only applies to Windows 8 machines and earlier. 
Windows 8.1 and above machines use automatic proxy 
configured in Windows Settings. 
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PIN Server 

Configure the PIN Server so Clients can connect using the PIN 
Connect feature. 

 

PIN Server 

PIN Server Address 

Enter the IP address of the workstation where the PIN Server is 
installed. 
 
Port  
The default port number for the PIN Server is 443. 

 
Use a proxy server to connect to the PIN Server (Windows 8.0 
and earlier) 
Select this option if you are using a proxy server to connect to the 
PIN Server. Enter the server address and port number for the proxy 

server.  
 

Note: This option only applies to Windows 8 machines and earlier. 
Windows 8.1 and above machines use automatic proxy 
configured in Windows Settings. 
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Copy settings from Gateway 

If you are using a NetSupport Gateway, you can use the same 
settings for the PIN Server. Select Copy and the Gateway address 
and port will be used. 
 

Dial in Bridge settings  

This option is used to set up dial-in NetSupport Manager links either 
to this workstation or to any NetSupport Manager Client on the same 
LAN as this one. 

  

Protocol 
By default, NetSupport Manager is set to have no transport for the 

Bridge selected. Choose to use NetBIOS, IPX or TCP/IP protocols for 
NetSupport Manager Bridge. 
 
Bridge Options 

Load Bridge on Startup 
Setting this option will cause the NetSupport Manager Bridge to 

initialise when the Client loads. If you do not set it, then the user at 
the Client must load it manually from the menu on the NetSupport 
Manager Client before dial-in access will be available. 
 



NetSupport Manager v14.00 

 

 222 

Inactivity Timeout 

Specify, in minutes, a maximum time span of inactivity at the Bridge 
before the Control disconnects. 
 
Dialback File 
You can set up the Bridge to support both passwords and dial-back 
with the additional functionality of dialling back different telephone 

numbers according to the password. 
 

Modem/ISDN 
You must select a modem from the list of modems installed in the 
Control Panel of the workstation for the Bridge to use. 
 
Dual Channel Bonding  

If enabled, both channels of your ISDN line are combined, thus 
increasing the amount of available bandwidth to 128k. However, in 
increasing the speed of transmission, you are, in effect, making two 
calls.  
 

MSN (Multiple Subscriber Number) 
Specify a number that you want the Bridge to accept incoming 

connections from. Depending on the channels in use, you need only 
specify the trailing digit(s). For example, if the ISDN lines in use are 
0181 123456 and 0181 123457, specify 6 or 7. 
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Advanced setting 

 

Tickle period 

While a Control is connected, the Client sends tickle packets to the 
Control to verify that it is still “alive”. You can disable tickle packets 

for ISDN links but be aware that the Client may not detect that the 
Control has disconnected unexpectedly. 
 
The normal period between tickle packets is 18 seconds but you can 
increase or decrease this value. Setting this to zero disables tickle 

packets entirely. 
 
Auto configure for XP SP2 firewall 
Enabled by default, this ensures that the NetSupport Manager Control 
and Client continue to function for those users who are using XP 

Service Pack 2. 
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Security options  

These options are used to set security at the Client. 

General settings 

These are used to set passwords to protect the Client configuration 
and to prevent unauthorised access to the Client. 

 

Identification 

Client Name 

Each NetSupport Manager Client on the network requires a unique 
name. You can either set a name of your own choosing or use an 
asterisk to default the Client name to be the same as the workstation 
name. 
 
You need to be logged in as an administrator to change the Client 

name. 
 

Notes: 
• If setting the Client name in Advanced Configuration, choose 

{Profiles}{Client Parameters} from the Advanced Configuration 
window drop-down menu. 

• For NetSupport Manager’s Integration with Explorer feature to 
work, the Client name must remain set to the default machine 
name. 
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Configurator Password 

As an extra level of security, you can associate a password with a 
configuration file. This prevents unauthorised amendment of this 
Client’s configuration. When the Configurator is next started, the user 
must enter the required password before being able to change any 
Client parameters in this configuration file. Choose Set to set your 
password. 

 
Client Password 

This helps to protect the Client from unauthorised access from a 
NetSupport Manager Control. The Control user will be required to 
enter the password before obtaining access to the Client. 
 
Client Security Key 

Provides additional security that enables Control users to connect 
only if the Control has the same security key as the Client. Optionally, 
this can be set as the serial number. You must set the security key at 
both the Client and the Control. 
 

Quiet Mode (Client not visible on taskbar) 
Hides the Client icon on the taskbar. 
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Access Privileges (basic) 

This option can be used to limit the range of remote control options 
that are available to the Control user. 

 

User Acknowledgement Required 
Prevents access to the Client unless a user is present. The user at the 

Client will have to accept the request to connect before access is 
granted. 

 

Note: To enhance security, from NetSupport Manager version 14.02, 
user acknowledgement is enabled by default on all new 

installations. If you are upgrading to version 14.02, your 
previous settings will apply. 

 

Disable File Transfer 
This prevents a Control user from being able to transfer files to and 

from the Client. The Control user will not be able to copy, view or 
otherwise manipulate files on the Client using the NetSupport 
Manager Control File Transfer options. 
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Disable Execute 

This prevents a Control user from remotely executing applications at 
the Client from within the Control program. They can still start 
applications on the Client while remote controlling the workstation. 
 
Disable Remote Registry Access 
Stops a Control user from remotely managing and editing the registry 

of Clients. 
 

Watch Only 
Enables the Control user to be able to view the screen of the Client 
workstation but prevents them from being able to enter keystrokes or 
mouse movements. 
 

Disable Receive Show 
Prevents the Client workstation from being able to display a Show 
sent by a NetSupport Manager Control. 
 
Disable Remote Reboot  

This prevents a Control user from being able to reboot the Client 
remotely. 
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Access Privileges (advanced)  

This option can be used to limit the range of remote control options 
that is available to the Control user. 

 

Disable Watch 

Prevents a Control from viewing the Client. File Transfer, scripting 

and other functions are still available. 
 

Disable Share 
Allows a Control to view a Client in Watch-only mode. 

 

Disable Control 
Prevents a Control from being able to lock out the Client’s keyboard 
and mouse. 

 
Disable File Transfer 

Disables File Transfer to and from the Client in all circumstances. 
 
Disable Execute 
This prevents a Control user from remotely executing applications at 
the Client from within the Control program. They can still start 

applications using the standard remote control functions. 
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Disable Reboot 

Disables the ability of the Control user to reboot the Client 
workstation from within the Control window. You can still reboot while 
remote controlling. 
 
Disable Shutdown Client 
Prevents the user at the Control from being able to shut down the 

Client program from a script.  
 

Disable Chat 
Prevents the Control from initiating a Chat session with the Client. 
However, Clients can still open a Chat session with the Control via the 
Client. 
 

Disable File Transfer when no User is Logged on 
Disables File Transfer when no user is logged on. This means that the 
Control user would have to log on with their own user ID if they have 
a valid user ID and password for this workstation to use File Transfer. 
 

Disable Remote Command Prompt 
Prevents the Control from being able to run command line 

instructions at the Client. 
 
Disable PowerShell 
Prevents the Control from being able to open a PowerShell session at 
the Client. 
 

Disable Blank Screen 
Prevents the Control user from being able to blank the Client screen. 

 

Note: This feature is only available on Clients running Windows 10 
v2004 and above (legacy support is provided for Clients 
running Windows 8 and below). 

 

Disable Ctl+Alt+Del 
Ignore Ctrl+Alt+Delete sent from the menu option in the Control 
interface. 
 
Disable Logoff 

Prevents the Control user from being able to log off from the Client 
workstation via the Logout option in the Control window. You can 

still log off while remote controlling. 
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Disable Clipboard Access 

Prevents the Control user from being able to use the remote 
clipboard.  
 
Ignore Messages 
Ignores messages sent by connected Controls. 
 

Ignore Broadcast Messages 
Ignores broadcast messages from a Control, whether connected or 

not. 
 
Disable Print Capture 
Prevents the Control user from being able to use NetSupport 
Manager’s printer re-direction function.  

 
Disable Registry Access 
The Script function and later versions of NetSupport Manager include 
a function to enable a Control user to remotely manage and edit the 
Registry on NetSupport Manager Clients. Setting this option will 

disable that function. 
 

Task Manager 
These options are disabled by default; clear the checkboxes to enable 
them. If enabled, the following tasks can be performed when the 
Task Manager is open for a selected Client. 
 
Disable Close Applications 

If checked, prevents the Control from being able to close a currently 
running application or process.  

 
Disable Service Management 
If checked, prevents the Control from being able to stop or start a 
service at the Client machine. 
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User Validation 

 

Usernames 
User names are used for setting the valid user ID and password for 

Control users when they connect to the Client. The user ID is also 
used to determine which Client profile will be applied. 
 

You can enter multiple user names, each with its own password. You 
do this by clicking on Change and adding the individual user names 
and passwords. 
 

By entering specific user names and passwords, the Client will restrict 
access to Controls entering a matching user name and password 
when connecting. 
 

Notes:  
• If this is an NT workstation and you have elected to use the NT 

Security option to validate the Control user’s ID and password, 
then you do not need to specify the user name and password. 
However, you may still wish to set this option to provide an 
additional filter when using NT security validation to restrict 

access to particular NT users and determine which Client profile 
they will use. 
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• Rather than continually prompt the Control user for a user name, 

a default ID can be set in the Control Configuration - General 
settings. 

 

NT Options 
Authenticate User and Password with NT 
This only applies to NT Clients. If this option is set, then the user ID 
and password entered at the Control must be a valid NT ID on the 
Client workstation or its default domain. 

 
Restrict Access to members of the following groups 

You can further restrict access by specifying groups. Click on Browse 
to select a group(s). 
 
Enable Smartcard Authentication 
If this option is selected, then the Control will be required to enter a 
user ID and password as well as the smartcard and pin to connect to 

the Client. 
 

Active Directory Options  
Authenticate user and password with Active Directory 
If in use, you can configure the Client to validate a user connection 
against members of the groups defined within Active Directory. A 
connecting Control will be prompted for their user ID and password, 

which will be validated against the Active Directory. 
 
Restrict Access to Members of the following Groups: 
As an additional level of security, you can restrict access to members 
of specified groups.  

 
RADIUS 

You can configure the Client to validate a user connection with 
RADIUS. Once enabled, when a Control connects to the Client, the 
connection will be validated using the method set in RADIUS. 
 

Note: RADIUS authentication can be used over TCP/IP and 
HTTP/HTTPS communications. 

 
Authenticate using RADIUS 

Enable RADIUS authentication. 
 
Server address 

Enter the fully qualified domain name (FQDN) or IP address for your 

RADIUS server. 
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Port 

The default port for RADIUS is 1812. 
 
Secret 
Enter your RADIUS secret key. 
 
Always Prompt for Username and Password 

If checked, the Control will be prompted for a user name and 
password each time it attempts to connect to the Client.  
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User Acknowledgement options 

These security options display a prompt at the Client machine 
advising that a Control user is attempting a remote connection. The 
Client must acknowledge the message before a remote control 

session can be instigated. 
 

Note: To enhance security, from NetSupport Manager version 14.02, 
user acknowledgement is enabled by default on all new 

installations. If you are upgrading to version 14.02, your 

previous settings will apply. 

  

User Acknowledgement 
User Acknowledgement Required  

When a Control user attempts to connect, a message will be 
displayed at the Client. Unless the user at the Client explicitly accepts 
the request, the connection will be refused. 
 

Except when no User Logged On 
Only applies when user acknowledgement has been set. This means 
that the Client can be configured to allow remote control when the 

workstation is at the login screen. The Control user would have to 
have a valid ID and password to be able to log in. 
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Except when connecting as current logged on user 

This enables you to bypass user acknowledgement if the remote 
connection is being made using the user name/password of the 
currently logged-on user. For example, if a user locks his office 
workstation at the end of the day, they can then connect to it from 
home without having to physically accept the connection at the 
remote machine. User validation must be set to allow connection. 

 
Acknowledge Connection Attempts from other Controls 

The Client receives a message that another Control is attempting to 
connect. 
 

Note: For the message to be displayed at the Client, the Allow more 
than one Control to Connect at a time option must be 
enabled in Client Configuration – Security Connect. 

 
Acknowledge Connection Display Text:  
Specify a customised acknowledgement message to be displayed at 
the Client workstation. The text can also incorporate a choice of 

default settings should you wish the Client to know, for example, the 
name of the Control user. There are four available syntaxes: 

 
$loginname$ Returns the logged-on user name of the user at 

the Control. 

$fullname$ Returns the full name of the logged-on user at 
the Control. 

$computername$ Returns the machine name of the Control. 

$userdomain$ Returns the domain of the logged-on user at the 

Control machine. 
 

Note: The standard NetSupport Manager graphic in the User 
Acknowledgement dialog can be replaced with a customised 
graphic by placing an icon file with the name helpdesk.ico in 
the installed directory for the product on the Client machine. 

 
Acknowledge Connection Timeout:  
Specify a time limit, between 0-255 seconds, for the user 
acknowledgement prompt to be displayed and decide what action to 

take if the user has not acknowledged the connection after the 
specified time. You can choose Reject Connection to cancel the 
connection attempt or Accept Connection to allow the Control to 

connect. 
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This can be useful if there is an urgent need for the Control to 

connect, but they want to allow the remote user a few seconds to 
complete a task or close down files. 
 
View Acknowledgement 
Acknowledge switching to xxxxx view mode or higher. 
Displays a prompt at the Client machine if, while being viewed, the 

Control user wishes to switch to a higher View mode. For example, if 
the level is set to Control, the prompt will appear if the mode is 

changed from Share or Watch. The Client can choose to accept or 
reject the change. 

 

Enable Smartcard logon 

Enabling this option at the Client allows a Control to log on to Client 
machines that use smartcard authentication. 

 

Smartcard support is automatic and no additional installation is 
required. Support is dynamically loaded at the Client when a Control 
connection is made. When loaded, an additional hardware device will 
be available called NSL Pseudo Smartcard Reader. 
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When the Control opens a window to the connected Client, they will 

need to insert their own smartcard into the reader attached at the 
Control and enter the Client’s PIN to log on to the remote user’s 
machine. 
 
If multiple Client View windows are open at the Control, smartcard 
insertion and removal events are sent to the Client currently in focus.  

 

Note: In an Active Directory environment, it is possible to enable 

smartcard support using the NetSupport Manager ADM 
Template.  

 

Connect options 

This option is used to administer which Control users or Control 
workstations can connect to this Client. You can also set the level of 
encryption to be used. 

 

Security Key  
Provides additional security that enables Control users to connect 
only if the Control has the same security key as the Client. Optionally, 

this can be set as the serial number in your NetSupport Manager 
Licence file. You must set the security key at both the Control and 
Client. 
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Allow Connections from these Control Machines 

This enables you to restrict access to Controls running on IPX, TCP/IP 
networks or over HTTP. This feature can also be used to limit access 
to Control workstations with specific addresses. Wildcards can be 
used in the address field.  
 
For example: 

194.182.*.* all workstations on TCP/IP subnet 194, 182 
00000001-* all workstations on IPX network 1 

 

Note: Access can also be limited to a specific IP range, e.g. 10.0.0.1-
24 would allow access from 10.0.0.1 up to 10.0.0.24. 

 
Set Minimum level of Encryption 

With encryption turned on, all the information that is sent between 
the Control and Client is very difficult for others to read. NetSupport 
Manager offers a range of encryption options, ranging from 56 bit 
DES to 256 bit AES, enabling you to find the necessary balance 
between security and performance. The higher the level of 

encryption, the higher the potential for decreased performance. 
 

Choose the level of encryption to be used while a Control is 
connected. By default, encryption is set to none for all connections 
and 56 bit DES for HTTP connections. 
 
Disable encryption for file transfer from Control for better 
performance 

By default, NetSupport Manager encrypts file transfers from the 
Control to the Client. Selecting this option disables encryption and 

improves performance. 
 
Allow more than one Control to connect at a time 
NetSupport Manager allows multiple Controls to connect and view the 
Client simultaneously. This is useful for group working. Checking this 

option enables the function. 
 
Advanced Connection Security (Only v12.50 Controls or later 
can connect) 
As an added security measure from version 12.50, Clients can 

challenge Controls that make a connection attempt and only Controls 
running version 12.50 and above will be able to connect. Selecting 

this option will reject connections from Controls running earlier 
versions of NetSupport Manager. 
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Disconnect options 

The options here provide additional security when a Control user 
disconnects from the Client machine. This is useful if the connection 
to the Client is unexpectedly lost. 

 

Lock the Workstation if not initially logged on – NT only 
When the Control user disconnects, the workstation will be locked. 
The Control user will be able to reconnect and unlock the workstation. 
This option is useful if the Control unexpectedly loses the connection. 

It prevents a user at the workstation inheriting the Control user’s 
rights (assuming they have logged in as an Administrator, for 
example). This only applies if the workstation was logged off when 
the Control was connected. 
 

Logoff if not initially logged on 
When the Control user disconnects, the workstation will be 

automatically logged off. This only applies if the workstation was 
logged off when the Control connected. 
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Restart if not initially logged on 

When the Control user disconnects, the workstation will be 
automatically restarted. This only applies if the workstation was 
logged off when the Control connected. 
 
Logoff if user has changed 
If a Control needs to log on to a Client workstation under a different 

name to the user, for example, as an Administrator, it prevents the 
user from inheriting the Control user’s rights should the connection 

be unexpectedly lost. 
 
Disconnect Display Text 
Specify a customised message to be displayed at the Client 
workstation when a Control disconnects. The text can also 

incorporate a choice of default parameters should you wish the Client 
to know, for example, the name of the Control user. The available 
options are: 
 
$loginname$ Returns the logged-on user name of the user 

at the Control. 

$fullname$ Returns the full name of the logged-on user 

at the Control. 

$computername$ Returns the machine name of the Control. 

$userdomain$ Returns the domain of the logged-on user at 
the Control machine. 
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Protect Configuration settings 

This option allows you to protect the Client configurations. 

  

Configurator Password 
Nominate a security password for the Client profile. 

 
Authenticate User and Password with NT 
This only applies to NT Clients and therefore only protects Client 
Configurators on NT workstations. If this option is set, the user ID 
and password entered at the Control must be a valid “Act as part of 

the Operating System” NT ID on the Client workstation or its default 
domain. This user right is not granted by NT as default. 
 
To grant this user right 
1. Run {Programs}{Administrative Tools}{User Manager}. 

2. Select {Policies}{User Rights} from the drop-down menu.  

3. Check the Show Advanced User Rights checkbox. 
4. Select the right. 
5. Click Add. 
6. Select which users and/or groups this right should be granted. 
7. Click OK. 
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8. For this user right to be recognised, you must re-log into your 

workstation. 
 

Note: You can also point the Client to validate the ID in another 
domain.  

 
Restrict Access to Members of the following Groups 

You can further restrict access by specifying groups. Click Browse to 
select a group(s). 

 

File Transfer settings 

This option is used to control file access. 

 

Disable File Transfer  

Disables File Transfer to and from the Client in all circumstances. 
 
Disable File Transfer when no User is Logged On 
Disables File Transfer only if no user is logged on. This means that 
the Control user could log on as themselves if they have a valid user 
ID and password for this workstation. 
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Impersonate Logged on User when Transferring Files 

When using NetSupport Manager File Transfer, the Control user will 
have the same file access as the logged-on user. 
 
Impersonate Logged on User for Network Drives 
The Control user will have the same access to network drives as the 
logged-on user. 

 
Access Rights to Files and Directories 

This is used to explicitly allow or deny access to individual drives, 
directories and files. This only applies to File Transfer within 
NetSupport Manager. 
 
It is hierarchical, so you could, for example, disable access to drive 

C:\ in general but explicitly grant access to sub-folders.  
 

Note: Any access rights set in the master profile apply to all profiles 
unless overridden. 

 

Replay Files settings 

Replay files enable the Control to record and playback the screen 
activity that takes place at a Client workstation while it is being 

remote controlled/viewed. 
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Record Replay Files 

Check this option to enable the recording of replay files. A replay file 
will be created each time the Control views a Client PC with the 
option enabled. 
 
Prefix Files With Client Name 
In order to identify each replay file, file names can be prefixed with 

the Client name and the date/time of the recording. Alternatively, 
with the option unchecked, the files will be named sequentially in the 

format 00000001.rpf etc. 
 
In Folder 
Specify where the replay files should be stored. If saving to a network 
share, this allows you to store each Clients files in individual folders. 

 
As User 
The user name and password used to write to the log file. 
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Event Logging 

Log files record the activity that takes place at a Client machine while 
it is being remote controlled. Information such as the name of the 
Control that initiated the connection, and the date and time that the 

session started and ended, can be recorded if required. The text files 
that are created provide a useful audit trail but you can also enhance 
Client security using this feature. 

 

Enable Logging 
Select this check box to enable logging. 
 
Log to NT Event Log 

Sets the log to be maintained within the NT Event Log. 
 
Log to File  
Sets the log to be maintained within a text file. This file can be on the 

local workstation or on a server. Multiple Clients can write to the 
same log file. 

 
Primary Log File 
Specify the path, and file name (*.log), where the log file will be 
stored. 
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Secondary Log File 

Specify the path for a secondary log file. In the event that the 
primary path cannot be found, for example, the server is down, the 
file will be stored here. 
 

Notes: 
• To make the tracking of log files easier, particularly if multiple 

Client log files are stored on the same server, the file names 
specified above can include the Clients computer name and the 

date that the log was created. For example: 
\\Logserver1\logfiles\$computername$$dd$$mm$$yy$.log. In this 

instance, you would be able to build up a daily record of activity on 
a particular Client machine. 

Acceptable formats for the date are: 
$d$$m$$y$ which for 7th December 2021 returns 171221. 
$dd$$mm$$yy$  returns 1071221. 
$ddd$$mmm$$yyy$  returns 1TueDec2021. 

$ddd$$dd$$mmm$$yyy$ returns 1Tue07Dec2021. 
$dddd$$dd$$mmmm$$yyyy$ returns 1Tuesday07December2021. 

• For Windows XP and above, this file must be a UNC path name as 
a mapped drive is not available until you log in. 

 
As User 
Log File user is the user name and password used to be able to write 
to the log file when the path specified is a UNC path.  
 
Append to log file 

By checking this box, NetSupport Manager will continually add to the 

existing entries in the log file. If unchecked, existing items get 
overwritten.  
 
Reject connection if no log server available 
By enabling this option, you can apply additional security. With 
logging enabled, if a Control attempts a connection and neither of the 

log files can be found, the connection request is rejected. This 
ensures that any audit checks that you may have in place will not be 
compromised due to the activity not being logged while the servers 
are down. 

 
Keep log values for 
Specify the number of days to keep the entries in the log file for. Any 

older entries will be cleared after the specified number of days (once 
a new log entry is received). Leave this blank to keep all entries 
indefinitely. 



NetSupport Manager v.14.00 

 

 247 

Only log while Connected 

This option ensures that activity is only logged during the period that 
the Control is physically connected. When logging is enabled, some 
additional information is recorded that you may prefer to ignore, 
Client configuration data, for example. 
 

Note: Another useful item of information that can be recorded is 
the reason why a Control is connected to the Client. This 
comes into effect when ‘User Acknowledgement ’ is enabled 

at the Client machine and the Control Security settings 
option is configured to ‘Prompt for additional information 

when connecting’. 

 
Log username 

By default, the user name of the Control user who initiated the 
connection is recorded in the log file. If you don't want to record this 
information, clear this checkbox. 
 

Log connection 

By default, connect and disconnect entries are recorded in the log 
file. If you don't want to record this information, clear this checkbox. 
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Remote Control options 
The following remote control attributes can be adjusted: 
 

View settings 

 

Options 
Send Physical Fonts  
When a Windows Client is sending its screen to a Control, it passes 
the font information by reference to reduce the volume of data sent. 
 
The Control refers to its own internal font mappings and uses the 
closest matching that it has to the one being displayed at the Client. 

In most cases, the same fonts will be available at both the Client and 
the Control and so what is displayed on the screen will appear 
identical. 

 
However, there may be occasions when a close match cannot be 
found. In these cases, it is desirable that the Client sends the Control 

the full information that it requires to display the data in the same 
font. 
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Setting this option forces TrueType text to be sent as glyphs (i.e. 

character shapes) rather than character codes. This guarantees that 
they will be displayed correctly at the Control.  
 
This will, however, impact on performance, especially on dial-up 
lines, and is not usually required. 
 

Enable Screen Scrape 
NetSupport Manager’s favoured and the most efficient method for 

capturing screen data is to hook into the Video Driver of the 
workstation being viewed. 
 
However, there may be occasions when this method will not work 
because certain applications bypass the driver. In these 

circumstances, you can enable ‘screen scrape’ mode in order to take 
a snapshot of the screen. Although this will have a greater impact on 
the network, it will at least provide an accurate representation of the 
Client’s screen. 
 

Disable font smoothing 
This option disables font smoothing when viewing a Client.  

 
Disable drop shadows on desktop 
This option disables drop shadows on applications when viewing a 
Client. 
 
Cache Size 

Screen data that has been recently sent to the Control by the Client is 
cached to improve performance. A larger cache improves 

performance at the expense of using more memory at both the Client 
and the Control. 
 
Setting this option enables you to tailor the cache size used for 
maximum performance. The lower of the cache size set at the Client 

and Control will be used so you must set at both ends for this to be 
effective. 
 

You can determine how efficiently the cache is working by clicking  
on the caption bar and selecting About - Cache from the Client View 

window at the Control. This will display statistics of hits etc. 

 
Max Colour Depth 
The higher the colour depth at the Client the greater the volume of 
data that needs to be sent to the Control for each screen update. 
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Restricting the Colour depth will improve performance on slower 

links. 
 

Note: The settings here will override the colour depth setting in the 
Control Configuration. 

 
Inactivity Timeout  

When a Control connects to a Client, it can prevent other Controls 
from connecting to that same Client unless the Allow Multiple 

Connections option has been set. 
 
If the operator at the Control forgets to terminate the connection, 
then a case might arise where other Control users who need access 
are locked out. 

 
Setting this option means that if a connected Control has not carried 
out any mouse, keyboard or file transfer activity for the specified 
period, the Client will assume that the connection is no longer 
required and disconnect automatically. It will then be available to 

other Controls. 
 

Enable DVD Playback and Direct 3D support 
NetSupport Manager uses the Microsoft Mirror Driver to capture 
screen data for view sessions. However, while hooked into the Mirror 
Driver, it is not possible to play DVDs. Therefore, if you do need the 
capability to play DVD’s, NetSupport Manager provides options which 
load and unload the Mirror Driver as required. 

 
Except While Viewed 

If checked, DVD support is enabled but will be disabled for the 
duration of a view session while the Mirror Driver is loaded. 
 
Except While Connected 
If checked, DVD support is suspended while a connection to the Client 

is in place. 
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Show settings 

 

Receive Show Options 
Disable Receive Show 

Prevents the Control from being able to show to the Client. 
 
Show to a Window 
Enables the Client to receive a Show in a window rather than in full 
screen mode. 

 
Scale to Fit 
Automatically scales the Receive Show window to resize the displayed 
screen in the available area. 
 

Scrollbars 

Determines if scrollbars will be displayed with the Receive Show 
window for navigation. 
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Auto-Scroll Speed 

When you are viewing a Show in a window on the Client’s screen, the 
Client can automatically scroll the contents when the mouse moves 
close to the edges of the window. Adjusting the sliding control sets 
the speed at which the view scrolls, from not at all to very fast. 
 
Scroll Delay 

When auto-scroll is enabled, you can change the delay before the 
scroll is activated. If you want the view to scroll as soon as the 

mouse is at the edge of the screen, move the slider towards Min. If 
you prefer a longer delay before the AutoScroll takes effect, move the 
slider towards Max.  

 

Audio settings 

This option provides configuration options for using Audio Support at 
the Client.  

 

Volume 
Threshold – microphone sensitivity 
Microphone – volume of the microphone 
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Speaker – volume of the speakers 

 
Test 
Check this option to test all of the above settings. 
 
Compatibility  
Enable Audio Hooking 

Enable or disable audio hooking.  
  

Note: A reboot is required for the settings to take effect. 

 
Hook audio acceleration 
Sets the hardware acceleration level for the Clients. 
 

Never 
Leaves the acceleration level at full. 
 
While Connected 
The acceleration level will be moved to basic while connected. 

 
Always 

The acceleration level will be moved to basic. 
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Client Interface options 

The Client Interface settings are used for customising the interface 
between the Client and the Control. 

 

Client settings 

 

Disable Client Menu items 
Disable Request Help 
Prevents the Client user from being able to use the Request Help 
function. 
 
Disable Call Control 

Disables the Call Control option at the Client. 
 
Disable Disconnect 

Prevents the Client user from being able to force the Control user to 
disconnect. 
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Disable Chat 

Prevents the Client from initiating a Chat session with a Control. 
However, the Control can still open a Chat session with the Client. 
 
Disable Replay 
Prevents the Client from being able to open Replay files. 
 

Disable Local Inventory 
Prevents the Client from being able to perform a local inventory. 

 
Client program options 
Icon in System Tray 
The NetSupport Manager Client icon will be displayed in the system 
tray (clicking this opens the Client information window) rather than 

as an active application on the taskbar (clicking this opens a window 
with drop-down menus providing access to the Client features). 
 
Always on Top  
The NetSupport Manager Client window can become obscured behind 

other windows. Setting this option means that it is always visible and 
the user at the Client will always know when someone is viewing 

them. 
 
Hide when Idle 
The NetSupport Manager Client icon will not be displayed unless a 
Control is connected or viewing the Client. 
 

Quiet Mode (Client not visible on taskbar) 
Select this option to hide the Client icon in the system tray. 

 
Silent Mode (no refresh) 
Allows the Control to connect and view a Client without the Client’s 
knowledge. If silent mode is not selected, the Client’s screen and 
mouse icon will flicker, notifying the Client that a connection has been 

made and their screen is being viewed. 
 
Use internal speaker for beep 
By default, the audible warning beep, which can be sent between 
machines in functions such as Chat and View, comes from the PC’s 

internal speaker. There may be occasions when it is more appropriate 
to use the workstations soundcard to generate the beep through 

speakers, in which case uncheck this box. 
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Beep while being Viewed (every n seconds) 

While a Control is viewing the Client, an audible beep will be 
sounded. 
 
Show UI when connected to 
When the Control connects to the Client, the Client Information 
window will be displayed. This allows the Client to see details of the 

Control that is connected to them. They also have the option to 
disconnect from the Control or chat with the Control. 

 
Disable Geolocation 
The location of a Client can be displayed in the Control. Selecting this 
option disables the Geolocation feature at the Client. 

 

Help Request settings 

This option is used for configuring the Client’s help request access. 
You can specify the NetSupport Manager Controls that the Client can 
forward help requests to or even link to a third-party web-based 
helpdesk system. 
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URL for Help Request 

If you use a third-party web-based helpdesk application, you can 
direct Clients to this rather than have them use NetSupport 
Manager’s help request feature. To enable, select Use URL and enter 
the appropriate URL. 
 
Available Controls 

Lists the Controls that are available to connect to from the Help 
Request and Call Control dialogs. 

 
Options 
Disable connections from Help Request dialog 
Check this box to disallow the options in the Help Request dialog for 
the Client to choose which Control they wish to send a help request 

to.  
 

Always show Controls in Help Request 
Check this box to ensure that the Client Help Request dialog shows all 
Controls available for the Client to send their help request to. 
 

Hotkeys for Request Help 
This sets the hotkeys that the user at the Client can press to raise an 

alert for help. The alert will normally be displayed when a Control 
connects to the Client. If you are using a keyboard that does not 
support three scan codes, configure your Client to use only two 
hotkeys. 
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Customisable Text 

This option enables you to add customisable messages which are 
displayed at the Client machine. 

 

Display Customisable Text 

In About Box 

Sets the message that will be displayed in the Client’s About Box.  
 
When Connected 
Sets the message that will be displayed at the Client when a Control 
connects. Leave blank if you do not want any message displayed. 
 

When Viewed 
Sets the message that will be displayed at the Client when it is being 
viewed by a Control. Leave blank if you do not want any message 
displayed. 
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Profile Options 

 

Disable this Profile when a user is logged on 
If someone is logged in at the Client, then this profile will be 

deactivated and therefore not available to a Control user. The value 
of this is that it prevents a Control user from inheriting rights on the 
workstation that they would not otherwise have. 
 

Note: You can have two profiles with the same user ID but with 
different rights, depending on whether the Client user is 
logged on at the time the Control connects. In this event, 
make sure that the profile with this setting is the first in the 

list, as it will then move on and use the second profile if the 
Client user is logged in. 

 
User of this Profile has Priority over other (non-priority) Users 

This works in conjunction with the option to allow more than one 
Control to connect simultaneously. If one profile has this set while the 
other does not, the latter will be automatically disconnected. 
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Terminal Services settings  

You can configure the settings for the Client Terminal Server here. 

 

Note: Terminal Server and other thin clients may not be configured 
to use the NetSupport Gateway. 

  
Terminal Services Settings 

Run Client in Console session 
Unchecking this option will stop the Client from running in a Console 
session. 
  
Run Client in remote sessions 
Unchecking this option will stop the Client from running in remote 

sessions. 
  

Base Port 
Enter the required base port number. The default value is 25405. 
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Client Name 

Enter the required name for the Client. If left blank, a unique ID will 
be displayed (defaults to %CLIENTNAME%). When entering a Client 
name, you must include at least one environment variable, e.g. 
%computername%.  
  

Note: For further information regarding Terminal Server support, 
please visit our Knowledge Base and refer to product article 
Setting Up NetSupport Manager to run in a Microsoft 

Terminal Server Environment. 

  

Advanced options 

 

Keyboard Filter Driver 

Should you encounter any issues with your keyboard filter driver, we 
provide a choice of drivers to switch between. Select the required 
driver from the drop-down menu. 
 

https://kb.netsupportsoftware.com/knowledge-base/setting-up-netsupport-manager-to-run-in-a-microsoft-terminal-server-environment/
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Configuring the Control 
 
In this chapter … 
 

How to configure the Control. 

 

Create individual profiles ensuring each Control user can only 

perform certain tasks at Client PCs. 
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Configuring the Control 

NetSupport Manager allows you to fully configure how the Control 
Program will operate. To provide maximum flexibility, NetSupport 

Manager also allows you to set up multiple profiles for different 
Control users, each with their own access and functionality levels.  
 
To access the Control Configurator 
1. Click the Change the settings for the current Configuration 

icon  on the caption bar.  
2. The Setting for Configurations dialog for the current profile will 

appear. 
 

Note: If you want to change the settings for a different Control 

profile, click the Profiles icon  on the caption bar, choose 
the profile you want to configure and click Settings. 

 

The Control Configuration options are categorised as follows: 
General  

Enables you to set the identification details for the Control. 
 
Connectivity  

Enables you to specify which transport protocols the Control will 
operate over. 
 
Security  
NetSupport Manager offers a wealth of security features that can be 
applied to each Control profile. 
 

Remote Control  
Enables you to adjust the Remote Control features that apply to each 
Control profile. 
 
Control Interface  
Enables you to configure the various components available to the 
Control from the Control window interface. 

 
Show 
Allows you to configure the settings for a Show. 

 
File Transfer  
These options configure the File Transfer settings in NetSupport 

Manager. They allow you to alter the way in which information is 
displayed and enable you to set safety features such as confirmation 
before performing a damaging operation. 
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Startup  

Allows you to configure the options that affect NetSupport Manager at 
startup. 
 
vPro 
Enables you to configure the settings for vPro management. 
 

File Locations  
Allows you to specify where to store this named configuration, Client, 

group, remote networks, tools and scripting files. 
 

Note: A search bar is provided at the top of the window, allowing you 
to locate the settings you're looking for. Type in the search 

bar (you can enter a full or partial term) and click . Any 
sections containing the search term will be highlighted. Click 

 to close the search. 
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Multiple Control profiles 

NetSupport Manager allows you to set up multiple profiles 
(configurations) for different Control users, each with their own 

access and functionality levels. 
 
Each configuration can be protected by a password and an icon can 
be created on the desktop to load the Control with a particular named 
configuration.  
 

You must have NetSupport Manager Administrator rights to profile or 
change a Control’s configuration. 
 
To create a profile 

1. Click the Profiles icon  on the caption bar. 
2. The Configurations dialog will be displayed. 

 

3. Select the configuration you want to change.  
Or 
Choose New to create a new one. By default, NetSupport 
Manager is installed with a single profile called Standard. This is 
set up for full functionality. 

4. Click Settings to tailor the global functionality of this profile. 

Or 
Click Connectivity and Startup Settings to tailor the basic 
functionality. 
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To create desktop icons 

Having saved the profile, you can create a desktop icon containing 
the parameters required to load the configuration. 
 
1. From the Configurations dialog, click Icons. 
2. The Icon Maintenance dialog will be displayed. 
3. Click anywhere in the dialog and drag to the desktop. 

4. The Create or Edit Icon dialog will appear.  
5. Enter the required configuration details and click OK to create the 

icon. 
 

Adjusting Client settings for a Control session 

During any Control session where you may be working with more 
than one Client, you can tailor how each Client interacts with the 
Control. For example, on one Client, you may want to use 
compression because it is on a slow link, but on another, you may 
want to turn compression off. NetSupport Manager allows you to do 

this by modifying the default settings for the current Control profile. 
 

To adjust View settings 
1. View the required Client. 

2. Click Settings  on the View window caption bar. 
3. The Remote Control Settings will appear.  
4. Configure which options will be enabled when you start a View 

session.  
 

Note: If you edit the Client settings, the changes you make only 
apply to that Client during the current Control session. If you 

want to change the settings permanently, select Update 
Configuration. 
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General settings 

This option allows you to give the Control a specific name. If left 
blank, the machine name is used. 

 

Identification 
Control Name 

The name which the NetSupport Manager Control program uses when 

connecting to Clients to identify itself. Under NetBIOS, this name is 
registered in the NetBIOS transport. 
 
Description 
Enter a description for this Control configuration. 
 
Default User ID 

If user validation is required before a Client connection can be made, 
Control users will need to log on with a valid user name and 

password. Rather than continually prompt for the user name, a 
default ID can be set here. The following variables can be used in 
order to default to the currently connected username: 
%userdomain%\%username%. 
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Send Message 

Title 
Enables you to add a customised title to the Send Message dialog.  
 

Connectivity options 

Before you can connect to Clients on your network, you must select 
and configure the transports to use. The transport protocols must be 
configured in the operating system before attempting to use them. 

 

Set TCP/IP connection 

 

TCP/IP 
Use TCP/IP 
Check this button to enable the Control to use the TCP/IP protocol. 
This protocol is used with the internet, local and wide area networks. 

In order to connect to TCP/IP Clients, you need to specify the port 
number that the Client is listening on. 

 
Port 
This value is used for all interactions with TCP/IP Clients. The default 
registered port for NetSupport Manager is 5405. You can configure 

Clients on your network to run on a different port number if required. 
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This is useful to provide additional security, as other NetSupport 

Manager Control users would need to know on which port your Clients 
are configured. You can also specify a port number when creating or 
connecting to a Client. 
 

Note:  To enable Clients to initiate a connection to the Control, the 
default registered port is 5421. 

 
Connect by Hostname (DHCP/WINS) 

Normally, the Control connects to a Client by IP address rather than 
by name. In an environment that uses DHCP (Dynamic Host 
Configuration Protocol), this may be undesirable as the address may 
change when the Client workstation is restarted. Checking this option 
forces the Control to connect by hostname. 

 
Test 
Select this option to check the configuration and version of the TCP/IP 
stack installed. The version of Winsock is returned along with its 
current state. 

 
Browsing 

Subnets used when browsing for clients 
When you are running on a network with multiple subnets or 
addresses, you need to configure the broadcast addresses for each 
effective network. When a browse is performed, the broadcast 
messages are sent to these addresses. 
 

Broadcast Settings 
Enable Broadcast Show and File Distribution 

When performing a show or distributing files to Clients, the screen 
information/files are sent to each Client machine in turn. Enabling 
Broadcast Show and File Distribution results in the screen information 
and files being sent to all machines simultaneously. In some network 
environments, where there is limited network bandwidth available or 

when broadcasting to larger numbers of machines, this will provide 
significant performance benefits. 
 
Whilst reducing overall network traffic generated by NetSupport 
Manager, using this feature will generate additional broadcast packets 

on your network. It is recommended that you consult your network 
administrator before using this feature. 
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Note: Show and File Distribution can be sent using multicast instead 
of UDP/broadcast. This means that the multicast packet will 
only be sent to machines included in the specified IP multicast 
address. 

 
Settings 
If the Broadcast Show and File Distribution option is enabled, 

select this option to set the multicast or broadcast address. The 
Broadcast Settings dialog will appear. If multiple Controls are 

attempting to use UDP/Broadcast Show simultaneously on the same 
subnet, it is recommended that each uses a unique port to avoid 
conflict. 
 
Wireless Network 

Check this option in order to optimise show performance across a 
wireless network. 
 

Note: NetSupport Manager will automatically detect any wireless 
Clients and enable this option to improve performance.  

 
Maximum throughput 

Controls the level of data sent across the network to your wireless 
access point. The default data rate is 8 Mbps. If required, this can be 
altered to reflect the speed of the router. 
 

Note: When a Control detects wireless Clients or is itself wirelessly 
connected, it will automatically reduce the maximum data 
output to whatever has been configured in the maximum 
throughput settings, regardless of whether the wireless 

network checkbox has been selected. This behaviour cannot 
be turned off. 

 



NetSupport Manager v.14.00 

 

 271 

Set IPX connection 

Note: This option is only available in the Control Configurator if you 
open it from the Control configurations dialog. Click the 

Profiles icon  on the caption bar, select the required 
configuration and click Connectivity and Startup Settings.   

 

IPX 

Use IPX 
Check this box to enable the IPX transport protocol. This protocol is 

used on local and wide area networks.  
 
Record Clients’ Network Numbers 
When IPX addresses are recorded for a client, the network number is 
normally set to 0 if the Clients are on the same IPX network as the 

Control (this prevents subsequent problems when a file server is 
down). This setting forces network numbers to be recorded and used 
when establishing a connection. 
 
Use Networks 

The Control normally obtains a list of network numbers from the 
nearest NetWare server or bridge. On some networks, there is no 

NetWare server to ask, or the list generated is unreliable. Enter one 
or more network numbers to use, which replaces the normal 
discovery mechanism. The numbers can be decimal or hexadecimal 
and must be separated by a comma. Such as “0x1, 0x2, 
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0x34db1d69”. You can also use the Test function to determine these 

values automatically. 
 
Ignore Networks 
This list of network numbers is generated in the same way as for Use 
Networks, except that when browsing, these network numbers are 
ignored. You can also use the Test function to determine these 

values automatically. 
 

Test 
Select this option to check the IPX network configuration. This 
determines if the IPX network stack is available and configured 
correctly. You can also scan the network for network numbers that do 
and do not respond. 

 

Set NetBIOS connection 

Note: This option is only available in the Control Configurator if you 
open it from the Control configurations dialog. Click the 

Profiles icon  on the caption bar, select the required 
configuration and click Connectivity and Startup Settings.   
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NetBIOS 

Use NetBIOS 
Check this box to enable the use of the NetBIOS transport. NetBIOS 
is a non-routed protocol and is only used on Local Area Networks 
(LAN). Using NetBIOS requires that you select one or more adapters 
to use. See adapters below. 
 

Adapters 
Contains the NetBIOS adapters that have been detected in your 

workstation. Select one or more of these adapters for use in the 
control. NetBEUI is the most common adapter used here, as it is used 
primarily by Windows systems. The adapter numbers will vary from 
workstation to workstation, but the names will remain constant.  
 

Test 
Allows you to test the NetBIOS stack and determine the adapters 
available. You can also display detailed information about each 
adapter found. 
 

Set HTTP connection 

This option enables you to configure the Control to communicate via 
HTTP. For more information, see Connecting Clients/Controls via a 
NetSupport Gateway. 
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Use HTTP:  

Check this box to enable the Client to communicate over HTTP. 
 
Port: 
NetSupport Manager’s default port for HTTP communications is 443. 
 

Note: In version 9.10, port 443 was introduced as the default for 
HTTP communications, 3085 being used previously. Gateway 
settings will be preserved for existing customers who 

subsequently upgrade, enabling 3085 to continue to be used, 
but there may be scenarios when upgraded Controls and 

Clients will need the HTTP port manually reconfiguring to 
ensure compatibility. 

 

PIN Server 

 

PIN Server 
PIN Server Address 

Enter the IP address of the workstation where the PIN Server is 
installed. 

 
Port  
The default port number for the PIN Server is 443. 
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Use a proxy server to connect to the PIN Server 

Select this option if you are using a proxy server to connect to the 
PIN Server. Enter the server address and port number for the proxy 
server.  
 

Copy Settings from Gateway 
If you have set up a NetSupport Gateway, you can use the same 
settings for the PIN Server.  Select the Gateway to copy the settings 
from using the drop-down list and select Copy.  The Gateway address 

and port from the selected Gateway will be used. 

 

Remote Dialup settings 

This option provides configuration options for the dial-up settings for 
remote networking. Before you can dial remote networks, you must 
enter information about your modem hardware. To dial a remote 
network at startup, click the Change the settings for the current 

Configuration icon  on the caption bar and choose Startup.  
 

Note: This option is hidden by default. To view this, click the Change 

the settings for the current Configuration icon  on the 
caption bar. Select Control Interface - Settings and clear 

the Hide Dial Directory checkbox. 
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Modem 

NetSupport Manager displays all available modems here. Simply 
select which modem you wish to use. 
 
Dual Channel Bonding 
If enabled, both channels of your ISDN line are combined, thus 
increasing the amount of available bandwidth to 128k. However, in 

increasing the speed of transmission, you are, in effect, making two 
calls.  

 

MSN (Multiple Subscriber Number) 
Specify a number that you want the Control to answer an incoming 
dial-back from a Client Bridge. 
 
Diagnostics 
None 

Select this option to perform no diagnostics on your modem. 
 
Basic 

When the modems connect, the Control checks the following: 
 
Flow control is correctly set (XON/OFF is disabled, etc). 
There is a NetSupport Bridge at the remote number. 

There are not excessive delays in transferring data. 
 
Extended 
The extended setting performs the same checks as for basic and 
includes: 
 

Line reliability 

Throughput. 
 
Logging Level 
None 
Select this option to display the progress messages on the screen 
only. 

 
Basic 
Logs the following information to MODEM.LOG: 

 
The name of the modem used 
The number dialled 
Results of diagnostic tests 

Connection speed. 
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Verbose 

This records the same information as Basic but includes timestamps. 
 

Use this option is you are having problems establishing dial-up links. 
 
View Log 
Opens a window that displays the MODEM.LOG file generated by 

Extended and Verbose Diagnostic and Logging settings. 
 

Advanced settings 

 

Tickle Period 
Specify the period in seconds between tickle packets that are sent to 

the Client. These packets check to make sure that a connected Client 
is still active. If the Client fails to respond, the Control assumes that 
it is no longer present and will close down the connection. 

 
Name Lookup Delay 

Specify the delay in seconds between broadcast packets. Use this 

value in conjunction with Name Lookup Attempts to reduce the 
amount of time spent performing browses. The browse is more likely 
to miss Clients if this value is too small. You should not specify a 
value that, when multiplied by the Name Lookup Attempts value, is 
less than 4 seconds. 
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Name Lookup Attempts 

Specify the number of name lookup packets the Control broadcasts 
during a browse. The fewer broadcasts that are sent, the lower the 
network traffic and the quicker the browse will complete. 
 

Security options 

The Control Configurator provides a wealth of security features 
categorised as follows: 

 

Settings  
Event Logging  
Replay Files  

User Permissions  
 

Security settings  

 

Password 

Enter the security password, which you will be prompted for when 
starting the Control using this configuration. You must click on the 
Set button next to this Control to set the password. 
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Security Key 

The security key is used whenever you connect to a Client. Unless the 
key entered here matches the security key on the Client, you will be 
denied access to the Client workstation. Press the Set button to 
change the key. Optionally, this can be set as the serial number in 
your NetSupport Manager Licence file. 
 

Prompt for Additional Information when connecting 
If this box is checked, you will be required to supply a reason for 

connecting to a Client workstation. This is sent to and displayed at 
the Client so that the user knows why you are connecting when the 
Client has user acknowledgement enabled. 
 
Try Last Username before displaying login Prompt 

Remembers the user name and password attached to a named 
configuration and will attempt to log in using this information. 
 
Use Compression 
Check this box to enable the use of compression. When you are 

communicating with a Client, whether it is a File Transfer, View or 
Chat session, the data being sent and reviewed will be compressed. 

This also provides a means of security, as the data will also be 
encrypted. 
 
Use Encryption 
With encryption turned on, all the information that is sent between 
the Control and Client is very difficult for others to read. NetSupport 

Manager offers a range of encryption options, ranging from 56 bit 
DES to 256 bit AES, enabling you to find the necessary balance 

between security and performance. The higher the level of 
encryption, the higher the potential for decreased performance. 
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Event Logging 

Event logging enables a NetSupport Manager Control to record, in a 
text file, the actions it has performed while remote controlling a 
Client. This may be useful for maintaining a history of how often a 

particular Client was connected to and for what purpose.  

 

Enable Logging 

Check this box to enable the Log to File option. Once enabled, each 
time the Control subsequently connects to a Client(s), the activity for 
that session will be recorded. 
 
Log to File 
Specify the path and file name for the log file. The NetSupport 
Manager default is PCICTL.log. This file can be stored on the local 

workstation or on a Server. Multiple Controls can write to the same 
log file. 
 

As User  
Log File user is the user name and password used to be able to write 
to the log file when the path specified is a UNC Path. 
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Append to Logfile 

By checking this box, NetSupport Manager will continually add to the 
existing entries in the log file. If unchecked, existing items get 
overwritten.  

 

Replay Files 

Replay files enable the Control to record and playback the screen 
activity that takes place at a Client workstation while it is being 

remote controlled/viewed. 

 

Record Replay Files 
Check this option to enable the recording of replay files. A replay file 
will be created each time the Control views a Client PC.  
 

Include Audio 
In addition to recording the screen, mouse and keyboard activity, if 

Client machines are configured for audio, you can include any 
narration that takes place. 
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Prefix Files With Client Name 

In order to identify each replay file, file names are prefixed with the 
Client name and the date/time of the recording. Alternatively, by 
unchecking this box, the files will be named sequentially in the format 
00000001.rpf etc. 
 

In Folder 
Specify where the replay files should be stored. 
 

User Permissions 

These settings restrict the items that a user running a configuration 
can modify. Only if this configuration is running as a NetSupport 

Manager Administrator can you restrict the privileges of other users. 

 

Permit a user of this Configuration to 
Act as an Administrator 

When this box is checked, there are no restrictions applied to the 

user of this configuration. This should be enabled for at least one 
account to allow you to alter other configurations. 
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Change Settings 

This box is only available when the configuration is not running as an 
Administrator. Check this box to prevent the user running this 
configuration from changing any settings from within the user 
interface. 
 
Configure User Interface 

This check box is only available when the configuration is not running 
as an Administrator, and Change Settings is checked. Check this 

box to prevent the user of the configuration from altering any 
settings that affect the user interface. 
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Remote Control settings 

The following settings enable you to configure the behaviour of the 
remote control options when viewing Client workstations.  

View  
Keyboard/Mouse  
Print Capture  
Audio 

 

View Settings 

This option provides the configuration options for viewing Client 

workstations. When editing the Client settings, all changes you make 
will only apply while you are connected to that Client. If you wish to 
make your changes to the Control default, check Update 
Configuration.  

 

Options 
BIOS Keyboard 

Checking this option causes the Control to emulate keystrokes on the 
Client at the BIOS level rather than the hardware level. Use this if an 
application at the Client does not appear to be correctly accepting 
keystrokes from the Control. Only use this option if you are 
experiencing problems with the default low-level keyboard option. 
 



NetSupport Manager v.14.00 

 

 285 

Confirm Switch to Full Screen 

When this box is checked, you will be prompted to confirm switching 
to Full Screen mode. 
 
Full Screen 
Checking this option will force the Control to view a Client in Full 
Screen mode rather than in a window. 

 
Scale to Fit 

Check this option if you want the contents of the View window to be 
automatically shrunk to fit the sizeable frame. 
 
Disconnect when Closed 
Check this option to disconnect from a Client when a View window is 

closed. 
 
Screen Scrape 
NetSupport Manager’s favoured, and the most efficient method for 
capturing screen data is to hook into the Video Driver of the 

workstation being viewed. However, there may be occasions when 
this method will not work because certain applications bypass the 

driver. In these circumstances, you can enable Screen Scrape mode 
in order to take a snapshot of the screen. Although this will have a 
greater impact on the network, it will at least provide an accurate 
representation of the Client’s screen. 
 
Scrollbars 

You can turn off scrollbars on the View windows by unchecking this 
option. This is useful when using auto-scroll, as you gain a little extra 

workspace. 
 
Use Compression 
Check this box to enable compression when viewing a Client’s screen. 
The state of this checkbox is also reflected in the General settings. 

 
Wallpaper 
Check this box if you want the Client’s wallpaper to be visible when 
viewing. Normally this is turned off to improve performance, so 
expect the screen update speed to be impacted by selecting this 

option. 
 

Blank Client Screen 
This enables the Control user to blank the Client screen in any of the 
View modes.  
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Notes:  
• This feature is only available on Clients running Windows 10 

v2004 and above (legacy support is provided for Clients running 
Windows 8 and below). 

• If another Control, with the Blank Client Screen setting checked, 
attempts to connect to a Client being controlled in Blank Client 
Screen mode, the original Control will be disconnected. This is to 
prevent less privileged users from ‘surfing in’ on the back of a 
more privileged user.  

 
Video Skipping 
NetSupport Manager Controls can be configured for viewing 
performance. The Control program will not display Client screen 
updates if a subsequent update to the area of the screen is made. 

Unticking the box will result in all Client screen updates being 
displayed at the Control.  
 
Auto Clipboard 
When enabled, it provides the quickest method for copying data. Use 

shortcut keys to automatically copy from (Ctrl+C) and paste to 
(Ctrl+V) the clipboard at both the Control and Client machines. 

 
Default Mode 
By default, when you view a Client, you start viewing in Share mode. 
If you prefer to start viewing in a different way, change the mode 
from the list provided. 
 

Cache Size 
The NetSupport Manager Control contains a cache to help improve 

overall performance. The cache sizes range from 256k to 16Mb and a 
separate cache is allocated to each Client connection. If you are 
running applications on the Client that use lots of or large bitmaps, 
increase the cache size to improve the performance. 
 

Max Colour Depth 
When you connect to a Client, you can restrict the colour depth that 
is sent. This is done to reduce the amount of traffic between the 
Client and Control. Reduce the colour depth to 16 colours if you are 
using applications that do not rely on anything other than the 

standard 16-colour palette. 
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Note: The colour depth set here will be overridden by the settings in 
the Client’s Configuration, preventing you from setting the 
colour depth at a higher level. To alter these settings at the 
Client, load the Advanced Configurator and select {Remote 

Control – View} and amend the Max Colour Depth to the 
required level. 

 

Change DOS Font 
Use this dialog to select the font to use when displaying DOS screens. 

This will be either from DOS Clients or Windows Clients running Full 
Screen DOS boxes. Windows uses a graphic character set for 
displaying DOS screens. The higher the resolution that you are 
running Windows in, the larger the font size you will need to set to 
get an accurate representation of a DOS screen. 

 
Change Japanese Font 
Use this dialog to select the font to use when displaying Japanese 
DOS screens. 
 

Update Configuration Standard 
Check this box to update the currently selected configuration. 
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Keyboard/Mouse settings 

 

Keyboard Layout 

International keyboard 
An international keyboard layout will be used at the Control during a 
view session. 
 

To specify a different keyboard layout to be used at the Control 
during viewing, select the required layout from the drop-down list. 

These layouts map keys on the Control to keys on the Client 
workstation. If both Client and Control are using the same keyboard 
layout, you should select Unmapped Keyboard from the list. 
 
Hotkeys 
When you are viewing a Client in Full Screen mode, hotkeys provide a 
way of returning to the (possibly hidden) user interface. If the screen 

resolution at the Client is smaller than the resolution of the Control, 

you can simply click your mouse button outside the View window to 
stop viewing and display the View window again. Check the boxes in 
this group to determine the keys that are used as hotkeys.  
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If you are using a keyboard that does not support three scan codes, 

choose only two options as your hotkeys.  
 
AutoScroll Speed 
When you are viewing a Client’s screen, the Control can automatically 
scroll the contents when the mouse moves close to the edges of the 
window. Adjusting the sliding control sets the speed at which the view 

scrolls, from not at all to very fast. 
 

Scroll Delay 
When auto-scroll is enabled, you can change the delay before the 
scroll is activated. If you want the view to scroll as soon as the 
mouse is at the edge of the screen, move the slider towards Min. If 
you prefer a longer delay before the auto-scroll takes effect, move 

the slider towards Max.  
 
Mouse Delay 
Adjusting the mouse delay allows you to reduce the rate at which 
mouse updates are sent from the Control to the Client when 

controlling or sharing. Move the slider control towards Infinite to 
reduce the rate and conserve bandwidth or towards Min for the best 

mouse response. This is useful on dial-up or very slow networks. 
 
Disable Num Lock Synchronisation 
If using a laptop as the Control machine, check this option to ensure 
that the keyboard’s behaviour corresponds with that of a standard 
desktop machine.  

 
Update Configuration Standard 

Check this box to update the currently selected configuration. 
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Print Capture settings 

Print Capture redirects printer output from a local printer at the Client 
to the printer or file at this Control. You would use this when running 
an application on a Client but want any printed output redirected to 

the printer that is local to you. 

 

Enable Print Capture 
Select this option to enable the Print Capture feature. If this option is 
unchecked, the output will be printed at the Client.  
 

Notes:  
• This option can also be enabled whilst viewing a Client. Click 

Print Capture on the View window status bar and select Enable. 
Alternatively, select Options to configure all print settings. 

• In addition to enabling this option at the Control, you also need to 
ensure that Print Capture is enabled in the Client’s Configuration. 

The privileges are enabled by default.  

 
These options specify where the printed output will be redirected to 
on the Control. This can be a local or networked printer, a PDF/XPS 
document, or a file. 
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Capture to PDF/XPS document 

Allows you to redirect the Client printing to a PDF/XPS document. If 
an XPS driver or a PDF printer is installed, this will be used as the 
default printer. If both are available, the PDF printer takes 
preference. 
 

Automatically print document if possible 

If printing is available, this option allows the document to be 
printed automatically at the Control. 

 
Capture to Printer xxx 
Select this option to redirect the Client printing to a local or network 
printer. The name of the default printer that is currently set up is 
displayed. 

 
Change 
Select this option to display a window containing all of the printers 
configured on your local workstation. 
 

Capture to File 
Allows you to redirect the Client printing to a file that can be printed 

later. This file can be on a local or network path. 
 
Browse 
A file browse window will appear when you select this option, allowing 
you to find a location for the capture file. 
 

Use Client Printer Driver 
When you enable Print Capture and connect to a Client, a printer 

matching the Control's local printer will be automatically created at 
the Client. In some cases, say where the Control and Client have 
different operating systems, the print driver may not install 
automatically. In this case, you will need to manually install the print 
driver at the Client. 

 
Please contact our Support team for further information. 
 
Report Driver used 
When you connect to a Client, a dialog box will appear informing you 

of the printer driver that has been used. If no matching drivers are 
found, you will be informed whether you select this option or not. 

 

Note: Print output is captured only from the port to which the default 
printer is attached. Note that the Client may change this when 

Print Capture is enabled. 

http://www.netsupportsoftware.com/support
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If you experience problems with the Windows Client, try: 

• Disabling 'fast printing direct to port' at the Client. 

• Removing any connection to a network printer at the Client. 

• Changing the printing priority at the Client to Low in Print 
Manager, Options, Background printing. 

 

Update Configuration Standard 

Check this box to update the currently selected configuration. 
 

Note: If you are editing the Client Settings, any changes you make 
here will only apply while you are connected to that Client. If 
you wish to make your changes to the Control default, check 
the Update Configuration option.  
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Audio settings 

This option provides configuration options for using Audio Support.  
 
If you are editing the Client settings, all changes you make will only 

apply while you are connected to that Client. If you wish to make 
your changes to the Control default, check the Update 
Configuration box.  

 

Volume 
Threshold – microphone sensitivity. 
Microphone – volume of microphone. 
Speaker – volume of speakers. 

Test – Click Test, to test the volume settings as you adjust.  
 
Enable 
On –  turn audio on. 

Off – turn audio off. 
Talk – turn the Control audio to talk function only. 

Listen – turn the Control audio to listen function only. 
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Selecting the Change Transmission Format button allows you to 

change the transmission format. Use only the level you need for 
acceptable quality. High quality settings can affect screen update 
performance. Over remote communication links, we recommend you 
use a transmission format of less than 2 kb/sec. 
 

Control Interface settings 

These options enable you to configure the different components 
available to the named configuration. 

 

Interface settings 

This option enables you to configure the different components 

available to the named configuration.  

 

Settings 
Hide Client List 

Check this option to disable the display of known Clients for security 
reasons. The All Computers folder is hidden in the Tree view. 
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Hide Group List 

Check this box to disable all the display of groups for security 
reasons. Any groups that have been created in the All Computers 
folder will be hidden. 
 
Hide Dial Directory 
Check this box to disable all remote network functions. The Remote 

Networks folder is hidden in the Tree view. 
 

Note: This option is enabled by default. 

 
Hide Gateway 
Check this box to disable the Gateway function. The Internet 
Gateways folder is hidden in the Tree view. 

Disable Browse 
Check this box to disable the browse function. The Browse folder is 
hidden in the Tree view. 

Use internal speaker for Beep 
By default, the audible warning beep, which sounds between 
machines in functions such as Chat and View, comes from the PC’s 
internal speaker. There may be occasions when it is more appropriate 

to use the workstation’s sound card to generate the beep through 
speakers, in which case uncheck this box. 
 
Hide Auto Group List 
Allows you to remove the Auto Group function from the Tree view. 
 

Hide empty auto groups 
Allows you to hide any auto groups that don't have any 
Clients associated to them. 

 
Client List Read-only 
Check this box to remove the ability to alter the Known Client list. 
Clients are still available in the Tree view, but you cannot modify or 

create new Clients. 

Group List read-only 

Check this box to remove the ability to alter the Groups list. Groups 
are still available in the Tree view, but you cannot modify or create 
new groups. 
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Dial Directory Read-only 

Check this box to remove the ability to alter the Remote Networks 
list. The Remote Networks folder is still available in the Tree view, 
but you cannot modify or create new items. 

Gateway Read-only 
Check this box to remove the ability to alter the Gateway list. The 
Internet Gateways folder is still available in the Tree view, but you 

cannot modify or create new items. 

 
Message on Disconnect 
When checked, the Control user will be prompted to send a message 
to the Client when disconnecting. This may be useful to notify the 
user on the Client workstation that the Control user has finished 
using the workstation and advise what action has been taken. 

 
Silent Disconnect 
Should a Client inadvertently disconnect during a session, a prompt 
appears at the Control machine. Check this option to disable the 

warning. 
 
Shell Extension  

NetSupport Manager integrates directly with Windows Explorer, 
allowing you to launch key functionality directly from your system 
without needing to first start NetSupport Manager. 
 
Disable Shell Extension 
Check this option to remove NetSupport Manager functionality from 

the Explorer shell.  

 
Location details (Geolocation) 
Show Client location 
This option will display the location of the Client in the Control. 
NetSupport Manager will display the approximate location of each 
Client (the town, state and country - with supporting flag). Clients 

can be grouped by country/location in the Auto Group feature.   
 
Default Client command 
By default, double-clicking a Client in the List view opens a View 

window. Here, you can change the action that is performed. 
 

Double-clicking a Client in the list 

Select what happens when a Client is double-clicked from the drop-
down list. You can choose to open a View, File Transfer, Edit Registry, 
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Inventory, Task Manager, Remote Command Prompt or Remote 

PowerShell window. 

 
Functions 

This option enables you to restrict the functionality that is available to 
the Control. 

 

Restrict Functionality 

You can prevent the following features from appearing in the Control 
profile by checking the appropriate boxes: 
 
• Disable File Transfer 

• Disable Chat 
• Disable Send Message 
• Disable Broadcast Message 
• Disable File Manager 
• Disable Duplicate Client Check* 
• Disable PIN Connect 

• Disable Quick Connect 

• Disable Execute 
• Disable Remote Command Prompt 
• Disable PowerShell 
• Disable Reboot 
• Disable Logoff 
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• Disable Replay 

• Disable Registry Editing (this option is disabled by default) 
• Disable Blank Screen 
• Disable Inventory 
• Disable Task Manager 
 
* When browsing for Clients, NetSupport Manager checks for 

duplicate Client details, only connecting to the first occurrence of a 
particular address. Depending on the set-up of your network 

infrastructure, there may be instances where duplicate IDs are in 
use. You can disable the check using this option. 

 
Remote Control 
The following items disable the different view functions within the 

NetSupport Manager Control: 
 

• Disable Control 

• Disable Share 

• Disable Watch 
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Help Request settings 

This option provides configuration options for receiving help requests 
from Clients.  

 

When a Help Request arrives: 
Highlight the Client in the Help Request list 

Check this box to highlight the Client icon in the List view when a 

help request is sent.  
 
Display a message 
Check this box to have help request messages displayed on the 
Control screen.  
 
Play a sound 

Check this box to play a sound when a Client sends a help request. 
Select Browse to specify the sound. 

 
Control Status (for incoming Client Connections) 
Available to take Help Requests 
Check this box to be available to receive all incoming help messages.  
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Not available to take Help Requests 

Check this box to not receive any help messages.  
 
Busy at the moment 
Check this box to be available to receive all incoming help messages, 
but not when connected to xxx number of Clients. Ensure that you 
specify the number of Clients you need to be connected to in order to 

be considered busy. 
 

Set Status to ‘Busy’ when connected to xxx or more Clients 
Specify the number of Clients you need to be connected to in order to 
be considered busy. 
 

Show settings 

The Show feature allows you to display the Control screen on all, 
some or one of the Client's screens. From here, you can configure the 

settings for a Show. 

 

Screen Scrape 
NetSupport’s favoured, and the most efficient method for capturing 
screen data is to hook into the Video Driver of the workstation being 

viewed. However, there may be occasions when this method will not 
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work because certain applications bypass the driver. In these 

circumstances, you can enable screen scrape mode in order to take 
a snapshot of the screen. Although this will have a greater impact on 
the network, it will at least provide an accurate representation of the 
Client’s screen.  
 
Max Colour Depth 

Allows you to select the maximum colour depth when showing to 
Clients. By default, this will be set to 256 (high) colours. 

 
Show Hotkeys 
To ensure that all actions performed by the Control are visible to 
Clients during a Show, you can enable the use of hotkeys. Any key 
combinations that the Control uses, e.g. CTRL+V, will be displayed in 

a balloon at both the Control and Client screens. 
 
Send Physical Fonts 
In order to reduce the volume of data being sent when sharing 
information of this nature, NetSupport Manager passes the font 

information by reference. The target workstation will refer to its own 
internal font mappings to find an appropriate match to the one that 

has been sent. In most cases, the same fonts will be available, but if 
there are instances where this isn’t the case, you can send the full 
information. Check this box to enable. 
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File Transfer settings 

This option provides configuration options for transferring files. They 
allow you to alter the way in which information is displayed and 

enables you to set safety features such as confirmation before 
performing a damaging operation. 
 
If you are editing the Client settings, all changes you make will only 
apply while you are connected to that Client. If you wish to make 
your changes to the Control default, check the Update 

Configuration box.  

 

Display Options 
Show System/Hidden files 
Check this box to display all files with system and hidden attributes. 

By default, this option is unchecked. 
 
Show file details 

Select this option to display multiple columns of information for each 
file in the list. These show the file size, modified date, attributes and 
short file name. You can toggle between this state and the file names 
only state by using the list style buttons in the File Transfer user 

interface. 
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Show filenames only 

Select this option to only display file names in the file lists. This 
allows you to display more files at the same time than with file 
details. You can toggle between this state and the details state by 
using the list style buttons in the File Transfer user interface. 
 
Confirm 

When you perform potentially dangerous file operations, such as 
deleting a directory or file, you can make the Control display a 

Confirmation dialog box. This helps prevent accidental loss of data. If 
you are familiar with the user interface, you can turn these options 
off as required. By default, all the confirmation settings are turned 
on. 
 

Folder copy 
Make the user confirm before copying a directory structure. 
 
Folder delete 
Make the user confirm before deleting a directory structure. 

 
File overwrite 

If checked, displays a confirmation dialog before overwriting an 
existing file. However, if unchecked, the confirmation message will 
still appear if system/hidden files are about to be overwritten. 
 
File delete 
Display a confirmation dialog before deleting one or more files. 

 
Use Recycle Bin for local deletions (when available) 

All files deleted from the Local pane will be sent to the recycle bin. 
This is enabled by default. 
 
Use Compression 
Check this box to enable the use of compression. When you are 

communicating with a Client, whether it is a File Transfer, View or 
Chat session, the data being sent and received will be compressed. 
This also provides a means of security, as the data will also be 
encrypted. 
 

Delta File Transfer 
Delta File Transfer improves performance by skipping the transfer of 

information that is unchanged. If the file being transferred already 
exists in the destination directory, only the changed parts of the file 
will be updated.  
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Delta File Transfer is enabled by default. 

 
Priority (when also Viewing) 
When you are transferring files and viewing a Client’s screen at the 
same time, each operation impacts the performance of the other. You 
can reduce the priority of a file transfer operation to make the 
viewing more responsive and vice-versa. Slide the control to the left 

to give the file transfer higher priority or to the right to give Client 
views higher priority. If you are not viewing a Client, this setting is 

ignored. 
 
Automatically close progress when copy finished 
Closes the File Transfer Progress dialog automatically on completion. 
Untick this option if you want to see the File Transfer results. 

 
Safe file types 
When opening a remote Client file, a warning appears asking you to 
confirm before continuing in case the file is unsafe. A list of safe file 
types is provided and you won't be prompted before opening these 

file types. By default, .bmp, .png, .jpg, .txt and .doc file types are 
included in the list. You can edit or add additional file types to the list 

(separate each file type with a semi-colon) as required. 
 

Note: Certain file types such as .exe, .cmd and .bat files will still 
receive a prompt even if they have been added to the list. 

 
Update Configuration Standard 

Check this box to update the currently selected configuration. 
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Startup settings  

This section configures the options that affect NetSupport Manager at 
startup. You can connect to a Client, group, remote network or even 

perform a browse. This enables you to perform a repetitive task that 
you would normally do every time you start the Control.  

 

At Startup 

Dial Remote Network 
Select this checkbox if you want to dial a remote network when the 
Control starts. When this item is checked, the list of remote networks 
configured is enabled. Select one of these networks to continue. 
 
Connect to Client 

Select this checkbox to connect to a Client when the Control starts. 
All of the Clients in your Known Clients List will be displayed here, 
with the transport appended to the name, for example, TEST1<TCP>. 
 

Connect to Group 
Select this checkbox to connect to a group of Clients when the 

Control starts. All of the groups created will be displayed in this list. 
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Browse for Clients starting with … 

When the Control starts, it can perform a browse using the 
information supplied. Enter a partial Client name or leave this blank 
to find all available Clients. The Clients found will appear in the 
Browse folder in the Tree view. 
 
Start Viewing 

When you have selected one of the checkboxes above, you have the 
option to view the Client when the control starts. Select this checkbox 

to enable the three options below. This allows you to choose how the 
Client is viewed. 
 

Watch 
Start watching the Client or Clients when the Control starts. 

 
Share 
Start sharing the Client or Clients when the Control starts. 
 
Control 

Start controlling the Client or Clients when the Control starts. 
 

Icons 
This utility allows you to create icons on your desktop that load a 
NetSupport Manager Control with a specific named configuration. This 
means that you can have several shortcuts that automatically connect 
to one or more Clients when run.  

 

Disconnect 
The following options are only available on non-administrative 

configurations. 
 

Exit Program on Disconnect 
Select this checkbox to force the Control to shut down when you 
disconnect from a Client. This option is very useful when used in 

conjunction with the option above and connecting to a Client at 
startup. 
 
Exit Program after Hanging up the phone 
Select this checkbox to force the Control to shut down once a dial-up 

session has been completed. This is most useful when used with 
dialling a remote network at startup. 
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vPro 

Allows you to choose which mode to use when looking for and 
connecting to Intel vPro machines. 

 

Configuration 
Basic (Small Business) Mode 
Select this option to scan for vPro machines on your network using an 

IP address range. You will be required to enter a user name and 

password to establish a connection. 
 
Advanced (Enterprise) Mode 
Select this option to retrieve vPro machines from the SCS server. A 
certificate will be required to establish a connection. 
 

Intel® Setup and Configuration Service 
These options will only be available when using Advanced mode.  
 

HTTPS Mode: 
SCS Service URL 
Enter the URL for the SCS service. 
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WMI mode: 

SCS Server Name 
Enter the name of the SCS server. 

 

File Location settings 

This option provides configuration options for Client, group, remote 
networks, tools and scripting file locations. This facility allows a 
Control user to have unique Control files, enabling a Control user to 

access their Control files from any Control workstation. 

 

Client File 
Click Change to specify an alternative location for all Control’s, Client 
details. To make files read-only, check the Client List Read Only 
checkbox in the Control Configuration User Interface settings. 

 
Group File 

Click Change to specify an alternative location for all profiled 
Control’s, group details. To make files read-only, check the Group 
List Read Only checkbox in the Control Configuration User Interface 
settings. 
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Remote Networks File 

Click Change to specify an alternative location for all profiled 
Control’s, remote network details. To make files read-only, check the 
Dial Directory Folder Read Only checkbox in the Control 
Configuration User Interface settings. 
 
Tools File 

Click Change to specify an alternative location for all profiled 
Control’s tool details. There is no facility to make these files read-

only. 
 
Scripts File 
Click Change to specify an alternative location for all profiled 
Control’s, script details. 

 
Use shared data files 
Checking this option allows you to share data with other users. 
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Managing and organising 
Clients  
 

In this chapter … 
 

You will find out how to better manage your database of Client 

PCs. Group Clients by department or geographic location and 

customise the properties of each Client.  
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Add a new Client 

NetSupport Manager maintains a database of all Known Clients. This 

is stored in the All Computers folder in the Tree view and provides a 
fast way to connect to those Clients without having to perform a 
browse. 
 
You can also see additional information about the Client, such as 

names, contact numbers etc.  

 
To populate the known Clients database 
1. Use the browse function to look up available Clients and connect 

to them. All required information about that Client will then be 
stored in the All Computers folder.  
Or 

Select the Home tab in the ribbon and click New. 
Or 
Select the All Computers folder and double-click New Client. 

2. You will then be prompted for the following information: 

• The name of the Client. 
• The network address of the Client. 

• The network transport it is running under. 

Note: Select I’ll choose the name from a Browse list to 
perform a browse and select a Client from the Browse list. 

3. Click Next. 
4. To enter additional information to be stored with the Client’s 

details, select Yes, enter more information. To finish adding 
the Client, select No. The information you can additionally store 
is: 

• An alternative name to be displayed at the Control for that 
Client. 

• A text description about that Client. 
• A contact name. 

• A contact telephone number. 
5. Click Finish. The newly created Client will now appear in the All 

Computers folder and be displayed in the List view. 
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Delete a Client 

As part of maintaining a database of known Clients, good 
housekeeping requires deleting unused previously saved Clients from 

the All Computers folder in the Control Tree view. 
 
To delete a known Client from the database 
1. Select the All Computers folder in the Tree view and select the 

required Client. 

2. Right-click the Client and click Delete .  

3. A prompt will appear asking for confirmation. 
 

Renaming a Client 

Instead of displaying the Client’s physical name, NetSupport Manager 

allows you to set a different name that will be displayed at the 
Control. 
 
For example, a workstation running a Client may have a description 

allocated by you, such as Sales 2. This workstation may move to the 
Accounts department, and as such, you wish to rename it to Accounts 

3. 
 
To rename a Client 
1. Select the All Computers folder in the Tree view and select the 

required Client. 
2. Select the tab in the ribbon displaying the Client's name and click 

Properties. 

Or 

Right-click the Client and click Properties . 
3. The Client Properties dialog will appear.  

4. Select the Details tab. 
  

This is where you can store background information about the 
Client workstation. The following options are available: 
 
Display name 

Use the display name to provide a friendlier name for the Client 
to be displayed at the Control. By default, the physical Client 

name is used. 
 
Description 
Here, you can enter any useful information about the Client. 
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Contact and Phone number 

Store the name of the workstation user and a relevant telephone 
number for the workstation. 
 
Mac/Ethernet address 
Store the Mac/Ethernet address of the Client workstation. 
 

Note: This only changes the stored name on the Control. It does not 
affect the physical name of the Client that will be displayed at 

another Control or if you do a browse. 

 

Setting Client properties 

You can store additional information about a Client workstation and 
its user. This information can then be viewed in the detailed List view. 
You choose which columns are displayed in the List view by selecting 
the View tab in the ribbon and clicking Columns. 
 
To adjust Client properties 

1. Select the All Computers folder in the Tree view and select the 
required Client. 

2. Select the tab in the ribbon displaying the Client's name and click 
Properties. 
Or 

Right-click the Client and click Properties . 
3. The Client Properties dialog will be displayed. The following tabs 

are available: 
 

General 

This tab displays the physical Client name and location, the 
transport the Client is using and the Client's network address. 
You can also decide if the Client is included in shows/scans. 
  
Details 
This tab allows you to store background information about the 

Client, such as the name you want displayed at the Control for 
this Client, the description you want to associate with this Client, 
the contact name and phone number, and the Mac/Ethernet 
address. 
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System Information 

This tab will only be displayed once you have connected to the 
Client. It displays the following system information about the 
Client: 
 

• The machine and logged on user name 
• The IP address of the Client 
• The last connection date and time 

• The operating system the Client is running on 
• The location of the Client 

• The type of device the Client is using 
• What version of NetSupport Manager the Client is running. 
 

vPro 
This tab will only be displayed if the Client is running on a vPro 
machine. It shows the vPro version. 
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Creating a new group 

NetSupport Manager allows you to organise Clients into groups for 
easier access and management. For example, you might group all the 

Clients in the Accounts department into a single group called 
Accounts. You can also create sub-groups which are attached to a 
group, this may be useful if the Accounts department has different 
offices, you can then have a sub-group for the London office and one 
for the Cambridge office. 
 

Note: Clients are also grouped by pre-defined criteria, platform and 
Client version in the Auto Group folder in the Tree view. 
These groups are fixed and are unable to be changed. 

 
To create a group 
1. Make sure the required Clients have previously been connected as 

this will store them in the All Computers folder and make them 

available for grouping. 
2. Select the Home tab in the ribbon, click the New icon drop-down 

arrow and select Group. 
3. This will display the Add a group wizard, which will guide you 

through the process of adding or removing Clients in your new 
group. 

4. Click Finish. 

 
To create a sub-group 
1. Select the group that you wish to attach the sub-group to. 
2. Select the Group tab in the ribbon and click New. 
3. This will display the Add a group wizard, which will guide you 

through the process of adding or removing Clients in your new 

group. 
4. Click Finish. 

 

Note: Clients specified in a sub-group will also appear in the group 
above it. 
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Adding/removing Clients in a group 

NetSupport Manager allows you to group selected Clients together to 
allow easier management.  

 
For example, you may have a number of workstations all associated 
with the Sales department. By placing each of the individual Clients in 
a predefined group, you can then perform operations in a single 
action to all members within that group. 
 

To add Clients to a group 
1. Open the All Computers folder and select the group you want to 

add the Client to. 

2. Right-click and select Properties . 
Or 
Select the Group tab in the ribbon and click Properties. 

3. Choose the Members tab 
4. Select which Client you wish to add to the group.  
5. Click Add. 

 

Or 
 
1. Select the Clients in the List view. 

2. Right-click and choose Add to Group . 
Or 
Select the Selection tab that appears in the ribbon and click Add 
to Group. 

Note: This tab will only appear if multiple Clients are selected. 

3. Select the required group and click Add.  
 
Or 
 
1. Select the Client in the List view. 

2. Left-click and drag and drop the Client into the relevant group. 
 
To remove Clients from a group 
1. Open the All Computers folder and select the group you want to 

remove Clients from.  

2. Right-click and select Properties . 
Or 
Select the Group tab in the ribbon and click Properties. 

3. Choose the Members tab 
4. Select the Client(s) you wish to remove from the group and click 

Remove.  
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5. When you have finished adjusting the members of your group, 

click OK.  
 
Or 
 
1. Open the All Computers folder and select the group you want to 

remove Clients from. 

2. Select the Client(s) you want to remove from the group in the 
List view. 

3. Select the Group tab in the ribbon and click Remove from 
group. 

 

Note: To move a Client to a different group, select the Client icon 
and drag and drop to the new group. This will remove the 
Client from all levels in the previous group. 

 

Setting group properties 

Having created a group, you may be required to review or change its 

name, description or members. 
 

To adjust a group’s properties 
1. Highlight the required group from the Tree view. 
2. Select the Group tab in the ribbon and click Properties. 

Or 

Right-click the group and click Properties .  
3. The Group Properties dialog will be displayed. This has two tabs: 
 

General  

Shows the name and a description of the group, you can also 

customise the appearance of the client icons. 
 
Members 
Lists the Clients in the group. From here, you can add or remove 
Clients in the group. 
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NetSupport Scripting 
 
In this chapter … 
 

Learn about NetSupport’s powerful scripting language and how 

it can be used to automate repetitive tasks. 
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NetSupport Scripting overview 

NetSupport includes a powerful Scripting Language and Scheduler 
that allows you to automate the tasks you would normally perform 

repetitively in the NetSupport Manager Control. 
 
For example, you might set up a script that runs unattended 
overnight to connect to a number of remote NetSupport Manager 
Clients and upload or download files to them. 
 

This is a simple case, but NetSupport Scripting also contains a wealth 
of desktop management functions such as the ability to interrogate 
Clients and retrieve information such as their free disk space, what 
operating system they are running, etc. 
 
You could even use NetSupport Scripting to distribute applications by 
using a combination of File Transfer, Remotely Execute applications 

and edit the Registry. 
 
Anything that you do manually with NetSupport Manager, you can do 

automatically with NetSupport Scripting.  
 
The following are just a few of the highlights:  
• A powerful, structured language.  

• A wide range of text manipulation functions.  
• The ability to work with multiple connected Clients.  
• Local and remote operations are supported.  
• Full logging of activities.  
• The ability to supplement the system log with your own log 

messages.  

• All of the security features associated with the 32-bit control are 
available.  

• Your scripts will not contain visible human-readable passwords to 
develop your scripts. 

 
A full description of the Script Editor can be found in the online help.  
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Starting the Script Editor 

The Scripting Editor allows you to edit and create automated 

NetSupport Manager scripts. 
 
To start the Script Editor 
1. Choose {Start}{Programs}{NetSupport Manager}{NetSupport 

Manager Script Editor}. 

2. The Script Editor main window will appear. 

 
The Script Editor is divided into four main sections: 
• The menu bar and toolbar 
• The Command window 
• Edit dialog window 
• Script Output Frame. 
 

Creating a simple script 

NetSupport Scripting contains so many functions that it is not 

possible to cover them all. Instead, we will take you systematically 

through creating, testing and running a simple script. You can then 
explore the full functionality yourself. 
 
To create a script 
1. Choose {File}{New} from the Scripting drop-down menu bar. 

2. A new Script dialog window will appear. 
3. Double click on the Functions folder and then again on the Client 

sub-folder. A list of functions relating to the Client will be 
displayed. 

4. Select a function and drag and drop it into the Script dialog 

window. 
5. A dialog box will appear, prompting you for the variables you 

need to enter. 
6. Select a transport for the script to run on by selecting the 

SetTransport function, drag and drop it into the Script dialog 
window. 

7. A dialog box will appear, select which transports you wish to use 
and click OK. The correct syntax will automatically be inserted in 
the script. 

8. Select the Connect function, drag and drop it into the Script 

dialog window. 
9. Enter the Client(s) workstation to connect to and run your script 

over. 
10. Continue in this manner until you have completed your script. 
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Notes : 
• To access help for a function, select the required function, right-

click and choose Display Help On xxx. 
• It is advisable to regularly check the syntax of your script, choose 

{Run}{Check Syntax} from the drop-down menu. The script will 
then be checked and the results displayed in the output frame at 
the bottom of the screen.  

 

Scheduling and running a script 

You schedule a script to run using the NetSupport Manager Scripting 
Agent. Start this from the NetSupport Manager program group. 
 
The Scripting Agent contains many functions for tailoring the 
schedule to your exact needs. You create a schedule by choosing 
{Script}{Add} and selecting or adding the details you want in the 
Schedule dialog. 

 
You can set many scripts to run in the same schedule. You can even 

set the running of one script to depend on the results from another. 
 
NetSupport Scripting is an exceptionally powerful tool and there are 
an almost unlimited number of ways on which it can be used. Here 
are just a few ideas for you to consider: 

 
• Connect to Clients at remote sites overnight via a dial-up link and 

retrieve their day’s sales. 
• Connect to every Client on the Local LAN and retrieve its free disk 

space. Raise an alert if it is less than a certain limit. 

• Send a command to every Client to log in to the File Server and 

download a database. 
• Send a message to all Clients to be read by the users first thing 

in the morning. 
• Download an application overnight and use the Execute 

Command to run its set-up. 
• Update your NetSupport Manager Clients to the latest version. 
 

The list is endless. 
 



NetSupport Manager v14.00 

 

 322 

 

Technical reference 
 
In this chapter … 
 

Additional technical information is provided, which will further 

enhance your understanding of NetSupport Manager features. 
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Unloading a NetSupport Manager Client 

This allows you to stop the NetSupport Manager Client program from 
running. 

 
1. Use Net Stop Client32 from the command line. 

 

Restarting a Client 

In order to save any changes made to a profile, the file Client32U.ini 

must be saved. Once saved, the Client should be restarted for these 

changes to take effect. You can stop/start the Client from the Client 
Configurator dialog box. 
 
To save changes made to a profile 
1. Choose {File}{Save} from the Client Configurator drop-down 

menu. 

Or 
Click the Save icon on the toolbar. 

 

To restart the Client from the Client Configurator dialog box 
1. Click the Restart icon on the toolbar. A dialog with the Client 

information and licence details will appear. 
 

Or 
 
1. Choose {File}{Restart Client} from the Client Configurator drop-

down menu. 
2. A dialog box will appear informing you that the Client32 service is 

being started. 

3. A dialog with the Client information and licence details will 

appear. 
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Using compression effectively  

Compression can be configured to three different settings, on, off or 
always. When compression is turned on, screen data and file transfer 

operations are compressed. However, if a file is transferred that is 
already stored compressed (such as a zipped file or certain graphic 
files), NetSupport Manager will stop trying to compress it further after 
64KBytes. If Use Compression is turned on, the file is compressed 
no matter what its internal structure is. This can be useful for 
encrypting the file. 

 
The compressing and decompressing of the information takes time. 
On a dial-up link, the overhead of compressing and decompressing is 
minimal compared to the transfer speed of the modems. However, on 
a local LAN, if either the Control and/or Client are low specification 
workstations, the time taken to compress, transfer the data and then 
decompress can be greater than just sending the information directly. 

In this case, it is probably better to turn compression off. 
 
You can use the Compression tab in the About box to determine if file 

and screen information is being compressed efficiently. Time copying 
files of known sizes to determine if compression is speeding up your 
connection to the Client. 
 

Using cache effectively  

NetSupport Manager can store areas of the Client screen in local 

memory. This enables the Control to determine whether it needs to 
get the area from the Client (relatively slow) or from local memory 
(fast). This is commonly referred to as a cache. 

 
The Client and Control use the same size cache. The size of the cache 
for the Client is set via the Configurator and the size of the Control 

cache is set in the View settings. The lower of the Control and Client 
values is used.  
 
Use the Cache tab of the About box to determine how efficiently the 
cache is currently working. If the hit rate is low, then not many items 
have been requested from the cache (or your remote control session 
has not been very intensive). You could save memory by reducing the 

size of the cache. If the hit rate is high, then the cache is being used 
heavily. In this case, you may like to increase the size of the cache to 
speed up the remote control session. 
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The cache on the Control is created for each Client when it is viewed, 

bear this in mind if you regularly view multiple Client’s screens. If 
each Client has a 4Mbyte cache and you view 6 of them, the Control 
will allocate 24Mb of memory. If the total size of all the caches 
exceeds your physical memory size, then the operating system will 
start paging memory to disk, this will affect the performance of the 
cache. 

 
If you have Clients with different cache sizes set, configure the 

Controls to be as big as the largest Client setting. That way, the 
Control will always allocate the largest cache the Client can support. 
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Remote inventory and system information 

For many support teams, an important part of the problem resolution 
process is knowing not only what platform the workstation is running 

but its hardware specifications and the applications installed on the 
workstation. NetSupport Manager provides a real-time view of the 
hardware and software inventory of the remote PC. 
  

In addition to its sophisticated hardware/software reporting, where a 
wealth of information is collected specifically about the hardware or 

environment of the Client PC, you can obtain details of installed 
hotfixes and use the Task Manager to view and manage applications, 
processes and services that are currently running. 
  

As well as the real-time reporting, NetSupport Manager also provides 
the tools, security permitting, to allow you to remotely stop and start 
services, end applications and processes. 

 

Display the inventory for the selected Client 

1. Select the required Client icon in the Control window List view. 

2. Select the Home or Remote tab in the ribbon and click Inventory. 
Or 
Select the tab displaying the Client's name in the ribbon and click 
Inventory. 
Or 
Right-click and select Inventory. 

3. The Inventory window for the selected Client will appear.  
 

Note: Once collected, the various Client inventories are stored locally 

in the NetSupport Manager program folder, meaning that you 

do not need to be connected to the target PC to be able to 
view the information at a later date. Simply select the 
required Client from the List view and choose the Inventory 
option. However, if you subsequently want to refresh the 
inventory, you do need to connect to the target PC. 
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The Inventory window 

The Inventory window is the primary interface for accessing the 
wealth of information that NetSupport Manager’s inventory feature 
provides.  

 

The caption bar 

The caption bar displays the name of the remote Client PC whose 
system inventory is being viewed. Clicking the Client name brings up 
a Remote Management pane, and from here, you can see details of 
the Client and perform a variety of functions.  
 

By default, the Client name, wireless and battery indicators (if 
applicable) and security status (shows if TLS or encryption are 

enabled or not) are displayed on the caption bar. You can customise 
what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 
on the quick access bar, connected Clients list on the status 
bar and when zooming into thumbnails. 

  
The following options are available: 

 

 Show or hide the ribbon. 

 
Shows how many windows are open. From here, you can 

access the Window menu. 
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Access the online help and version number, licensee and 

Technical Support information. 
 
The ribbon 
The ribbon provides access to the inventory components and you can 
refresh, print and export the current view. 
 

The following inventory views are available:  
 

• Hardware  
NetSupport Manager collects a range of information specifically 
about the hardware or environment of the Client PC, providing all 
the key information needed to assist in speedy problem 
resolution. 

 

Note: The inventory functions included with NetSupport 
Manager are designed to run over TCP/IP. The Network 
adapter details will not be displayed if TCP/IP is not 
installed. 

 
• Software  

Provides a full software inventory report for any selected Client 
PC. Includes the name of each installed product, the 

manufacturer, product icon, version number and even the 

associated exe file. 
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• Hot Fixes  

NetSupport Manager scans for and checks the status of any ‘hot 

fixes’ that have been installed on the selected Client workstation. 
The hot fix ID is listed along with its status. The hot fix ID links to 
the appropriate Microsoft support page, where details of the fix 

can be found. 

 

When verifying the status of each fix, NetSupport Manager 
returns one of three indicators: 

 

 Verifies that the fix is present on the target PC and is 

current. 

 
An expected file may not be present or is not the 
correct version. It would be advisable to install the fix 
again. 

 
NetSupport Manager was unable to gather the required 
information for it to be able to verify the status. 
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Status bar 

The status bar shows the number of connected Clients. You can see a 
list of all connected Clients by clicking Connected (clicking a Client 
name opens an Inventory window for them). Right-click to choose 
how the Client is displayed in the list. 
 

Running the Task Manager 

1. Select the required Client icon in the List view. 
2. Select the Home or Remote tab in the ribbon and click Task 

Manager. 

Or 
Select the tab displaying the Client's name in the ribbon and click 
Task Manager. 
Or 
Right-click and select Task Manager. 
Or 
While viewing the Client screen, select the Tools tab in the View 

window ribbon and click the Task Manager icon. 
3. The Task Manager window for the selected Client will appear. 

 

The Task Manager window 

NetSupport Manager allows you to remotely open the Task Manager 
and manage applications, processes and services on the Client. 

 

The caption bar 
The caption bar displays the name of the Client you are running the 
Task Manager for. Clicking the Client name brings up a Remote 

Management pane, and from here, you can see details of the Client 
and perform a variety of functions.  
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By default, the Client name, wireless and battery indicators (if 

applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed on the caption bar. You can customise 
what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 
on the quick access bar, connected Clients list on the status 

bar and when zooming into thumbnails. 

 
The following options are available: 
 

 Show or hide the ribbon. 

 
Shows how many windows are open. From here, you can 
access the Window menu. 

 
Access the online help and version number, licensee and 
Technical Support information. 

 
The ribbon 
The ribbon provides access to the Task Manager tasks and tools. The 

available options change depending on what view is selected. You can 
refresh, print and export the data from all views. 
 
The following views are available: 
 
• Applications  

Shows a list of applications currently running on the Client 

machine. You can close a selected application from the list by 
clicking the Close Application icon. 
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• Processes  

Provides a list of processes currently running on the Client 
machine. You can close a selected process from the list by 
clicking the Kill Process icon. 
 

Note: Click Monitor Resources to see the usage differences 
(+/-) for the running processes. 

 

• Services  
Provides a list of services currently running on the Client 
machine. The Control can stop, start, pause and restart services 

by clicking the required Services icon. 

 
 

Note: By default, the close process/application and start/stop 
services features are disabled. You can enable these in the 
Advanced Client Configurator – Access Privileges settings. 

 

Status bar 
The status bar shows the number of connected Clients. You can see a 
list of all connected Clients by clicking Connected (clicking a Client 
name opens a Task Manager window for them). Right-click to choose 
how the Client is displayed in the list. 
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Edit Registry window 

Within the Edit Registry window, you are able to edit the registry of a 
Client or Control workstation. 

  

Note: The ability to edit the registry of a Control or Client 
workstation is off by default. This can be turned on in the 

Client Configuration – Access Privileges (Advanced) or Control 
Configuration – Functions settings. 

 

To edit the registry of a Client workstation 
1. Select the required Client in the List view. 
2. Select the Remote tab in the ribbon and click the Edit Registry 

icon. 
Or 
Right-click the Client and select Edit Registry. 

 

To edit the registry of the Control machine 
1. Select the Tools tab in the ribbon and click the Edit Local 

Registry icon. 

 

The Edit Registry window is divided into the following sections: 
  
The caption bar 
The caption bar shows which Client you are editing the registry of 

(this does not appear when you edit the registry of the Control 

machine). Clicking the Client name brings up a Remote Management 
pane, and from here, you can see details of the Client and perform a 
variety of functions.  
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By default, the Client name, wireless and battery indicators (if 

applicable) and security status (shows if TLS or encryption are 
enabled or not) are displayed on the caption bar. You can customise 
what is displayed and choose to show the Client's logged-on user 
name, IP address, operating system, enclosure type and location by 
right-clicking the Client name.  
 

Note: Changing the Client display options here will also change them 
on the quick access bar, connected Clients list on the status 

bar and when zooming into thumbnails. 

 
The following options are available: 
 

 Show or hide the ribbon. 

 
Shows how many windows are open. From here, you can 

access the Window menu. 

 
Access the online help and version number, licensee and 
Technical Support information. 

 
The ribbon 
The ribbon provides access to all the tasks and tools required for 
editing the registry. Positioning the cursor over an icon will display a 

brief description of its function.  
 

The following sections are available in the Home tab of the ribbon: 
  

• Registry 
Allows you to create new, delete, compare and edit values, 

rename keys or find specific data. You can also import and export 
a key or value and print the registry tree or values. 

 
• Bookmarks 

Allows you to add, edit, remove or move up and down your list, 
previously nominated bookmarks. 
 

Left-hand pane 
Displays a Tree view of the registry data. 
 

Right-hand pane 
When an item has been selected in the Tree view, it will be displayed 
here. Select the item and use the icons in the ribbon (or right-click) 
to edit it. 
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Status bar 

The status bar shows the number of connected Clients and the 

current registry path (this can be copied by clicking ). 
 
You can see a list of all connected Clients by clicking Connected 
(clicking a Client name opens an Edit Registry window for them). 
Right-click to choose how the Client is displayed in the list. 

  
WARNING: The registry contains vital information on the 

workstation. Editing any section of a registry should be done 
with EXTREME care. 
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Using NetSupport Manager’s Security features 

effectively 

NetSupport Manager has a large number of security features that can 
be used to restrict access to the Control and Client. Knowing how 
these work together and their limitations is useful when planning your 
security policy.  
 

Firstly, we recommend that if you want to restrict access to or protect 

a Client, you do it at the Client, not at the Control.  
 
There are a number of reasons for this. If the workstation contains 
sensitive information that you want to protect, it is likely that the 
workstation will have some physical security measures. Perhaps it is 

located in a locked room, a restricted area or maybe it has some local 
security measures. For example, it runs NT using NTFS. 
 
It doesn’t matter how good the NetSupport Manager Client’s security 
is if people can just walk up to the workstation and access the 

information. 
 

We recommend that the following measures are used to secure a 
NetSupport Manager Client. They are ranked from most secure to 
least secure. See the help in the Client Configurator for more 
information. 
 
• Physically protect access to the workstation. 
• Use a secure operating system such as NT and use its security to 

protect the workstation locally. i.e. use NTFS and user profiles for 

NT. 
• Store the Client configuration files in a secure area such as NT 

Server. 
• Set Client profiles that restrict the access rights that individual 

Control users or groups of users have to what they actually need. 

• Set a security key at the Control and Client. This only allows 
Controls to connect to the Client only if they have the same 
security key. For example, you can use this function to provide 
someone in a department with access to their departments’ 
workstations only. 

• Use the audit log/event log so you can determine who has 
connected and when. 

• Disable features at the Client that you know the Control user will 
not need. For example, disable File Transfer or set to Watch only 
if you don’t want people to manipulate the screen.  



NetSupport Manager v.14.00 

 

 337 

• For NT Client workstations, use the NT security features such as 

validate user ID. 
• Set a password on the Configurator and restrict access to who 

can run it. 
• Password protect the Control workstation and set Control profiles 

for individual users. 
• Set restrictions in the Control profile for accessing certain 

features like File Transfer, Viewing, Show etc.  
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Understanding IP addresses 

An IP address is made up of 4 bytes, each byte being made up of 
eight bits, which can have a value of 1 or 0. This gives possible IP 

addresses of 0.0.0.0 to 255.255.255.255. 
 
Each IP address is also split into two portions, a network portion, 
which identifies the network the device is on, and the local or host 
portion, which identifies a particular device. 
 

The subnet mask defines the position of this split between the 
network and host portions of the address, which is associated with 
the address. The subnet mask is also a four-byte number. Each bit in 
the subnet mask that is set to 1 denotes that the corresponding bit in 
the IP address is part of the network portion. 
 
For example, if we have an IP address of 10.10.2.21 and a subnet 

mask of 255.255.255.0 
 

IP Address 10 . 10 . 2 . 21 

Subnet Mask 255 . 255 . 255 . 0 

IP Address In Binary 00001010 . 00001010 . 00000010 . 00010101 

Subnet Mask in Binary 11111111 . 11111111 . 11111111 . 00000000 

Network Portion of IP 

Address 
00001010 . 00001010 . 00000010 . 00000000 

Host Portion of IP Address 00000000 . 00000000 . 00000000 . 00010101 

Network Portion of IP 
Address 

10 . 10 . 2 . 0 

Host Portion of IP Address 0 . 0 . 0  21 

Therefore, when we send an IP packet to 10.10.2.21, we are actually 
sending a packet to device 21 on network 10.10.2.0 
 
In the example above, the network 10.10.2.0 can have 256 host 
addresses, 0 to 255. However, two of the host addresses, the first 

and last, on each IP network are reserved. The reserved host address 

with all bits set to 0 is the Network Address, and the one with bits set 
to 1 is the broadcast address. 
 
In our example network of 10.10.2.0 
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10.10.2.0 is the network address 

10.10.2.255 is the broadcast address. 
 
When an IP packet is sent to a network’s broadcast address, each 
device on the IP network will receive this packet. 
 
It is this IP network broadcast address, which is used when 

configuring NetSupport Manager Control to browse on an IP subnet 
other than its own. 
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Using command line instructions 

The NetSupport Manager Control program, PCICTLUI.EXE, can be 
called from the command line. A range of parameters is available, 

enabling you to create shortcuts to many commonly used tasks. 
 
Using these parameters, you can, for example, create different 
Control profiles, set up a connection to specific Clients, and then 
create a desktop icon to automatically execute the commands when 
required. 

 
NetSupport Manager Command Line Options 
At the command line run, ‘PCICTLUI.exe’, from the NetSupport 
Manager Program folder, followed by the appropriate parameters: 
 
1. /N Loads a specific Control configuration. (Created in the Control 

Configurator. Click the Profiles icon  on the caption bar.) 
  

Note: When using control configuration profiles, it is advisable 

to password protect the configuration and keep the 
standard configuration unchanged to avoid locking 
yourself out of the Control. 

Syntax 
PCICTLUI /NPROFILE NAME (where profile name = the 
stored configuration name)   

 
/F Used with /N, restricts the control to only use the specified 

profile. By including this parameter, you prevent the Control 

user from being able to alter or add configurations. 

Syntax 
PCICTLUI /N/FPROFILE NAME 

 
/C Connect to a specific Client by name or address. 

Syntax 

If connecting by IP address: 

PCICTLUI /C”>NN.NN.NN.NN” (where “NN.NN.NN.NN” = 
the IP address) 

If connecting by name: 

PCICTLUI /CNNNNNN (where NNNNNN = client name) 
 
/V Used in conjunction with /C, opens the View window (in share 

mode) of the connected Client.  
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Syntax 

PCICTLUI.EXE /C”>NN.NN.NN.NN” /V 

/VC Opens a View window to the connected Client in Control mode. 

Syntax 
PCICTLUI.EXE /C”>NN.NN.NN.NN” /VC 

 
/VW Opens a View window to the connected Client in Watch mode. 

Syntax 
PCICTLUI.EXE /C”>NN.NN.NN.NN” /VW 

 

/VS Opens a View window to the connected Client in Share mode. 

Syntax 
PCICTLUI.EXE /C”>NN.NN.NN.NN” /VS 

 

/E Used in conjunction with the /V options, opens the View window 
without loading the Control. When the View window is closed, 
the remote control session ends. 

Syntax 
PCICTLUI.EXE /C”>NN.NN.NN.NN” /V /E 

PCICTLUI.EXE /C”>NN.NN.NN.NN” /VC /E 
PCICTLUI.EXE /C”>NN.NN.NN.NN” /VW /E 
PCICTLUI.EXE /C”>NN.NN.NN.NN “/VS /E 

 
/G Connect to a defined group of Clients on start-up. 

Syntax 

PCICTLUI.EXE /GNNNNN  (where NNNNN = the group name) 
 

/D Dial into a remote network. Can be used in conjunction with /C. 

Syntax 

PCICTLUI.EXE /DNNNNN /Cxxxxx  (where NNNNN = the 
name of the remote network and xxxxx = the name of the 
Client to connect to) 

 
/U Specify the protocol to use. Use IP for IPX/SPX, TC for TCP/IP, 

and NBn for NETBIOS where n = the stack 0-7. 

Syntax 

PCICTLUI.EXE /Unb1 (where nb1 = netbios stack 1) 
 
/R Display a NetSupport Manager Replay File. 
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Syntax 

PCICTLUI.EXE /RNNNNN.rpf  (where NNNNN.rpf = the file 
name) 

/A Open a Chat session with a selected Client. 

Syntax 

PCICTLUI.EXE /CNN.NN.NN.NN  /A 
 
/I Retrieves a hardware/software inventory from the selected 

Client machine. 

Syntax 

PCICTLUI.EXE /CNN.NN.NN.NN  /I 
 

/S  Connect to the Client using its PIN. Can be used in conjunction 
with /V, /VC, /VW and /V /EV. 

 
Syntax 

PCICTLUI.EXE /SNNNNN (where NNNNN is the Client's PIN) 
 

/X  Opens a File Transfer window at the selected Client. 
 
Syntax 
PCICTLUI.EXE /CNN.NN.NN.NN  /X 
 

/K  Opens a PowerShell or Registry session at the selected Client. 
 
Syntax 
PCICTLUI.EXE /CNN.NN.NN.NN  /Kpowershell 
PCICTLUI.EXE /CNN.NN.NN.NN  /Kregistry 
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Integration with Active Directory 

NetSupport Manager integrates with Microsoft’s Active Directory 
structure, enabling you to centrally manage Client and Control 

configurations. By creating an appropriate Group Policy, you can 
apply standardised Client configurations to Client machines without 
the need to visit individual desktops. 
  
To make the task a little easier, NetSupport Manager supplies ready-
made Administrative Templates containing the configurable options. 

When you install NetSupport Manager, the Template files are copied 
to the NetSupport Manager program folder. 

 

To apply configuration changes via Active Directory 
1. At the domain controller, run Group Policy Management. 
2. Select the desired policy to apply the NetSupport settings to or 

create a new policy. 
3. Right-click the policy and select Edit. 

4. The NetSupport Manager templates will be located under: 
Computer Policies – Computer Configuration > Policies > 

Administrative Templates 
User Policies – User Configuration > Policies > Administrative 
Templates 

5. The templates are called NetSupport Client Settings and 
NetSupport Manager Control Settings. 

6. Within these templates, you will find the relevant NetSupport 
Manager settings that can be applied via Group Policy. 

 

By default, each NetSupport policy option is set to not configured. 
 

Each time you make a change to an option, the Group Policy refresh 
interval will determine when it is applied to Client machines. If a 

remote control session is not currently active,  the Client will detect 
any changes to its own Administrative Template and restart,  
applying the new settings. If a remote control session is open, the 
Client will restart at the next available opportunity. 
 
For an explanation of the configuration options that are available, 
refer to the Configuring the Client section. 
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Note: Please refer to the Support area on our website 
www.netsupportsoftware.com/support for the latest 
information on Active directory policy files, instructions on 
upgrading from previous versions and applying NetSupport 

Manager Client profiles within Active Directory. 

 
The NetSupport Manager Client can be configured to validate user 

connections against members of Active Directory groups. See 
Configuring the Client - User Validation. 

http://www.netsupportsoftware.com/support/
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Smartcard support 

NetSupport Manager allows the Control to log on to Client machines 
that use Smartcard authentication. Smartcard support is automatic 

and no additional installation is required. Support is dynamically 
loaded at the Client when a Control connection is made. When 
loaded, an additional hardware device will be available called NSL 
Pseudo Smartcard Reader. 
  
When the Control opens a View window to the connected Client, they 

will need to insert their own smartcard into the reader attached at the 
Control and enter the Clients PIN to log on to the remote user’s 
machine. 
  
If multiple Client View windows are open at the Control, smartcard 
insertion and removal events are sent to the Client currently in focus.  
  

Notes:  
• Smartcard authentication for remote control sessions is only 

available if the Client is running Windows XP or later, the 

smartcard authentication option is enabled at the Client and the 
Client was able to successfully create the pseudo smartcard 
device. 

• In an Active Directory environment, it is possible to enable 
smartcard support using the NetSupport Manager ADM Template. 

  
Enabling smartcard logon 
1. Open the NetSupport Manager Program folder by choosing 

{Start}{Programs}{NetSupport Manager}{NetSupport Manager 

Configurator}. 

2. Choose the Advanced Configurator option and select the profile 
to amend. 

3. From the list of configuration options, select Security-
Smartcard. 

4. Check the Enable Smartcard option. 

5. Click OK. 
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Using NetSupport Manager over the internet 

NetSupport Manager works across the internet in much the same way 
as it does across dial-up networking. It can be done to workstations 

with a static connection across a LAN or to a dial-up account with ISP.  
 
If your workstation can “see” a workstation running NetSupport 
Manager, you can connect to it, whether this is on the internet, via 
remote communications, a RAS dialup link or on your local LAN/WAN. 
 

Note: While the following procedure can be used, NetSupport 
Manager also provides a convenient Internet Gateway 
feature delivering web-based remote control without the 
need for modifications to existing Firewall configurations. 

 
To remote control a Client over the internet 
1. Connect both the Control and the Client to the internet.  

2. Select the Home tab in the ribbon.  
3. In the Quick Connect section, type in the IP address of the Client 

you wish to connect to.  

4. Select the By IP address icon . 
5. Click Quick Connect. 

Finding an IP address 
The easiest way to find the IP address of the Client is to use the 

command line ipconfig. 
 
DHCP 
Workstations connecting via a modem link to an ISP will normally 
have a different IP address assigned to them each time they connect. 

You will therefore need to find out their address each time you wish 

to connect. This is done using the command line ipconfig. 
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Contacting NetSupport 
 

If you have any comments regarding the design, installation, 
configuration, or operation of NetSupport Manager, please contact us. 
 
UK & International 

www.netsupportsoftware.com  
Technical Support: support@netsupportsoftware.com 
Sales: sales@netsupportsoftware.com 

 
North America 
www.netsupport-inc.com  

Technical Support: support@netsupportsoftware.com 
Sales: sales@netsupport-inc.com 
 
Canada 
www.netsupport-canada.com 
Technical Support: support@netsupportsoftware.com 
Sales: sales@netsupport-canada.com 

 
Germany, Austria and Switzerland 
www.pci-software.de  
Technical Support: support@netsupportsoftware.com 
Sales: sales@pci-software.de 
 
Japan 

www.netsupportjapan.com  
Technical Support: support@netsupportsoftware.com 
Sales: sales@netsupportjapan.com 

 
 
 

 
 
 
 
 
 
 

 
 
 
 

http://www.netsupportsoftware.com/
http://www.netsupport-inc.com/
http://www.netsupport-canada.com/
http://www.pci-software.de/
http://www.netsupportjapan.com/
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2 
2FA, 107 

A 
access privileges, 227, 229 
access rights 

for file transfer, 243 
acknowledge connection by a 

Control, 235 
active directory, 344 

authenticate, 232 
adding Clients, 312 
advanced Client browsing, 81 

terminal server, 112 
advanced Client configuration, 213 
android client, 56 
applications running at Client. See 

inventory 
audio support, 151 

adjusting microphone sensitivity, 
153 

adjusting speaker volume, 153 
Client configuration, 253 
Control configuration, 294 
making announcements, 152 

auto group, 66 

B 
basic Client configuration, 212 
beep 

when Control receives help 
request, 300 

while chatting, 183 
while viewing, 255 

blanking Clients screens, 128 
broadcast show, 145, 269 
browsing, 73 

advanced, 81 
for Gateway Clients, 73 
for terminal server Clients, 112 
Gateways, 103 
IPX network, 83 
over a subnet, 81 
over an IP subnet, 81 
specify subnets, 269 
understanding IP addresses, 339 

C 
cache, 249, 285, 325 
capture print output, 190, 291 
capture screen, 132 
chat 

Client initiated, 204 
Control initiated, 182 
disable, 185, 229, 255 
group chat, 182 

initiate in explorer, 193 
send audible beep, 183 

chrome OS, 54 
client 

update, 118 
Client 

accept/reject connection, 236 
acknowledge connection, 235 
automatic login, 117 
chat to a Control, 204 
Client Main Window, 201 
configuration, 212 
disconnecting a Control, 203 
features, 200 
inventories, 327 
load bridge at startup, 222 
power off, 119 
power on, 119 
properties, 314 
raising a help request, 204 
receiving messages, 205 
remote installation, 37 
restarting, 324 
security. See security, at the 

Client 
unloading, 324 

client automatic login, 117 
client automatic update, 118 
client configurator 

advanced options, 262 
terminal services, 261 

Client Configurator 
access privileges, 227, 229 
audio settings, 253 
Client interface options, 255 
Client settings, 255 
connect options, 238 
connectivity options, 215 
dialin options, 222 
disconnect options, 240 
enable smartcard logon, 237 
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help request settings, 257 
profile options, 260 

remote control settings, 249 
replay file settings, 244 
security, 225 
set Client password, 225 
set Configurator password, 225 
set HTTP, 219 
set IPX, 217 
set NetBIOS, 218 
set Security key, 225 
set TCP/IP, 216 
set tickle period, 224 
show settings, 252 
user acknowledgement, 235 
user validation, 232 
view settings, 249 

client information window, 201 
Client settings, 267 
clients 

organising clients, 137 
clipboard, 191 
command line instructions, 195, 

197, 341 
compression, 279 

file transfer, 303 
use while viewing, 285 
using effectively, 325 

configuration files 
creating, 209 
editing, 209 

configure PIN server at client, 221 
configure PIN server at control, 275 
configuring Clients, 212 
connect 

by hostname, 269 
connecting to Clients 

on different protocols, 80 
over a remote IPX network, 83 
over a subnet, 81 
over an IP subnet, 81 
quick connect, 79 
terminal server, 112 
through firewalls, 110 
through proxy servers, 110 
through the Internet, 347 
understanding IP addresses, 339 

using IP address, 79 
with a smartcard, 237 

connecting to clients using PIN 
connect, 77 

connecting to Controls 
through firewalls, 110 

through proxy servers, 110 
through the Internet, 347 

connectivity 
dialin options, 222 
remote dialup at Control, 276 
set HTTP, 219, 274 
set IPX, 217 
set NetBIOS, 218 
set PIN server at client, 221 
set PIn server at control, 275 
set TCP/IP, 216, 269 

connectivity server, 84 
contact us, 348 
Control 

adjusting microphone and 
speaker volume, 153 

audio announcements, 152 
audio support, 151 
capture Client print output, 190 
chat to Client, 182 
clipboard, 191 
connecting to Clients, 76 
connecting to Clients, different 

protocols, 80 
Ctrl+Alt+Delete, 122 
dealing with help requests, 188 
disconnecting Clients, 116 
executing applications, 138 
features, 14 
file distribution, 176 
file manager, 180 
finding Clients on a gateway, 73 
finding Clients on the network, 73 
Internet, use over, 347 
logout, 121 
managing Control files, 180 
messages, sending, 187 
power management, 119 
quick connect, 79 
reboot, 121 
recording replay files, 158 
scanning clients, 130 
security. See security, at Control 
set name, 268 
showing a Client's screen, 149 

showing the Control screen, 145 
starting, 60 
user defined tools, 143 
video support, 154 
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viewing a Client, 123 
Control configuration 

create desktop icons, 266 
multiple profiles, 266 

control configurator 
vPro, 308 

Control Configurator, 264 
advanced settings, 278 
audio settings, 294 
configure interface settings, 295 
connectivity options, 269 
Control interface settings, 295 
event logging, 246, 281 
file locations, 309 
file transfer settings, 243, 303 
general settings, 268 
help request settings, 300 
keyboard/mouse settings, 289 
print capture settings, 291 
protect configuration, 242 
remote control settings, 285 
remote dialup settings, 276 
replay files, 282 
restrict functionality, 298 
security settings, 279 
set HTTP connection, 274 
set TCP/IP connection, 269 
show settings, 301 
startup settings, 306 
terminal server settings, 112 
user permissions, 283 

control panel video player, 156 
Control Window, 61 

hide options, 295 
list view, 69 
tree view, 65 

Ctrl+Alt+Delete, 122 
customisable display text, 235, 240, 

259 
cut and paste, remotely, 191 

D 
database, Client 

adding, 312 
deleting, 313 
properties, 314 
renaming, 313 

default settings, customise. See 
customise 

deleting Clients, 313 

deleting files and directories, 169 
delta file transfer, 168, 303 

deploy 
a Client configuration, 47 
a NetSupport license file, 48 
a NetSupport package, 43 
getting started, 40 
log files, 52 
main window, 41 
pre-define settings, 51 
remote Install, 37 
remote uninstall, 49 

DHCP 
connect by hostname, 269 

directory 
copying, 168 
deleting, 169 
synchronise, 172 

disable functionality, 227, 229, 255, 
298 
configure Control interface, 295 

disconnect 
a Client, 116 
a Control, 203 
all Clients, 116 
configuration options, 240 

distributing files, 176 
dual channel bonding 

enable at Client, 222 
enable at Control, 277 

DVD 
enable playback support, 249 

E 
edit registry window, 334 
enable client location, 297 
enable geolocation, 297 
encryption 

at Control, 279 
force encryption, 238 

evaluation kits, 30 
event logging 

enable at Client, 246 
enable at Control, 281 

executing applications, 138 
explorer integration, 193 

disable shell, 295 
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F 
file 

copying, 168 
copying between Clients, 169 
deleting, 169 

file distribution, 176 
File Distribution Window, 173 
file locations, 309 
file manager, 180 

File Manager Window, 178 
file transfer 

applying a filter in List View, 165 
arranging multiple Windows, 165 
between Clients, 169 
changing the sort orders, 167 
changing the view format, 166 
configuring access rights, 243 
control settings, 303 
copying files and directories, 168 
deleting file and directories, 169 
delta file transfer, 168 
print file list, 171 
synchronising directories, 172 

File Transfer Window, 162 
applying a filter in List View, 165 
arranging multiple Windows, 165 
changing the sort orders, 167 
changing the view format, 166 

finding Clients on the network, 73 
firewalls, 86, 110 

G 
gateway, 84 

configure Client for HTTP, 219 
configure Control for HTTP, 274 
connecting clients/controls, 86 

gateway configuration, 88 
geolocation, 69 
glossary, 348 
groups, 316 

adding, 317 
chat, 182 
creating, 316 
properties, 318 
removing, 317 

H 
hardware inventory, 327 
help requests 

configure Control settings, 300 
configuring settings, 257 

dealing with, 188 
sending, 204 
use web based application, 257 

hide 
interface settings, 295 

hot fixes. See inventory 
hotkeys, 289 
HTTP 

connecting Clients/Controls, 86 
set at Client, 219 
set at Control, 274 

I 
icons 

create desktop icons, 266 
use small toolbar icons, 61, 124, 

132 
using command line instructions, 

341 
inactivity timeout 

set at Client, 249 
initialising NetSupport, 60 
install configuration options, 34 

installing, 20, 33 
android client, 56 
evaluation kits, 30 
existing installation detected, 29 
gateway, 25 
mac, 53 
on chrome OS devices, 54 
planning, 20 
properties for silent install, 34 
remote deploy, 37 
select an installation type, 25 
Server, 32 
silent/unattended, 33 
uninstalling, 30 

instcfg.exe, 33 
integration with active directory, 

344 
integration with explorer, 193 

disable shell, 295 
intel vPro, 113 
interface settings 

configure, 295 
Internet 

gateway, 86 
use over, 347 
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inventory, 327 
check for hot fixes, 330 

disable at control, 298 
disable features, 229 
list applications, 332 
list processes, 333 
retrieve via explorer, 193 
software and hardware, 327 

inventory window, 328 
IP connections, 79 
IP subnet browsing, 81 
IPX 

set at Client, 217 
IPX subnet browsing, 83 

L 
launching applications, 138 
list view, 69 
load balancing connectivity servers, 

105 
load bridge on startup, 222 
load control from command line, 

341 
log files 

during a remote deploy, 52 

enable at Client, 246 
log events at Control, 281 

logging in clients, 117 
logout, 121 

M 
mac, 53 
managing Clients, 311, See groups 

add a new Client, 312 
delete a Client, 313 
rename a Client, 313 
setting Client properties, 314 

managing files 
Control, 180 

max colour depth, 249 
messages 

customisable display text, 235, 
240 

messages, sending, 187 
mobile control for iOS and android, 

58 
modem 

at Control, 276 

monitor mode, 136 

configure settings, 295 
multiple subscriber number 

set at Client, 222 
set at Control, 277 

N 
NetBIOS 

set at Client, 218 
NetSupport 

features, 14 
netsupport connectivity server, 84 

add gateways, 101 
client configuration, 100 
connecting clients/controls, 86 
console, 84 
control configuration, 101 
set up load balancing connectivity 

servers, 105 
netsupport connectivity server 

configuration, 88 
netsupport connectivity server 

configuration utility 
2FA tab, 98 
general tab, 88 
keys tab, 90 

licenses tab, 95 
operators tab, 91 
security tab, 96 
servers tab, 92 

NetSupport deploy, 37 
a Client configuration, 47 
a NetSupport license file, 48 
a NetSupport package, 43 
getting started, 40 
log files, 52 
main window, 41 
pre-define settings, 51 
remote uninstall, 49 

num lock synchronisation, 289 

O 
organising Clients. See also 

managing Clients 
organising clients in the list view, 

137 

P 
parameters 

command line, 341 
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silent installation, 34 
passwords, 279 

PIN connect, 77 
play sound 

during chat session, 183 
when help request arrives, 188 

port number, 110 
for gateway connection, 87 
for HTTP connection, 87, 219, 

274 
for TCP/IP connections, 216 

power management 
Client power off, 119 
Client power on, 119 

powershell, 197 
pre-define deploy settings, 51 
print 

deploy log file, 52 
file transfer list, 171 

print capture, 190, 291 
processes running at Client. See 

inventory 
profiles, 209, 266 

using command line instructions, 
341 

prompt for connection reason, 279 
properties, Client, 314 
protecting the Client configuration, 

242 

Q 
quick access bar, 64 
quick connect, 79 

disable at control, 298 
quiet mode, 255 

R 
radius, 233 
reboot, 121 
receive show options, 252 

disable, 252 
record client activity, 159 
record local activity, 158 
remote clipboard, 191 
remote command prompt, 195 
remote communications 

dual channel bonding, 222, 277 
set MSN number, 222, 277 

remote control 
configure settings at Client, 249 

configure view settings, 285 
disable functionality, 298 

viewing Clients, 123 
remote controlling a Client, 123 

via explorer, 193 
remote deploy utility, 37 
remote install 

a Client configuration, 47 
a NetSupport license file, 48 
a NetSupport package, 43 
log files, 52 

remote inventory and system 
information, 327 

remote uninstall, 49 
renaming Clients, 313 
replay files 

create for all clients, 159 
create for selected client, 159 
enable at Client, 244 
enable at Control, 282 
record local activity, 158 
recording, 158 
showing, 145, 161 
watching, 160 

requesting help, 204 
restarting a Client, 324 
running the task manager, 331 

S 
scale to fit, 286 

show window, 252 
scale to fit mode, 128 
Scan Window, 132 
scanning Client screens, 130 

individually, 130 
multiple, 131 

screen capture, 132 
screen scrape 

set at Client, 249 
set at Control, 285 

scripting, 320 
creating a, 321 
running, 322 
scheduling, 322 
starting the editor, 321 

scrollbars 
in show window, 252 

security 
using effectively, 337 

security at Client 
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connect options, 238 
disconnect options, 240 

enable smartcard logon, 237 
event logging, 246 
force encryption, 238 
set access privileges, 227, 229 
set password, 225 
set set security key, 225 
user acknowledgement, 235 
user validation, 232 
using log files, 246 

security at Control, 279 
compression, 280 
encryption, 279 
event logging, 281 
password, 279 
replay files, 282 
user permissions, 283 
using log files, 281 

security key, 279 
send physical fonts, 249 
setting up and using two-factor 

authentication, 107 
settings, Client, 267 
set-up. See installing:planning 
shell extension 

disable explorer shell, 296 
showing 

a Client’s screen, 149 
broadcast show, 145 
configure options at Client, 252 
enable broadcast show, 269 
replay files, 145, 161 
the Control screen, 145 
video support, 154 

silent installation, 33 
install configuration options, 34 

silent mode, 255 
smartcard logon, 237 
smartcard support, 346 
software inventory, 327 
SOS messages 

sending, 204 
ssl/tls certificates, 96 
starting NetSupport, 60 

configure startup settings, 306 
status bar, 71 

subnet 
browse IPX networks, 83 
configuring the control to browse, 

81 

IP subnet browsing, 81 
understanding IP addresses, 339 

synchronisation, num lock, 289 
synchronising directories, 172 

T 
task manager, 331 
task manager window, 331 
TCP/IP 

set at Client, 216 
set at Control, 269 

terminal server, 112 
thumbnail view, 136 

configure settings, 295 
tickle packets, 224, 278 
timeout 

user acknowledgement, 236 
toolbar 

use small icons, 61, 124, 132 
transport 

set for dialin, 222 
set HTTP, 219, 274 
set IPX, 217 
set NetBIOS, 218 
set TCP/IP, 216, 269 

tree view, 65 
two-factor authentication, 107 

U 
understanding IP addresses, 339 
uninstalling, 30 
unloading a Client, 324 
url 

route help requests to web based 
system, 257 

user acknowledgement, 235 
user defined tools, 143 
user permissions, 283 
user validation, 232 

V 
video player, 154 

control panel, 156 
video skipping, 287 
view modes, 126 
view settings, 129 
View Window, 124 

use small toolbar icons, 124 
viewing, 123 
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blank Client screen, 128 
configure default mode, 285 

multiple screens, 127 
scale to fit, 128 
use explorer to initiate, 193 
view modes, 126 
view settings, 129 

vPro, 113 

W 
WAN 

IP subnet browsing, 81 
IPX subnet browsing, 83 
subnet browsing, 81 
understanding IP addresses, 339 

whiteboard, 182 

window 
inventory, 328 

Window 
chat, 183 
Client Information, 201 
Control Main, 61 
deploy, 41 
file distribution, 173 
file manager, 178 
file transfer, 162 
scan, 132 
view, 124 

Windows explorer 
integration with NetSupport, 193 

Windows Vista 
installation, 23 
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